
Über Logic Audio Quick Reference

Logic Audio Quick Reference ist ein Nachschlagwerk über die in Logic Audio verfügbaren Befehle. Zu 
jedem Befehl gibt es eine eine Kurzbeschreibung.
Ausführlichere Informationen zu den Befehlen finden Sie im Handbuch.

Logic Audio Quick Reference wurde von kurt hofmann erstellt.



Haupt-Menü > Über das Haupt-Menü

Sämtliche Befehle unter Haupt-Menü sind globale Menüs und daher im Hauptmenü von Logic zu finden.

Die entsprechenden Tastaturbefehle werden im Menü hinter dem Menü-Eintrag angezeigt. Eigene 
Tastenkombinationen lassen sich unter Menü "Optionen > Einstellungen > Tastaturkommandos..." den 
Befehlen zuordnen.



Haupt-Menü > Datei > Neu

Erzeugt einen neuen Song.

Tasturbefehl:
Neu
(Globale Kommandos)



Haupt-Menü > Datei > Öffnen...

Mit der darauf erscheinenden Dateiauswahl kann ein Song geöffnet werden.

Tasturbefehl:
Öffnen
(Globale Kommandos)



Haupt-Menü > Datei > Song schließen

Schließt den aktuellen Song. Falls die letzten Änderungen noch nicht gesichert worden sind, erfolgt eine 
Sicherheitsabfrage.

Tasturbefehl:
Song schließen
(Globale Kommandos)



Haupt-Menü > Datei > Sichern

Mit der darauf erscheinenden Dateiauswahl kann ein Song gesichert werden. Falls dieser bereits 
gespeichert worden ist, wird die aktuelle Version gesichert.

Tasturbefehl:
Sichern
(Globale Kommandos)



Haupt-Menü > Datei > Sichern unter...

Der aktuelle Song kann unter anderem Namen gesichert werden.

Tasturbefehl:
Song sichern unter...
(Globale Kommandos)



Haupt-Menü > Datei > Zurück zur letzten Version

Die letzte gesicherte Version des aktuellen Songs wird geladen. Alle seit dem letzten Sichern gemachten 
Änderungen werden verworfen.

Tasturbefehl:
Zurück zur letzten Version
(Globale Kommandos)



Haupt-Menü > Datei > Papierformat...

Hier erfolgen die Einstellungen bezüglich dem Papierformat.

Tasturbefehl:
Papierformat...
(Globale Kommandos)



Haupt-Menü > Datei > Drucken

Hier kann der Ausdruck des aktuellen Noten-Editors gestartet werden.

Tasturbefehl:
Drucken
(Globale Kommandos)



Haupt-Menü > Datei > Importieren...

Erlaubt das Importieren von Songs in anderen Formaten, so z.B. MIDI Files.

Tasturbefehl:
Datei importieren...
(Globale Kommandos)



Haupt-Menü > Datei > Auswahl als MIDI-File exportieren...

Erlaubt das Exportieren der selektierten Sequenzen als MIDI File. Sequenzen vorher unbedingt 
Normalisieren, Loops auskopieren usw.

Tasturbefehl:
Auswahl als MIDI-File exportieren...
(Globale Kommandos)



Haupt-Menü > Datei > Beenden

Logic wird beendet. Falls die letzten Änderungen noch nicht gesichert worden sind, erfolgt eine 
Sicherheitsabfrage.

Tasturbefehl:
Beenden
(Globale Kommandos)



Haupt-Menü > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Haupt-Menü > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Haupt-Menü > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Haupt-Menü > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Haupt-Menü > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Haupt-Menü > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Haupt-Menü > Audio > Audio-Fenster...

Öffnet ein neues Audio-Fenster.

Tasturbefehl:
Audio-Fenster öffnen...
(Globale Kommandos)



Haupt-Menü > Audio > Sample Editor...

Öffnet ein neues Sample-Editor Fenster.

Tasturbefehl:
Wellenform-Editor öffnen...
(Globale Kommandos)



Haupt-Menü > Audio > Audio-Mischer

Öffnet ein Trackmischer-Fenster mit den Kanälen der Audio-Spuren.



Haupt-Menü > Audio > Audio-Einstellungen...

Öffnet das Fenster mit den globalen Einstellungen bezüglich Audio.



Haupt-Menü > Audio > Audio-Hardware & Treiber...

Öffnet die Voreinstellungen bezüglich den Audio-Treibern.

Tasturbefehl:
Audio Hardware Setup
(Globale Kommandos)



Haupt-Menü > Audio > Systemauslastung...

Öffnet ein Fenster, in welchem die momentan beanspruchte System-Leistung dargestellt wird.

Tasturbefehl:
Systemauslastung öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Einstellungen... > Synchronisationseinstellungen...

Öffnet ein Fenster mit sämtlichen Parametern welche für die Synchronisation von Bedeutung sind.

Tasturbefehl:
Synchronisationseinstellungen öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Einstellungen... > Metronom-Einstellungen..

Öffnet ein Environment-Fenster in der Layer, in der das Objekt "MIDI Metronome" zu finden ist.



Haupt-Menü > Optionen > Einstellungen... > Aufnahme-Einstellungen...

Öffnet den Abschnitt bezüglich Aufnahme-Einstellungen der Einstellungen im Song.

Tasturbefehl:
Aufnahmeoptionen...
(Globale Kommandos)



Haupt-Menü > Optionen > Einstellungen... > MIDI-Einstellungen...

Öffnet den Abschnitt bezüglich MIDI-Einstellungen der Einstellungen im Song.

Tasturbefehl:
MIDI-Optionen...
(Globale Kommandos)



Haupt-Menü > Optionen > Einstellungen... > Events verfolgen...

Öffnet den Abschnitt bezüglich Events verfolgen der Einstellungen im Song.

Tasturbefehl:
Events verfolgen...
(Globale Kommandos)



Haupt-Menü > Optionen > Einstellungen... > Einstellungen importieren...

Öffnet einen Dialog in welchem Screen Sets, Transform Sets, Hyper Edit Sets, Score Instrument Sets, 
Notationsformate oder Notations-Einstellungen markiert werden können. Die markierten Einstellungen 
werden dann von dem mit "Import" gewählten Song auf den aktuellen Song übertragen.

Tasturbefehl:
Einstellungen importieren...
(Globale Kommandos)



Haupt-Menü > Optionen > Einstellungen... > Notation: globale Formate...

Hier lassen sich die Parameter für die globalen Formate der Notation für diesen Song einstellen.



Haupt-Menü > Optionen > Einstellungen... > Notation: Ziffern und Namen...

Hier lassen sich die Parameter für Ziffern und Namen der Notation für diesen Song einstellen.



Haupt-Menü > Optionen > Einstellungen... > Notation: Gitarrentabulatur...

Hier lassen sich die Parameter für Gitarrentabulatur der Notation für diesen Song einstellen.



Haupt-Menü > Optionen > Einstellungen... > Notation: Schlüssel- und Taktwechsel...

Hier lassen sich die Parameter für Schlüssel- und Taktwechsel der Notation für diesen Song einstellen.



Haupt-Menü > Optionen > Einstellungen... > Notation: Erweiterte Layout-Parameter...

Hier lassen sich die erweiterten Layout-Parameter der Notation für diesen Song einstellen.



Haupt-Menü > Optionen > Einstellungen... > Notation: MIDI-Bedeutung...

Hier lassen sich die Parameter für die MIDI-Bedeutung von Notations-Symbolen für diesen Song 
einstellen.



Haupt-Menü > Optionen > Einstellungen... > MIDI-Interface-Kommunikation...

Öffnet den Abschnitt für die Einstellungen von MIDI-Interface-Kommunikation der globalen 
Voreinstellungen.



Haupt-Menü > Optionen > Einstellungen... > Allgemeine Programmeinstellungen...

Öffnet den Abschnitt für die Einstellungen von allgemeinen Programmeinstellungen der globalen 
Voreinstellungen.



Haupt-Menü > Optionen > Einstellungen... > Darstellungseinstellungen...

Öffnet den Abschnitt für die Darstellungseinstellungen der globalen Voreinstellungen.



Haupt-Menü > Optionen > Einstellungen... > Notationseinstellungen...

Öffnet den Abschnitt für die Voreinstellungen für Notation der globalen Voreinstellungen.



Haupt-Menü > Optionen > Einstellungen... > Reset-Einstellungen...

Öffnet den Abschnitt für die Reset-Einstellungen der globalen Voreinstellungen.



Haupt-Menü > Optionen > Einstellungen... > Tastaturkommandos...

Öffnet das Fenster der Tastatur-Befehle. Jedem hier verzeichneten Befehl kann eine Tastenkombination 
und ein MIDI Befehl zugeordnet werden.

Tasturbefehl:
Tastaturkommandos öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Erzeugen

Erzeugt eine Markierung zum aktuellen Zeitpunkt.

Tasturbefehl:
Marker erzeugen
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Erzeugen ohne Runden

Erzeugt eine neue Markierung an der exakten Position der Song Position Line. Dabei findet keine 
Rundung statt.

Tasturbefehl:
Marker erzeugen ohne Rundung
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Erzeugen anhand von Objekten

Erzeugt eine neue Markierung an der Position und mit der Länge der aktuellen Selektion.



Haupt-Menü > Optionen > Marker > Löschen

Löscht eine Markierung.

Tasturbefehl:
Marker löschen
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Zum nächsten

Die Song Position Line springt an die Position der nächsten Markierung.

Tasturbefehl:
Zum nächsten Marker
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Zum vorherigen

Die Song Position Line springt an die Position der vorangehenden Markierung.

Tasturbefehl:
Zum vorherigen Marker
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Zu Markernummer...

Öffnet einen Dialog in welchem numerisch die Nummer der Markierung eingegeben werden kann, zu der 
Logic springen soll.

Tasturbefehl:
Zu Markernummer...
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Quick Edit Marker

Ermöglicht die Eingabe des Namens eines Markers direkt im aktuellen Fenster.



Haupt-Menü > Optionen > Marker > Liste öffnen...

Öffnet ein Fenster mit der Liste aller Markierungen.

Tasturbefehl:
Marker Liste öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Liste öffnen immer oben...

Öffnet ein Fenster mit der Liste aller Markierungen. Dabei wird das Fenster als schwebendes Fenster 
geöffnet.

Tasturbefehl:
Marker Liste immer oben öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Markertext öffnen

Öffnet ein Fenster mit dem Text der Markierung. Dieser kann hier editiert werden.

Tasturbefehl:
Markertext öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Marker > Markertext öffnen immer oben...

Öffnet ein Fenster mit dem Text der Markierung. Das Fenster wird als "Floating Window" (Schwebendes 
Fenster) geöffnet. Der Text der Markierung kann hier nicht editiert werden!

Tasturbefehl:
Markertext immer oben öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Tempo > Tempo der Objektlänge und den Locatorpunkten anpassen

Das Tempo wird der Dauer der selektierten Objekte angepaßt. Mittels Locator bestimmt man, wieviele 
Takte der Länge der selektierten Objekte entsprechen sollen. Die Funktion berechnet dann das genaue 
Tempo, damit die Dauer der Objekte der vorgegebenen Taktzahl entspricht.

Tasturbefehl:
Tempo der Objektlänge und den Locatorpunkten anpassen
(Arrangierfenster)



Haupt-Menü > Optionen > Tempo > Tempo als Liste...

Öffnet eine Liste der eingetragenen Tempo-Änderungen, ähnlich dem Event-Editor.

Tasturbefehl:
Tempo-Liste öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Tempo > Tempo als Graphik...

Öffnet ein Fenster zur grafischen Bearbeitung des Tempos.

Tasturbefehl:
Tempo als Graphik öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Tempo > Tempo-Operationen...

Öffnet ein Fenster zur Berechnung von Änderungen im Tempo.

Tasturbefehl:
Tempo-Operationen öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Tempo > Tempo-Interpreter...

Öffnet ein Fenster in dem man die Paramater zur manuellen Kontrolle des Tempos einstellen kann.

Tasturbefehl:
Tempo Interpreter öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Tempo > Reclock Song...

Ein Dialog zum Berechnen des Song Tempos in Abhängigkeit von MIDI Events wird geöffnet.

Tasturbefehl:
Reclock Song...
(Globale Kommandos)



Haupt-Menü > Optionen > Erweiterte Sequenzeinstellungen...

Öffnet die Erweiterten Sequenzeinstellungen. Hier können die erweiterten Parameter der Sequenzen 
eingestellt werden.

Tasturbefehl:
Erweiterte Sequenz-Parameter
(Globale Kommandos)



Haupt-Menü > Optionen > Mini-Event-Anzeige...

Öffnet ein kleines Floating Window mit den Daten des selektierten Events.

Tasturbefehl:
Event-Editor immer oben öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Video-Spieler...

Mittels Dateiauswahl kann eine Filmdatei angegeben werden, welche dann in einem eigenen Fenster 
synchron zum Sequenzer abgespielt wird.

Tasturbefehl:
Movie öffnen...
(Globale Kommandos)



Haupt-Menü > Optionen > Video Spieler immer oben...

Mittels Dateiauswahl kann eine Filmdatei angegeben werden, welche dann in einem eigenen Fenster 
synchron zum Sequenzer abgespielt wird. Dabei wird der Film in einem schwebenden Fenster angezeigt.



Haupt-Menü > Optionen > Video-Einstellungen...

Hier können die Einstellungen für eine synchron ablaufende Filmdatei eingestellt werden.



Haupt-Menü > Optionen > WavePlayer...

Öffnet die Einstellungen des WavePlayers. Dieser ermöglicht das Triggern von Audio-Dateien per MIDI-
Note.

Tasturbefehl:
WavePlayer...
(Globale Kommandos)



Haupt-Menü > Optionen > Groove-Muster > Groove-Muster erzeugen

Die selektierte Sequenz wird als Quantisierungs-Vorlage eingetragen. Das Raster dieser Sequenz ist 
danach im Quantisierungs-Menü verfügbar.

Tasturbefehl:
Groove-Muster erzeugen
(Arrangierfenster)



Haupt-Menü > Optionen > Groove-Muster > Groove-Muster aus der Liste entfernen

Entfernt die selektierte Sequenz als Quantisierungs-Vorlage. Das Raster dieser Sequenz ist danach nicht 
mehr im Quantisierungs-Menü verfügbar.

Tasturbefehl:
Groove-Muster aus der Liste entfernen
(Arrangierfenster)



Haupt-Menü > Optionen > Groove-Muster > DNA Groove-Muster importieren...

Zeigt eine Übersicht der installierten DNA-Grooves.

Tasturbefehl:
DNA Groove-Muster importieren...
(Arrangierfenster)



Haupt-Menü > Optionen > MIDI-Befehle senden > Maximale Lautstärke

Stellt die MIDI Lautstärke der angeschlossenen Geräte auf das Maximum.

Tasturbefehl:
MIDI-Lautstärke auf Maximum
(Globale Kommandos)



Haupt-Menü > Optionen > MIDI-Befehle senden > Controller rücksetzen

Logic sendet Controller-Meldungen an die angeschlossen Geräte. Diese werden dadurch auf einen 
Standardwert zurückgesetzt, z.B. Lautstärke auf 127, Panorama auf 64 usw.

Tasturbefehl:
MIDI-Controller zurücksetzen
(Globale Kommandos)



Haupt-Menü > Optionen > MIDI-Befehle senden > MIDI-Einstellungen benutzter Instrumente 
senden

Sendet die Einstellungen der Instrumenten-Parameter an die MIDI Geräte.

Tasturbefehl:
MIDI-Einstellungen benutzter Instrumente senden
(Globale Kommandos)



Haupt-Menü > Fenster > Screensets > Lock Screenset

Das gegenwärtige Screenset wird geschützt oder der Schutz wird aufgehoben. Der Schutz wird mit einem 
"ø" neben der Screensetnummer angezeigt. Ein geschütztes Screenset kann zwar verändert werden. 
Wenn es jedoch das nächste mal aufgerufen wird, so wird diejenige Fensterkonfiguration angezeigt, 
welche zum Zeitpunkt der Aktivierung des Schutzes auf dem Blidschirm war.

Tasturbefehl:
øAktuellen Screenset ver-/entriegeln
(Globale Kommandos)



Haupt-Menü > Fenster > Screensets > Screenset kopieren

Kopiert das aktuelle Screenset in die Zwischenablage.

Tasturbefehl:
Screenset kopieren
(Globale Kommandos)



Haupt-Menü > Fenster > Screensets > Screenset einfügen

Fügt ein Screenset aus der Zwischenablage anstelle des aktuellen Screensets ein.

Tasturbefehl:
Screenset einfügen
(Globale Kommandos)



Haupt-Menü > Fenster > Screensets > One

Wechselt zum ersten Screenset.



Haupt-Menü > Fenster > Screensets > Two

Wechselt zum zweiten Screenset.



Haupt-Menü > Fenster > Screensets > Three

Wechselt zum dritten Screenset.



Haupt-Menü > Fenster > Screensets > Four

Wechselt zum vierten Screenset.



Haupt-Menü > Fenster > Arrangierfenster öffnen

Öffnet ein neues Arrangierfenster.

Tasturbefehl:
Arrangierfenster öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Trackmixer öffnen

Öffnet ein Fenster mit dem 'Trackmixer'.

Tasturbefehl:
Track Mixer öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Event-Editor öffnen

Öffnet ein neues Event-Editor-Fenster.

Tasturbefehl:
Event-Editor öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Noten-Editor öffnen

Öffnet ein neues Noten-Editor-Fenster.

Tasturbefehl:
Notenfenster öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Hyper-Editor öffnen

Öffnet ein neues Hyper-Editor-Fenster.

Tasturbefehl:
Hyper-Editor öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Transform-Fenster öffnen

Öffnet ein neues Transform-Fenster.

Tasturbefehl:
Transform-Fenster öffnen
(Globale Kommandos)



Haupt-Menü > Fenster > Matrix-Editor öffnen

Öffnet ein neues Matrix-Editor-Fenster.

Tasturbefehl:
Matrixfenster öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Environment-Fenster öffnen

Öffnet ein neues Environment-Fenster.

Tasturbefehl:
Environment-Fenster öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Transportfenster    öffnen

Öffnet ein neues Transportfenster.

Tasturbefehl:
Transportfenster öffnen...
(Globale Kommandos)



Haupt-Menü > Fenster > Größere Ansicht

Vergrößert die Darstellung des aktuellen Fensters.

Tasturbefehl:
Größere Ansicht
(Größere Ansicht)



Haupt-Menü > Fenster > Kleinere Ansicht

Verkleinert die Darstellung des aktuellen Fensters.

Tasturbefehl:
Kleinere Ansicht
(Globale Kommandos)



Haupt-Menü > Fenster > Nächstes Fenster

Macht das nächste Fenster zum aktuellen Fenster.

Tasturbefehl:
Nächstes Fenster
(Globale Kommandos)



Haupt-Menü > Fenster > Fenstergröße einstellen

Paßt die Größe des aktuellen Fensters dem aktuellen Inhalt an.

Tasturbefehl:
Fenstergröße einstellen
(Globale Kommandos)



Haupt-Menü > Fenster > Fenster schließen

Schließt das aktuelle Fenster.

Tasturbefehl:
Fenster schließen
(Globale Kommandos)



Haupt-Menü > Fenster > Fenster nebeneinander anordnen

Verteilt sämtliche geöffneten Fenster nebeneinander auf dem Bildschirm und paßt deren Größe so an, 
daß alle Fenster sichtbar sind.

Tasturbefehl:
Fenster nebeneinander anordnen
(Globale Kommandos)



Haupt-Menü > Fenster > Fenster untereinander anordnen

Verteilt sämtliche geöffneten Fenster untereinander auf dem Bildschirm und paßt deren Größe so an, daß 
alle Fenster sichtbar sind.

Tasturbefehl:
Fenster untereinander anordnen
(Globale Kommandos)



Haupt-Menü > Fenster > Fenster hintereinander anordnen

Stapelt alle geöffneten Fenster.

Tasturbefehl:
Fenster hintereinander anordnen
(Globale Kommandos)



Arrangierfenster > Über das Arrangierfenster

Sämtliche Befehle unter «Arrangierfenster» sind Befehle des lokalen Menüs dieses Fensters und sind 
daher nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Arrangierfenster > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Arrangierfenster > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Arrangierfenster > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Arrangierfenster > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Arrangierfenster > Bearbeiten > Einfügen an der Originalposition

Objekte aus der Zwischenablage werden zu deren ursprünglichen Zeitpunkt eingesetzt.

Tasturbefehl:
An originaler Position einfügen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Einfügen mit Ersetzen

Objekte aus der Zwischenablage werden eingefügt und ersetzten dabei die selektierten Objekte.

Tasturbefehl:
Einfügen durch Ersetzen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Arrangierfenster > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Arrangierfenster > Bearbeiten > Alle folgenden Objekte auswählen

Alle folgenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Alle folgenden Objekte auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Innerhalb Locatorpunkten auswählen

Alle Objekte im aktuellen Fenster in der Zeit zwischen den Locatorpunkten werden selektiert.

Tasturbefehl:
Alles auswählen innerhalb Locatorpunkten
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Auswahl zurücknehmen außerhalb der Locatorpunkte

Alle Objekte im aktuellen Fenster ausserhalb der Zeit zwischen den Locatorpunkten werden deselektiert.

Tasturbefehl:
Ausserhalb der Lokatorpunkte die Auswahl zurücknehmen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Auswahl umkehren

Die aktuelle Auswahl des obersten Fensters wird umgekehrt. Alle nicht selektierten Objekte werden 
selektiert und umgekehrt.

Tasturbefehl:
Auswahl umkehren
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Leere Objekte auswählen

Alle leeren Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Leere Objekte auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Überlappte Objekte auswählen

Alle überlappenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Überlappte Objekte auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Stummgeschaltete (Mute) Objekte auswählen

Alle stummgeschalteten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
stummgeschaltete (Mute) Objekte auswählen
(Arrangierfenster)



Arrangierfenster > Bearbeiten > Gleichfarbige Objekte auswählen

Alle zur aktuellen Auswahl identisch eingefärbten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
gleichfarbige Objekte auswählen
(Arrangierfenster)



Arrangierfenster > Bearbeiten > Ähnliche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden selektiert. So können 
z.B. alle Noten 'A' selektiert werden, unabhängig von deren Oktavlage.

Tasturbefehl:
Ähnliche Objekte auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Gleiche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die der aktuellen Auswahl entsprechen, werden selektiert. So können 
z.B. alle Controller 10 vom Wert 80 selektiert werden.

Tasturbefehl:
Gleiche Objekte auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Objekte mit gleichem MIDI-Kanal auswählen

Alle Objekte im aktuellen Fenster,    deren MIDI Kanal der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleichem MIDI-Kanal auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Bearbeiten > Objekte mit gleicher Position im Takt auswählen

Alle Objekte im aktuellen Fenster,    deren Positionen im Takt der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleicher Position im Takt auswählen
(Arrangier- und Editierfenster)



Arrangierfenster > Funktionen > Spur > Erzeugen

Eine neue Spur wird angelegt.

Tasturbefehl:
Spur erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Erzeugen mit nächstem Instrument

Eine neue Spur wird angelegt. Sie wird mit dem nächst folgenden Instrument belegt.

Tasturbefehl:
Neue Spur hinzufügen mit nächstem Instrument
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Erzeugen für überlappte Objekte

Überlappende Objekte werden jeweils auf separate neue Spuren gelegt. Dies erhöht die 
Übersichtlichkeit.

Tasturbefehl:
Spuren für überlappte Objekte erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Erzeugen für ausgewählte Objekte

Die selektierten Objekte werden auf eigene Spuren gelegt.

Tasturbefehl:
Spuren für ausgewählte Objekte erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Löschen

Die aktuelle Spur wird gelöscht. Falls die Spur nicht leer sein sollte, erfolgt eine Sicherheitsabfrage.

Tasturbefehl:
Spur löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Unbenutzte löschen

Löscht sämtliche nicht benötigten Spuren, also Spuren, die nicht mit Sequenzen, Ordnern oder Regions 
belegt sind.

Tasturbefehl:
Unbenutzte Spuren löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Redundante Audio-Spuren löschen

Löscht sämtliche Audio-Spuren, die doppelt definiert sind. Das kann geschehen, wenn ein Song aus 
Versionen vor 3.5 geladen wird.



Arrangierfenster > Funktionen > Spur > Spurname erzeugen

Ein vom Instrument unabhängiger Spurname wird auf der aktuellen Spur erzeugt.

Tasturbefehl:
Spurname erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Spurname löschen

Ein vom Instrument unabhängiger Spurname wird auf der aktuellen Spur gelöscht.

Tasturbefehl:
Spurname löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > Neues Instrument erzeugen

Erzeugt ein neues Instrument im Environment und legt dieses auf die aktuelle Spur.

Tasturbefehl:
Neues Instrument erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Spur > SoundDiver für Instrument öffnen

Falls SoundDiver ebenfall gestartet ist, so versucht Logic, das aktuelle Instrument in SoundDiver 
aufzurufen.

Tasturbefehl:
SoundDiver für aktuelles Instrument öffnen
(Arrangierfenster)



Arrangierfenster > Funktionen > Ordner > Ordner einpacken

Die gesamte Auswahl wird in einen Ordner gepackt. Anstatt den selektierten Objekten enthält das 
Arrangierfenster nachher einen Ordner, welcher diese Objekte enthält. 

Tasturbefehl:
Objekte in einen neuen Ordner packen
(Arrangierfenster)



Arrangierfenster > Funktionen > Ordner > Ordner auspacken (neue Spuren erzeugen)

Der selektierte Ordner wird "entpackt". Der Inhalt wird dabei aus dem Ordner auf die nächst höhere 
Ebene verschoben und der Ordner wird gelöscht. Dabei werden neue Spuren angelegt.

Tasturbefehl:
Objekte aus einem Ordner auspacken
(Arrangierfenster)



Arrangierfenster > Funktionen > Ordner > Ordner auspacken (vorhandene Spuren nutzen)

Der selektierte Ordner wird "entpackt". Der Inhalt wird dabei aus dem Ordner auf die nächst höhere 
Ebene verschoben und der Ordner wird gelöscht. Dabei werden vorhandene Spuren genutzt.



Arrangierfenster > Funktionen > Objekt > Objekte wiederholt kopieren

Ein Dialog bezüglich der Wiederholung der selektierten Objekte wird aufgerufen.

Tasturbefehl:
Objekte wiederholt kopieren...
(Arrangier- und Editierfenster)



Arrangierfenster > Funktionen > Objekt > Überlappte Objekte ersetzen

Überlappende Objekte werden ersetzt.

Tasturbefehl:
Überlappte Objekte ersetzen
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > Ausgewählte Objekte auf aktuelle Spur bewegen

Verschiebt die selektierten Objekte auf die aktuelle Spur.

Tasturbefehl:
Ausgewählte Objekte auf aktuelle Spur verschieben
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > Locatorpunkte den Objekten anpassen

Setzt die Position der Locator auf den Anfang und das Ende der gegenwärtig selektierten Objekte.

Tasturbefehl:
Locatorpunkte setzen entsprechend Objekte
(Globale Kommandos)



Arrangierfenster > Funktionen > Objekt > Objektgröße optimieren

Paßt den Anfang und das Ende einer Sequenz möglichst genau an deren Inhalt an.



Arrangierfenster > Funktionen > Objekt > Objekte einrasten

Verschiebt den Anfang der selektierten Objekte auf den nächsten Taktanfang.

Tasturbefehl:
Objekte auf das Raster bewegen
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > Überlappungen beseitigen

Paßt die Längen von sich überlappenden Sequenzen der Auswahl so an, daß sich diese nicht mehr 
überlappen.

Tasturbefehl:
Überlappungen beseitigen
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > Objekte verbinden durch Längenänderung

Verbindet die selektierten Sequenzen, indem deren Länge geändert wird.

Tasturbefehl:
Objekte verbinden durch Längenänderung
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > Objekte verbinden durch Verschieben

Verbindet die selektierten Sequenzen, indem deren Position verändert wird.

Tasturbefehl:
Objekte verbinden durch Verschieben
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > Objekte verbinden innerhalb Locatorpunkte

Verbindet die selektierten Sequenzen, deren Position sich innerhalb der Locators befindet.

Tasturbefehl:
Sequenzen verbinden innerhalb Lokatorpunkte
(Arrangierfenster)



Arrangierfenster > Funktionen > Objekt > SMPTE-Position verriegeln

Die selektierten Objekte werden fest der SMPTE-Zeit ihrer gegenwärtigen Position zugeordnet. Danach 
sind sie unabhängig vom Taktraster und somit auch vom Tempo.

Tasturbefehl:
SMPTE-Position verriegeln
(Arrangier- und Editierfenster)



Arrangierfenster > Funktionen > Objekt > SMPTE-Position entriegeln

Die selektierten Objekte werden von der festen Zuordnung einer SMPTE Zeit gelöst.

Tasturbefehl:
SMPTE-Position entriegeln
(Arrangier- und Editierfenster)



Arrangierfenster > Funktionen > Alias > Erzeugen

Von den selektierten Objekten wird ein Alias auf der aktuellen Spur zum Zeitpunkt der Song Position Line 
angelegt.

Tasturbefehl:
Alias erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Alias > Erzeugen, aber Ordner kopieren

Von den selektierten Objekten wird ein Alias auf der aktuellen Spur zum Zeitpunkt der Song Position Line 
angelegt. Ordner hingegen werden kopiert.



Arrangierfenster > Funktionen > Alias > Neu zuordnen

Die Zuordnung eines Alias kann hiermit verändert werden. Dazu selektiert man ein Alias, sowie eine 
Sequenz, auf die der Alias zeigen soll. Wählt man dann diese Funktion, so verweist danach der Alias auf 
diese Sequenz.

Tasturbefehl:
Alias neu zuordnen
(Arrangierfenster)



Arrangierfenster > Funktionen > Alias > In echte Kopie verwandeln

Der selektierten Alias wird in eine echte Kopie umgewandelt.

Tasturbefehl:
Alia in echte Kopien wandeln
(Arrangierfenster)



Arrangierfenster > Funktionen > Alias > Original auswählen

Ist ein Alias selektiert, so ist nach dem Aufruf dieser Funktion die Sequenz auf die der Alias verweist, 
selektiert.

Tasturbefehl:
Referenz des Alias finden
(Arrangierfenster)



Arrangierfenster > Funktionen > Alias > Alle Alia des Objekts auswählen

Ausgehend von einem Objekt, sind nach dieser Funktion sämtliche Alias dessen selektiert.

Tasturbefehl:
Alle Alia des Objekts auswählen
(Arrangierfenster)



Arrangierfenster > Funktionen > Alias > Verwaiste Alia auswählen

Selektiert sämtliche verwaiste Alia. Ein verwaister Alias ist ein Alias, dessen Original gelöscht worden ist.



Arrangierfenster > Funktionen > Alias > Verwaiste Alia löschen

Löscht sämtliche verwaiste Alia. Ein verwaister Alias ist ein Alias, dessen Original gelöscht worden ist.



Arrangierfenster > Funktionen > Sequenz Parameter > Sequenz-Parameter normalisieren

Die eingestellten Sequenz-Parameter der selektierten Sequenzen werden auf die Daten dieser 
Sequenzen eingerechnet. 

Tasturbefehl:
Normalisieren
(Arrangierfenster)



Arrangierfenster > Funktionen > Sequenz Parameter > Normalisieren ohne MIDI-Kanal

Die eingestellten Sequenz-Parameter der selektierten Sequenzen werden auf die Daten dieser 
Sequenzen eingerechnet. Dabei wird der MIDI Kanal nicht berücksichtigt.

Tasturbefehl:
Normalisieren ohne MIDI-Kanal
(Arrangierfenster)



Arrangierfenster > Funktionen > Sequenz Parameter > Normalize ohne Kanal u. ohne Delay

Die eingestellten Sequenzen-Parameter der selektierten Sequenzen werden auf die Daten dieser 
Sequenzen eingerechnet. Dabei werden    MIDI Kanal    und Delay nicht berücksichtigt.

Tasturbefehl:
Normalisieren ohne MIDI-Kanal & Delay
(Arrangierfenster)



Arrangierfenster > Funktionen > Sequenz Parameter > Quantisierung fixieren

Die Quantisierung wird in die Daten der selektierten Sequenzen hineingerechnet.

Tasturbefehl:
Quantisierung einfrieren
(Arrangierfenster)



Arrangierfenster > Funktionen > Sequenz Parameter > Schleifen in echte Kopien umwandeln

Aus Loops werden echte Kopien erzeugt, welche dann eigene Daten enthalten.

Tasturbefehl:
Erzeuge aus Schleifen echte Kopien
(Arrangierfenster)



Arrangierfenster > Funktionen > Sequenz Parameter > Schleifen in Alia umwandeln

Loops werden in Alia verwandelt. 

Tasturbefehl:
Aus Schleifen "Alia" (Verweise) erzeugen
(Arrangierfenster)



Arrangierfenster > Funktionen > Instrument-Parameter > Variabler Program Change einfügen

Ein variabler Program Change Befehl wird in die selektierten Sequenzen eingetragen. Ein variabler 
Program Change ist ein Program Change, welcher stets die in den Instrumenten-Paramter eingestellte 
Programm-Nummer übernimmt.

Tasturbefehl:
Variablen Programmwechselbefehl einfügen
(Arrangierfenster)



Arrangierfenster > Funktionen > Instrument-Parameter > MIDI-Einstellungen als Events einfügen

Die Einstellungen der Instrumenten-Parameter werden in die selektierten Sequenzen eingetragen.

Tasturbefehl:
Instrument-MIDI-Einstellungen als Events einfügen
(Arrangierfenster)



Arrangierfenster > Funktionen > Takt- und Schlüsselwechsel > Alle in Ablage kopieren

Kopiert sämtliche Taktart- und Tonart-Wechsel in die Zwischenablage.



Arrangierfenster > Funktionen > Takt- und Schlüsselwechsel > Alle aus der Ablage einfügen

Fügt sämtliche kopierten Taktart- und Tonart-Wechsel aus der Zwischenablage ein.



Arrangierfenster > Funktionen > Papierkorb > Papierkorb öffnen

Öffnet den Papierkorb. Darin enthalten sind gelöschte Sequenzen.

Tasturbefehl:
Papierkorb öffnen
(Arrangierfenster)



Arrangierfenster > Funktionen > Papierkorb > Papierkorb entleeren

Löscht den Papierkorb.

Tasturbefehl:
Papierkorb entleeren
(Arrangierfenster)



Arrangierfenster > Funktionen > Teilen/Trennen > Objekte entsprechend der Locatorpunkte 
schneiden

Die selektierten Objekte werden jeweils beim Zeitpunkt des linken und rechtem Locators zerschnitten.

Tasturbefehl:
Objekte anhand der Locatorpunkte trennen
(Arrangierfenster)



Arrangierfenster > Funktionen > Teilen/Trennen > Objekte an der Songposition schneiden

Die selektierten Objekte werden an der aktuellen Songposition zerschnitten.

Tasturbefehl:
Objekte anhand der Songposition trennen
(Arrangierfenster)



Arrangierfenster > Funktionen > Teilen/Trennen > nach Event-Kanal auftrennen

Die selektierten Sequenzen werden aufgrund der MIDI Kanäle der Events aufgeteilt. Auf diese Weise 
kann ein MIDI File des Typs 0 (alle Daten in einer Sequenz) aufgeteilt werden, so daß jedes Instrument 
auf einer eigenen Spur liegt. 

Tasturbefehl:
Nach Event-Kanal trennen
(Arrangierfenster)



Arrangierfenster > Funktionen > Teilen/Trennen > Objekte nach Tonhöhe auftrennen

Die selektierten Sequenzen werden aufgrund der Tonhöhe aufgeteilt. Auf diese Weise können Akkorde so 
aufgeteilt werden, daß jede Stimme auf einer eigenen Spur liegt. 



Arrangierfenster > Funktionen > Mischen > Alle Objekte

Sind mehrere Sequenzen selektiert, so werden diese zu einer einzigen zusammengemischt.

Tasturbefehl:
Objekte mischen/Digitaler Mixdown
(Arrangierfenster)



Arrangierfenster > Funktionen > Mischen > Objekte pro Spur

Die Objekte werden pro Spur zusammengemischt.

Tasturbefehl:
Objekte pro Spur mischen
(Arrangierfenster)



Arrangierfenster > Funktionen > Zeitabschn. ausschn./einf. > Zeitabschnitt herausschneiden

Schneidet wahlweise aus den selektierten Objekten oder dem ganzen Song den Bereich zwischen dem 
linken und rechten Locator heraus und rückt die folgenden Teile nach.

Tasturbefehl:
Snip: Zeitbereich herausschneiden
(Arrangierfenster)



Arrangierfenster > Funktionen > Zeitabschn. ausschn./einf. > Zeitabschnitt einfügen

Fügt wahlweise den selektierten Objekten oder dem ganzen Song den Bereich zwischen dem linken und 
rechten Locator ein und schiebt die folgenden Teile entsprechend hinaus.

Tasturbefehl:
Zeitbereich einfügen
(Arrangierfenster)



Arrangierfenster > Funktionen > Zeitabschn. ausschn./einf. > Herausgeschnittenen Zeitabschnitt 
an Songposition einfügen

Kopiert wahlweise den selektierten Objekten oder dem ganzen Song den Bereich zwischen dem linken 
und rechten Locator an die aktuelle Song Position.

Tasturbefehl:
Splice: Herausgeschnittenen Zeitbereich an der Songposition einfügen
(Arrangierfenster)



Arrangierfenster > Funktionen > MIDI-Events löschen > Duplikate

Doppelte Events werden gelöscht.

Tasturbefehl:
Doppelte Events löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > MIDI-Events löschen > Zwischen den Locatorpunkten

Alle MIDI Events zwischen den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Innerhalb der Lokatorpunkte löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > MIDI-Events löschen > Ausserhalb der Locatorpunkte

Alle MIDI Events ausserhalb den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Ausserhalb der Lokatorpunkte löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > MIDI-Events löschen > Ausserhalb der Objektgrenzen

Alle MIDI Events ausserhalb von Start und Ende der Sequenz werden aus den selektierten Sequenzen 
gelöscht.

Tasturbefehl:
Ausserhalb der jeweiligen Objektgrenzen löschen
(Arrangierfenster)



Arrangierfenster > Funktionen > MIDI-Events löschen > Nichtausgewählte innerhalb der Auswahl

Sämtliche nicht selektierten Objekte, welche sich zwischen selektierten Objekten befinden, werden 
gelöscht.

Tasturbefehl:
Innerhalb der Auswahl nicht ausgewähltes löschen
(Arrangier- und Editierfenster)



Arrangierfenster > Funktionen > MIDI-Events kopieren...

Ein Dialog zum Kopieren von MIDI Events wird geöffnet.

Tasturbefehl:
MIDI-Events kopieren...
(Globale Kommandos)



Arrangierfenster > Audio > Regionen auf originale Aufnahmeposition

Setzt die selektierten Audio-Regionen an die Position im Song, an der sie ursprünglich aufgezeichnet 
wurden.

Tasturbefehl:
Regionen auf die originale Aufnahmeposition setzen
(Arrangierfenster)



Arrangierfenster > Audio > Regionen zu individuellen Regionen wandeln

Erzeugt aus der selektierten Audio Region eine von anderen Regions unabhängige neue Region von 
gleicher Länge und Startpunkt.

Tasturbefehl:
Regionen unabhängig machen
(Arrangierfenster)



Arrangierfenster > Audio > Regionen zu individuellen Audiodateien wandeln

Erzeugt aus den selektierten Regionen unabhängige Audio-Dateien.

Tasturbefehl:
Regionen in neue Audio-Dateien wandeln
(Arrangierfenster)



Arrangierfenster > Audio > Digitaler Mixdown

Sind mehrere Audio Regions selektiert, so werden diese digital zusammengemischt und eine neue Audio-
Datei mit dem Resultat tritt an deren Stelle. Dabei werden die momentanen Einstellungen bezüglich 
Volume und Panorama, sowie die Einstellungen der Audio Überblend-Optionen mitberücksichtigt.



Arrangierfenster > Audio > Standard Audio Überblend-Optionen...

Dieser Dialog bezieht sich auf die Überblendung beim digitalen Zusammenmischen von Audio Regions. 
Dabei kann eine Kurve und die gewünschte Überblendzeit eingestellt werden.

Tasturbefehl:
Audio-Crossfade-Optionen beim Mischen...
(Arrangierfenster)



Arrangierfenster > Audio > Null-Durchgänge suchen

Bei aktivierter Funktion werden beim Schneiden immer die nächstliegenden Nulldurchgänge als 
Schnittpunkte berücksichtigt. Diese können zwar von eigentlichen Schnittpunkt etwas abweichen, es 
entstehen dafür an den Schnittpunkten keine Knackser.



Arrangierfenster > Ansicht > Hyper Draw > aus

Hyper Draw wird für die selektierten Sequenzen ausgeschaltet.

Tasturbefehl:
Hyper Draw: ausschalten
(Arrangierfenster)



Arrangierfenster > Ansicht > Hyper Draw > automatisch definieren

Hyper Draw wird automatisch auf den ersten Event der Sequenz eingestellt.

Tasturbefehl:
Hyper Draw: automatisch definieren
(Arrangierfenster)



Arrangierfenster > Ansicht > Hyper Draw > Kanal

Hier wird der MIDI Kanal für die Darstellung und Eingabe des Hyper Draw gewählt.



Arrangierfenster > Ansicht > Hyper Draw > Lautstärke

Die selektierten Sequenzen werden mit Hyper Draw für Lautstärke (Controller 07) dargestellt.

Tasturbefehl:
Hyper Draw: Lautstärke
(Arrangierfenster)



Arrangierfenster > Ansicht > Hyper Draw > Panorama

Die selektierten Sequenzen werden mit Hyper Draw für Panorama (Controller 10) dargestellt.

Tasturbefehl:
Hyper Draw: Panorama
(Arrangierfenster)



Arrangierfenster > Ansicht > Hyper Draw > Balance

Die selektierten Sequenzen werden mit Hyper Draw für Balance (Controller 08) dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Modulation

Die selektierten Sequenzen werden mit Hyper Draw für Modulation (Controller 01) dargestellt.

Tasturbefehl:
Hyper Draw: Modulation
(Arrangierfenster)



Arrangierfenster > Ansicht > Hyper Draw > Blaswandler

Die selektierten Sequenzen werden mit Hyper Draw für Blaswandler (Controller 02) dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Fußpedal

Die selektierten Sequenzen werden mit Hyper Draw für Fußpedal (Controller 04) dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Port.-Zeit

Die selektierten Sequenzen werden mit Hyper Draw für die Potamento-Zeit (Controller 05) dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Ausdruck

Die selektierten Sequenzen werden mit Hyper Draw für Ausdruck (Controller 11) dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Andere...

Öffnet ein Dialog zur Manuellen Eingabe einer Controller-Nummer zur Darstellung als Hyper Draw.

Tasturbefehl:
Hyper Draw: Andere...
(Arrangierfenster)



Arrangierfenster > Ansicht > Hyper Draw > Druck (Channel Pressure)

Die selektierten Sequenzen werden mit Hyper Draw für Druck (Channel Pressure, auch Aftertouch 
genannt) dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Tonhöhenbeugerad

Die selektierten Sequenzen werden mit Hyper Draw für Tonhöhenbeugerad dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Programmwechselbefehl

Die selektierten Sequenzen werden mit Hyper Draw für Programmwechselbefehle dargestellt.



Arrangierfenster > Ansicht > Hyper Draw > Anschlagstärke

Die selektierten Sequenzen werden mit Hyper Draw für Anschlagstärke dargestellt.



Arrangierfenster > Ansicht > Scrolling bei Wiedergabe

Während der Wiedergabe bewegt sich der Fensterinhalt. Ist diese Funktion ausgeschaltet, so bewegt 
sich nur die Songposition-Line.



Arrangierfenster > Ansicht > SMPTE-Lineal

Die Angaben bezüglich Zeit im Lineal und in den Positionsangaben werden als SMPTE-Einheiten 
dargestellt.



Arrangierfenster > Ansicht > Laufwerktasten

Blendet die Transport-Funktionen im aktuellen Fenster ein oder aus.



Arrangierfenster > Ansicht > Parameter

Blendet die Paramater im aktuellen Fenster ein oder aus.

Tasturbefehl:
Zeige/verstecke Parameter
(Verschiedene Fenster)



Arrangierfenster > Ansicht > Werkzeuge

Blendet die Werkzeugpalette im aktuellen Fenster ein oder aus.



Arrangierfenster > Ansicht > Delay in ms

Schaltet die Darstellung von Delays zwischen ms oder Ticks um.

Tasturbefehl:
Delay in ms
(Arrangierfenster)



Arrangierfenster > Ansicht > Raster

Schaltet die Darstellung des Rasters ein oder aus.



Arrangierfenster > Ansicht > Weißer Hintergrund

Schaltet die Darstellung des Hintergrundes auf weiß ein oder aus.

Tasturbefehl:
Hintergrund ändern
(Arrangierfenster)



Arrangierfenster > Ansicht > Objekt-Inhalt

Schaltet die schematische Darstellung des Inhalts von Objekten ein oder aus.

Tasturbefehl:
Objekt-Inhalt
(Arrangierfenster)



Arrangierfenster > Ansicht > Spurnummer/Levelmeter

Blendet den Bereich der Spurnummern und Levelmetern ein oder aus.



Arrangierfenster > Ansicht > Mute-Schalter

Blendet den Bereich der Schaltflächen zur Stummschaltung der Spur ein oder aus.



Arrangierfenster > Ansicht > Aufnahme-Schalter

Blendet den Bereich der Aufnahme-Schalter ein oder aus.



Arrangierfenster > Ansicht > Instrument Icon

Blendet den Bereich der Instrumenten-Symbole ein oder aus.



Arrangierfenster > Ansicht > Schatten für Instrument Icon

Wahlweise können die Instrumenten-Symbole mit einem Schatten hinterlegt werden.



Arrangierfenster > Ansicht > Instrumentname

Blendet den Bereich der Instrumentname ein oder aus.



Arrangierfenster > Ansicht > Spurname

Blendet den Bereich der Spurname ein oder aus.



Arrangierfenster > Ansicht > Auswahl darstellen

Der Inhalt im aktuellen Fenster verschoben, damit die aktuelle Auswahl sichtbar wird.

Tasturbefehl:
Auswahl im Fenster darstellen
(Arrangier- und Editierfenster)



Arrangierfenster > Ansicht > Instrumentfarbe auf Objekte übertragen

Färbt die selektierten Objekte mit der Farbe des Instrumentes ein.

Tasturbefehl:
Instrumentenfarbe für Objekte verwenden
(Arrangierfenster)



Arrangierfenster > Ansicht > Spurname auf Objekte übertragen

Benennt die selektierten Objekte nach dem Spurnamen.

Tasturbefehl:
Spurnamen für Objekte verwenden
(Arrangierfenster)



Arrangierfenster > Ansicht > Objektfarben...

Öffnet die Farbpalette zum Einfärben von Sequenzen, Instrumenten, Markierungen usw.

Tasturbefehl:
Objektfarben öffnen...
(Globale Kommandos)



Trackmixer > Über den Trackmixer

Sämtliche Befehle unter «Trackmixer» sind Befehle des lokalen Menüs dieses Fensters und sind daher 
nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Trackmixer > Spuren > MIDI -Spuren

Wahlweise werden die Mixer-Objekte für die MIDI-Spuren im Trackmixer dargestellt.



Trackmixer > Spuren > Audio-Spuren

Wahlweise werden die Mixer-Objekte für die Audio-Spuren im Trackmixer dargestellt.



Trackmixer > Spuren > Ordner-Spuren

Wahlweise werden die Mixer-Objekte für Ordner-Spuren im Trackmixer dargestellt.



Trackmixer > Spuren > Andere Spuren

Wahlweise werden die Mixer-Objekte für andere Spuren im Trackmixer dargestellt.



Trackmixer > Spuren > zusätzlich Bus Return 1

Wahlweise wird das Mixer-Objekt für den Audio-Bus 1 im Trackmixer dargestellt.



Trackmixer > Spuren > zusätzlich Bus Return 2

Wahlweise wird das Mixer-Objekt für den Audio-Bus 2 im Trackmixer dargestellt.



Trackmixer > Spuren > zusätzlich Master(s)

Wahlweise werden im Trackmixer die Mixer-Objekte für die Masters dargestellt.



Trackmixer > Spuren > zusätzlich GS/XG Effects

Wahlweise lassen sich im Trackmixer die Parameter zur Einstellung von Effekten im GS/XG-Format 
darstellen.



Trackmixer > Ansicht > Legende

Eine Legende wird auf der linken Seite des Track-Mixers eingeblendet.



Trackmixer > Ansicht > Instrument-Name

Der Name der jeweiligen Instrumente wird angezeigt.



Trackmixer > Ansicht > Programm

Das Programm des MIDI-Instrumentes wird angezeigt.



Trackmixer > Ansicht > Bank

Die Programmbank des MIDI-Instrumentes wird dargestellt.



Trackmixer > Ansicht > Regler 1

Im Kanal der MIDI-Instrumente wird ein Regler für den ersten zugeordneten Controller dargestellt.



Trackmixer > Ansicht > Regler 2

Im Kanal der MIDI-Instrumente wird ein Regler für den zweiten zugeordneten Controller dargestellt.



Trackmixer > Ansicht > Regler 3

Im Kanal der MIDI-Instrumente wird ein Regler für den dritten zugeordneten Controller dargestellt.



Trackmixer > Ansicht > Regler 4

Im Kanal der MIDI-Instrumente wird ein Regler für den vierten zugeordneten Controller dargestellt.



Trackmixer > Ansicht > Regler 5

Im Kanal der MIDI-Instrumente wird ein Regler für den fünften zugeordneten Controller dargestellt.



Trackmixer > Ansicht > Pan

Der Regler für das Panorama wird dargestellt.



Trackmixer > Ansicht > Volume

Der Regler für die Lautstärke wird dargestellt.



Trackmixer > Ansicht > Spurname

Blendet den Bereich der Spurname ein oder aus.



Trackmixer > Ansicht > Spurnummer

Die Spurnummer wird angezeigt.



Trackmixer > Optionen > Mixer Automation: Mischen

Beim Aufzeichnen des Mixers werden die neuen Daten mit bereits vorhandenen Daten 
zusammengemischt.



Trackmixer > Optionen > Mixer Automation: Ersetzen

Beim Aufzeichnen des Mixers ersetzten die neuen Daten bereits vorhandene Daten.



Trackmixer > Optionen > Mixer Automation: Update

Beim Aufzeichnen des Mixers ersetzten die neuen Daten bereits vorhandene Daten an der selben 
Position.



Trackmixer > Optionen > Automation: Anpassungszeit...

Ermöglicht die Einstellung einer Übergangszeit, in der eine Überblendung bereits vorhandener Daten mit 
neuen Daten erfolgt.



Trackmixer > Optionen > Alle Mischereinstellungen senden

Die Daten der gegenwärtigen Einstellungen des Mixer werden gesendet.



Trackmixer > Optionen > Spur im Aufnahmemodus auswählen

Im Aufnahme-Modus wird durch das Anwählen eines Mixer-Objektes die entsprechende Spur im 
Arrangierfenster selektiert.



Trackmixer > Optionen > Spur im Wiedergabemodus auswählen

Im Wiedergabe-Modus wird durch das Anwählen eines Mixer-Objektes die entsprechende Spur im 
Arrangierfenster selektiert.



Event-Editor > Über die Event-Editor

Sämtliche Befehle unter «Event-Editor» sind Befehle des lokalen Menüs dieses Fensters und sind daher 
nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Event-Editor > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Event-Editor > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Event-Editor > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Event-Editor > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Event-Editor > Bearbeiten > Einfügen an der Originalposition

Objekte aus der Zwischenablage werden zu deren ursprünglichen Zeitpunkt eingesetzt.

Tasturbefehl:
An originaler Position einfügen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Einfügen mit Ersetzen

Objekte aus der Zwischenablage werden eingefügt und ersetzten dabei die selektierten Objekte.

Tasturbefehl:
Einfügen durch Ersetzen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Event-Editor > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Event-Editor > Bearbeiten > Alle folgenden Objekte auswählen

Alle folgenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Alle folgenden Objekte auswählen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Innerhalb Locatorpunkten auswählen

Alle Objekte im aktuellen Fenster in der Zeit zwischen den Locatorpunkten werden selektiert.

Tasturbefehl:
Alles auswählen innerhalb Locatorpunkten
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Auswahl zurücknehmen außerhalb der Locatorpunkte

Alle Objekte im aktuellen Fenster ausserhalb der Zeit zwischen den Locatorpunkten werden deselektiert.

Tasturbefehl:
Ausserhalb der Lokatorpunkte die Auswahl zurücknehmen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Auswahl umkehren

Die aktuelle Auswahl des obersten Fensters wird umgekehrt. Alle nicht selektierten Objekte werden 
selektiert und umgekehrt.

Tasturbefehl:
Auswahl umkehren
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Leere Objekte auswählen

Alle leeren Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Leere Objekte auswählen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Überlappte Objekte auswählen

Alle überlappenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Überlappte Objekte auswählen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Stummgeschaltete (Mute) Objekte auswählen

Alle stummgeschalteten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
stummgeschaltete (Mute) Objekte auswählen
(Arrangierfenster)



Event-Editor > Bearbeiten > Gleichfarbige Objekte auswählen

Alle zur aktuellen Auswahl identisch eingefärbten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
gleichfarbige Objekte auswählen
(Arrangierfenster)



Event-Editor > Bearbeiten > Ähnliche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden selektiert. So können 
z.B. alle Noten 'A' selektiert werden, unabhängig von deren Oktavlage.

Tasturbefehl:
Ähnliche Objekte auswählen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Gleiche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die der aktuellen Auswahl entsprechen, werden selektiert. So können 
z.B. alle Controller 10 vom Wert 80 selektiert werden.

Tasturbefehl:
Gleiche Objekte auswählen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Objekte mit gleichem MIDI-Kanal auswählen

Alle Objekte im aktuellen Fenster,    deren MIDI Kanal der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleichem MIDI-Kanal auswählen
(Arrangier- und Editierfenster)



Event-Editor > Bearbeiten > Objekte mit gleicher Position im Takt auswählen

Alle Objekte im aktuellen Fenster,    deren Positionen im Takt der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleicher Position im Takt auswählen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Locatorpunkte den Objekten anpassen

Setzt die Position der Locator auf den Anfang und das Ende der gegenwärtig selektierten Objekte.

Tasturbefehl:
Locatorpunkte setzen entsprechend Objekte
(Globale Kommandos)



Event-Editor > Funktionen > Erneut quantisieren

Die selektierten Objekt im aktuellen Fenster werden erneut quantisiert. 

Tasturbefehl:
øErneut quantisieren
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Dequantisieren

Hebt die Quantisierung der selektierten Objekte im aktuellen Fenster auf. 

Tasturbefehl:
Quantisierung zurücknehmen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > MIDI-Events löschen > Duplikate

Doppelte Events werden gelöscht.

Tasturbefehl:
Doppelte Events löschen
(Arrangierfenster)



Event-Editor > Funktionen > MIDI-Events löschen > Zwischen den Locatorpunkten

Alle MIDI Events zwischen den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Innerhalb der Lokatorpunkte löschen
(Arrangierfenster)



Event-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Locatorpunkte

Alle MIDI Events ausserhalb den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Ausserhalb der Lokatorpunkte löschen
(Arrangierfenster)



Event-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Objektgrenzen

Alle MIDI Events ausserhalb von Start und Ende der Sequenz werden aus den selektierten Sequenzen 
gelöscht.

Tasturbefehl:
Ausserhalb der jeweiligen Objektgrenzen löschen
(Arrangierfenster)



Event-Editor > Funktionen > MIDI-Events löschen > Nichtausgewählte innerhalb der Auswahl

Sämtliche nicht selektierten Objekte, welche sich zwischen selektierten Objekten befinden, werden 
gelöscht.

Tasturbefehl:
Innerhalb der Auswahl nicht ausgewähltes löschen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/alle)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/Auswahl)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Notenüberlappungskorrektur nur für gleiche Noten

Das Überlappen der selektierten Noten mit identischen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:

(Arrange and Various Sequence Editors)



Event-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/alle)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/Auswahl)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Oberste Linie auswählen

Selektiert die höchste Stimme im aktuellen Fenster. Jeweils die höchste Note eines Akkordes wird 
selektiert.

Tasturbefehl:
Oberste Stimmführung auswählen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Unterste Linie auswählen

Selektiert die tiefste Stimme im aktuellen Fenster. Jeweils die tiefste Note eines Akkordes wird selektiert.

Tasturbefehl:
Unterste Stimmführung auswählen
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Jeder Linie einen MIDI-Kanal zuordnen

In der aktuellen Auswahl werden den Noten eines Akkordes MIDI-Kanäle zugeordnet. Dabei erhält die 
höchste Note den MIDI Kanal 1, die nächst tiefere den Kanal 1 usw.

Tasturbefehl:
Stimmführung zu MIDI-Kanäle
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Noten > Haltepedal in Notenlänge wandeln

In der aktuellen Auswahl wird die Länge der Noten jeweils der Dauer des Sustains angepaßt. Die Sustain 
Befehle sind danach nicht mehr nötig und werden gelöscht.

Tasturbefehl:
Nachhalte-Pedal zu Notenlänge konvertieren
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > MIDI-Events kopieren...

Ein Dialog zum Kopieren von MIDI Events wird geöffnet.

Tasturbefehl:
MIDI-Events kopieren...
(Globale Kommandos)



Event-Editor > Funktionen > SMPTE-Position entriegeln

Die selektierten Objekte werden von der festen Zuordnung einer SMPTE Zeit gelöst.

Tasturbefehl:
SMPTE-Position entriegeln
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > SMPTE-Position verriegeln

Die selektierten Objekte werden fest der SMPTE-Zeit ihrer gegenwärtigen Position zugeordnet. Danach 
sind sie unabhängig vom Taktraster und somit auch vom Tempo.

Tasturbefehl:
SMPTE-Position verriegeln
(Arrangier- und Editierfenster)



Event-Editor > Funktionen > Transformieren

Ruft die verschiedenen Presets des Transform-Fensters auf. Im Transform definierte Presets erscheinen 
automatisch in diesem Menu.



Event-Editor > Ansicht > Positions & Länge in SMPTE

Die Angaben bezüglich Zeit im Lineal und in den Positionsangaben werden als SMPTE-Einheiten 
dargestellt.



Event-Editor > Ansicht > Länge als absolute Position

Anstatt der Notenlänge wird der absolute Zeitpunkt des Endes dargestellt.
(Notenanfang + Notenlänge = Notenende)

Tasturbefehl:
Länge als absolute Position anzeigen
(Event-Fenster)



Event-Editor > Ansicht > Relative Position

Die Positionen in Bezug zum Sequenzenanfang dargestellt. Normalerweise bezieht sich die Darstellung 
auf den Song.

Tasturbefehl:
lokale Position
(Event-Fenster)



Event-Editor > Ansicht > Parameter

Blendet die Paramater im aktuellen Fenster ein oder aus.

Tasturbefehl:
Zeige/verstecke Parameter
(Verschiedene Fenster)



Event-Editor > Ansicht > Sysex hexadezimal

Die Darstellung von System Exklusiven Daten (Sysex) kann wahlweise in dezimaler oder hexadezimaler 
Darstellung erfolgen. Vielfach werden die Angaben des Geräte-Herstellers in hexadezimaler Form 
geliefert.



Event-Editor > Ansicht > Auswahl darstellen

Der Inhalt im aktuellen Fenster verschoben, damit die aktuelle Auswahl sichtbar wird.

Tasturbefehl:
Auswahl im Fenster darstellen
(Arrangier- und Editierfenster)



Noten-Editor > Über den Noten-Editor

Sämtliche Befehle unter «Noten-Editor» sind Befehle des lokalen Menüs dieses Fensters und sind daher 
nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Noten-Editor > Layout > Notenzeilenformate...

Öffnet ein Fenster zur Einstellung der verschiedenen Notationsformate (Score Styles).

Tasturbefehl:
Notenzeilenformate öffnen
(Notenfenster)



Noten-Editor > Layout > Instrumentengruppen...

Öffnet ein Fenster zur Einstellung der Darstellung für die Partitur (Instrument Sets).

Tasturbefehl:
Instrumentengruppen öffnen
(Notenfenster)



Noten-Editor > Layout > Globale Layouteinstellungen...

Öffnet das Fenster "Song-Einstellungen" mit dem Abschnitt bezogen auf die globale Formatierung.

Tasturbefehl:
Globale Layouteinstellungen
(Notenfenster)



Noten-Editor > Layout > Nummern und Namen...

Öffnet das Fenster "Song Settings" mit dem Abschnitt bezogen auf die Numerierungen.

Tasturbefehl:
Einstellungen: Nummern und Namen
(Notenfenster)



Noten-Editor > Layout > Gitarrentabulatur...

Öffnet das Fenster "Song Settings" mit dem Abschnitt bezogen auf die Gitarren Tabulatur.

Tasturbefehl:
Einstellungen: Gitarrentabulatur
(Notenfenster)



Noten-Editor > Layout > Schlüssel, Takt und Tonart ...

Öffnet das Fenster "Song Settings" mit dem Abschnitt bezogen auf die Darstellung von Taktart, Tonart und 
Instrumentennamen.



Noten-Editor > Layout > Erweiterte Layoutparameter...

Öffnet das Fenster "Song Settings" mit dem Abschnitt bezogen auf die erweiterten Darstellungsparamter.



Noten-Editor > Layout > Midi Meaning ...

Öffnet das Fenster "Song Settings" mit dem Abschnitt bezogen auf die Midi Meaning, also dem Einfluß 
von grafischen Zeichen auf die Midi-Wiedergabe.



Noten-Editor > Layout > Instrumentengruppe für Auswahl erzeugen

Erzeugt aus den momentan selektierten Instrumenten ein neue Instrument Set.

Tasturbefehl:
Instrumentengruppe für Auswahl erzeugen
(Notenfenster)



Noten-Editor > Layout > Zeilenumbruch zurücksetzen

Setzt die manuellen Umbrüche usw. zurück.

Tasturbefehl:
Zeilenumbruch löschen
(Notenfenster)



Noten-Editor > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Noten-Editor > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Noten-Editor > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Noten-Editor > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Noten-Editor > Bearbeiten > Mehrfach einfügen

Der Inhalt der    Zwischenablage wird mehrfach eingefügt.

Tasturbefehl:
Mehrfach einfügen
(Notenfenster)



Noten-Editor > Bearbeiten > Einfügen an der Originalposition

Objekte aus der Zwischenablage werden zu deren ursprünglichen Zeitpunkt eingesetzt.

Tasturbefehl:
An originaler Position einfügen
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Noten-Editor > Bearbeiten > Objekte wiederholt kopieren

Ein Dialog bezüglich der Wiederholung der selektierten Objekte wird aufgerufen.

Tasturbefehl:
Objekte wiederholt kopieren...
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Noten-Editor > Bearbeiten > Alle folgenden Objekte auswählen

Alle folgenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Alle folgenden Objekte auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Innerhalb Locatorpunkten auswählen

Alle Objekte im aktuellen Fenster in der Zeit zwischen den Locatorpunkten werden selektiert.

Tasturbefehl:
Alles auswählen innerhalb Locatorpunkten
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Auswahl zurücknehmen außerhalb der Locatorpunkte

Alle Objekte im aktuellen Fenster ausserhalb der Zeit zwischen den Locatorpunkten werden deselektiert.

Tasturbefehl:
Ausserhalb der Lokatorpunkte die Auswahl zurücknehmen
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Auswahl umkehren

Die aktuelle Auswahl des obersten Fensters wird umgekehrt. Alle nicht selektierten Objekte werden 
selektiert und umgekehrt.

Tasturbefehl:
Auswahl umkehren
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Ähnliche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden selektiert. So können 
z.B. alle Noten 'A' selektiert werden, unabhängig von deren Oktavlage.

Tasturbefehl:
Ähnliche Objekte auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Gleiche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die der aktuellen Auswahl entsprechen, werden selektiert. So können 
z.B. alle Controller 10 vom Wert 80 selektiert werden.

Tasturbefehl:
Gleiche Objekte auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Objekte mit gleichem MIDI-Kanal auswählen

Alle Objekte im aktuellen Fenster,    deren MIDI Kanal der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleichem MIDI-Kanal auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Bearbeiten > Objekte mit gleicher Position im Takt auswählen

Alle Objekte im aktuellen Fenster,    deren Positionen im Takt der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleicher Position im Takt auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Locatorpunkte den Objekten anpassen

Setzt die Position der Locator auf den Anfang und das Ende der gegenwärtig selektierten Objekte.

Tasturbefehl:
Locatorpunkte setzen entsprechend Objekte
(Globale Kommandos)



Noten-Editor > Funktionen > Erneut quantisieren

Die selektierten Objekt im aktuellen Fenster werden erneut quantisiert. 

Tasturbefehl:
øErneut quantisieren
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Dequantisieren

Hebt die Quantisierung der selektierten Objekte im aktuellen Fenster auf. 

Tasturbefehl:
Quantisierung zurücknehmen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > MIDI-Events löschen > Duplikate

Doppelte Events werden gelöscht.

Tasturbefehl:
Doppelte Events löschen
(Arrangierfenster)



Noten-Editor > Funktionen > MIDI-Events löschen > Zwischen den Locatorpunkten

Alle MIDI Events zwischen den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Innerhalb der Lokatorpunkte löschen
(Arrangierfenster)



Noten-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Locatorpunkte

Alle MIDI Events ausserhalb den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Ausserhalb der Lokatorpunkte löschen
(Arrangierfenster)



Noten-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Objektgrenzen

Alle MIDI Events ausserhalb von Start und Ende der Sequenz werden aus den selektierten Sequenzen 
gelöscht.

Tasturbefehl:
Ausserhalb der jeweiligen Objektgrenzen löschen
(Arrangierfenster)



Noten-Editor > Funktionen > MIDI-Events löschen > Nichtausgewählte innerhalb der Auswahl

Sämtliche nicht selektierten Objekte, welche sich zwischen selektierten Objekten befinden, werden 
gelöscht.

Tasturbefehl:
Innerhalb der Auswahl nicht ausgewähltes löschen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/alle)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/Auswahl)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Notenüberlappungskorrektur nur für gleiche Noten

Das Überlappen der selektierten Noten mit identischen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:

(Arrange and Various Sequence Editors)



Noten-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/alle)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/Auswahl)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Oberste Linie auswählen

Selektiert die höchste Stimme im aktuellen Fenster. Jeweils die höchste Note eines Akkordes wird 
selektiert.

Tasturbefehl:
Oberste Stimmführung auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Unterste Linie auswählen

Selektiert die tiefste Stimme im aktuellen Fenster. Jeweils die tiefste Note eines Akkordes wird selektiert.

Tasturbefehl:
Unterste Stimmführung auswählen
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Jeder Linie einen MIDI-Kanal zuordnen

In der aktuellen Auswahl werden den Noten eines Akkordes MIDI-Kanäle zugeordnet. Dabei erhält die 
höchste Note den MIDI Kanal 1, die nächst tiefere den Kanal 1 usw.

Tasturbefehl:
Stimmführung zu MIDI-Kanäle
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > Noten > Haltepedal in Notenlänge wandeln

In der aktuellen Auswahl wird die Länge der Noten jeweils der Dauer des Sustains angepaßt. Die Sustain 
Befehle sind danach nicht mehr nötig und werden gelöscht.

Tasturbefehl:
Nachhalte-Pedal zu Notenlänge konvertieren
(Arrangier- und Editierfenster)



Noten-Editor > Funktionen > MIDI-Events kopieren...

Ein Dialog zum Kopieren von MIDI Events wird geöffnet.

Tasturbefehl:
MIDI-Events kopieren...
(Globale Kommandos)



Noten-Editor > Funktionen > Transformieren

Ruft die verschiedenen Presets des Transform-Fensters auf. Im Transform definierte Presets erscheinen 
automatisch in diesem Menu.



Noten-Editor > Attribute > Vorzeichen > Grundeinstellung

Setzt die Einstellungen der selektierten Noten bezüglich enharmonischen Verschiebungen auf die 
Grundeinstellung zurück.

Tasturbefehl:
Vorzeichen Grundeinstellung
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > Enharmonische Verschiebung: #

Die selektierten Noten werden als enharmonische Verschiebungen mit einem # versehen notiert.

Tasturbefehl:
Enharmonische Verschiebung: #
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > Enharmonische Verschiebung: b

Die selektierten Noten werden als enharmonische Verschiebungen mit einem 'b' versehen notiert.

Tasturbefehl:
Enharmonische Verschiebung:    b
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > # -> b

In den selektierten Noten werden alle 'b' als enharmonische Verschiebungen mit einem '#' versehen 
notiert.

Tasturbefehl:
Kreuze in B's umwandeln
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > b -> #

In den selektierten Noten werden alle 'b' als enharmonische Verschiebungen mit einem '#' versehen 
notiert.

Tasturbefehl:
B's in Kreuze umwandeln
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > Vorzeichen erzwingen

Die selektierten Noten werden mit einem Auflösungs-Zeichen notiert.

Tasturbefehl:
Vorzeichen erzwingen
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > Vorzeichen ausblenden

Die Vorzeichen der selektierten Noten werden unterdrückt (versteckt).

Tasturbefehl:
Vorzeichen ausblenden
(Notenfenster)



Noten-Editor > Attribute > Vorzeichen > Vorzeichen klammern

Die Vorzeichen der selektierten Noten werden in Klammern als Erinnerung angegeben.

Tasturbefehl:
Vorzeichen klammern
(Notenfenster)



Noten-Editor > Attribute > Notenhals > Automatisch

Setzt die Einstellungen der selektierten Noten bezüglich der Richtung des Notenhalses    auf die 
Grundeinstellung zurück.

Tasturbefehl:
Notenhals automatisch
(Notenfenster)



Noten-Editor > Attribute > Notenhals > Aufwärts

Setzt die Richtung des Notenhalses der selektierten Noten nach oben.

Tasturbefehl:
Notenhals aufwärts
(Notenfenster)



Noten-Editor > Attribute > Notenhals > Abwärts

Die Notenhälse der angewählten Noten werden nach unten dargestellt.

Tasturbefehl:
Notenhals abwärts
(Notenfenster)



Noten-Editor > Attribute > Notenhals > Ausblenden

Versteckt die Notenhälse der angewählten Noten.

Tasturbefehl:
Hals ausblenden
(Notenfenster)



Noten-Editor > Attribute > Balken > Automatisch

Setzt die Einstellungen der selektierten Noten bezüglich der Balken-Gruppierung auf Logic's Standard-
Werte zurück.

Tasturbefehl:
Balken automatisch
(Notenfenster)



Noten-Editor > Attribute > Balken > Auswahl verbinden

Die selektierten Noten werden soweit wie möglich mit Balken gruppiert.

Tasturbefehl:
Balken erzwingen
(Notenfenster)



Noten-Editor > Attribute > Balken > Auswahl trennen

Die Balken der selektierten Noten werden aufgehoben.

Tasturbefehl:
Balken unterdrücken
(Notenfenster)



Noten-Editor > Attribute > Bindebogen > Automatisch

Setzt die Einstellungen der selektierten Noten bezüglich der Haltebogen auf Logic's Standard-Werte 
zurück.

Tasturbefehl:
Haltebogen automatisch
(Notenfenster)



Noten-Editor > Attribute > Bindebogen > Oben

Setzt die Richtung des Haltebogens der selektierten Noten nach oben.

Tasturbefehl:
Haltebogen aufwärts
(Notenfenster)



Noten-Editor > Attribute > Bindebogen > Unten

Setzt die Richtung des Haltebogens der selektierten Noten nach unten.

Tasturbefehl:
Haltebogen nach unten
(Notenfenster)



Noten-Editor > Attribute > Synkope > Automatisch

In der aktuellen Auswahl werden die punktierten Noten gemäß der Vorgabe von Logic notiert.

Tasturbefehl:
Synkope automatisch
(Notenfenster)



Noten-Editor > Attribute > Synkope > Erzwingen

In der aktuellen Auswahl werden die punktierten Noten als Synkopen notiert.

Tasturbefehl:
Synkope erzwingen
(Notenfenster)



Noten-Editor > Attribute > Synkope > Verhindern

In der aktuellen Auswahl werden die Synkopen unterdrückt und als punktierte Noten notiert.

Tasturbefehl:
Synkope unterdrücken
(Notenfenster)



Noten-Editor > Attribute > Interpretation > Automatisch

Für die selektierten Noten erfolgt die Interpretation der Noten gemäß der Vorgabe von Logic.

Tasturbefehl:
Interpretation automatisch
(Notenfenster)



Noten-Editor > Attribute > Interpretation > Erzwingen

Für die selektierten Noten wird die Interpretation erzwungen.

Tasturbefehl:
Interpretation erzwingen
(Notenfenster)



Noten-Editor > Attribute > Interpretation > Verhindern

Für die selektierten Noten wird die Interpretation unterdrückt.

Tasturbefehl:
Interpretation unterdrücken
(Notenfenster)



Noten-Editor > Attribute > Unabhängig > Vorschlag

Die selektierten Noten werden als unabhängige Vorschläge notiert. 

Tasturbefehl:
Vorschlagsnote
(Notenfenster)



Noten-Editor > Attribute > Unabhängig > Unabhängig

Die selektierten Noten werden unabhängig von der automatischen Pausendarstellung notiert. 

Tasturbefehl:
Unabhängig
(Notenfenster)



Noten-Editor > Attribute > Unabhängig > Nicht unabhängig

Unabhängige Noten in den selektierten Noten werden wieder abhängig von der automatischen 
Pausendarstellung notiert. 

Tasturbefehl:
Nicht unabhängig
(Notenfenster)



Noten-Editor > Attribute > Alle Attribute zurücksetzen

Löscht alle manuell gesetzten Attribute der selektierten Noten.

Tasturbefehl:
Notenattribute zurücksetzen
(Notenfenster)



Noten-Editor > Text > Textformate...

Öffnet ein Fenster zur Einstellung der verschiedenen Text-Stile, welche von Logic zur Notendarstellung 
verwendet werden.



Noten-Editor > Text > Notations-Textfont...

Wählen Sie hier die Schrift-Einstellungen für die Notation.



Noten-Editor > Ansicht > Seitenansicht

Die aktuelle Notation wird in der Seitenansicht dargestellt.

Tasturbefehl:
Seitendarstellung
(Notenfenster)



Noten-Editor > Ansicht > Druckansicht

Nur bei eingeschalteter "Seitenansicht" zugänglich. Zeigt die erweiterte Seitenansichtinklusive 
Seitenränder, Titelbereiche usw.



Noten-Editor > Ansicht > Ordnerinhalt darstellen

Die Sequenzen der in der aktuellen Auswahl enthaltenen Ordner werden als eigenständige Sequenzen 
dargestellt.

Tasturbefehl:
Ordnerinhalt darstellen
(Notenfenster)



Noten-Editor > Ansicht > Polyphonie in Zeilen trennen

Die Stimmen der polyphonen Notation werden jeweils in einem eigenen Notensystem dargestellt.

Tasturbefehl:
Polyphonie in Zeilen trennen
(Notenfenster)



Noten-Editor > Ansicht > Scrolling bei Wiedergabe

Während der Wiedergabe bewegt sich der Fensterinhalt. Ist diese Funktion ausgeschaltet, so bewegt 
sich nur die Songposition-Line.



Noten-Editor > Ansicht > Partbox > Alle Gruppen zeigen

Wahlweise werden alle Gruppen der Notationssymbole angezeigt.



Noten-Editor > Ansicht > Partbox > Gruppenreihenfolge fixieren

Wahlweise werden alle Gruppen der Notationssymbole an fester Position dargestellt.



Noten-Editor > Ansicht > Werkzeuge

Blendet die Werkzeugpalette im aktuellen Fenster ein oder aus.



Noten-Editor > Ansicht > SMPTE-Zeitachse

Die Angaben bezüglich Zeit im Lineal und in den Positionsangaben werden als SMPTE-Einheiten 
dargestellt.

Tasturbefehl:
Zeitachse in SMPTE
(Arrangier- und Editierfenster)



Noten-Editor > Ansicht > Parameter

Blendet die Paramater im aktuellen Fenster ein oder aus.

Tasturbefehl:
Zeige/verstecke Parameter
(Verschiedene Fenster)



Noten-Editor > Ansicht > Instrumentnamen

Die Namen der Instrumente werden gemäß den Einstellungen in "Ziffern & Namen" im aktuellen 
Notenfenster dargestellt.



Noten-Editor > Ansicht > Seitenlineale

Wahlweise werden die Lineale für die Seite eingeblendet.

Tasturbefehl:
Seitenlineale ein/aus
(Notenfenster)



Noten-Editor > Ansicht > Weißer Hintergrund

Schaltet die Darstellung des Hintergrundes auf weiß ein oder aus.

Tasturbefehl:
Hintergrund ändern
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > aus

Hyper Draw wird für die selektierten Sequenzen ausgeschaltet.

Tasturbefehl:
Hyper Draw: ausschalten
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > automatisch definieren

Hyper Draw wird automatisch auf den ersten Event der Sequenz eingestellt.

Tasturbefehl:
Hyper Draw: automatisch definieren
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > Kanal

Hier wird der MIDI Kanal für die Darstellung und Eingabe des Hyper Draw gewählt.



Noten-Editor > Ansicht > Hyper Draw > Lautstärke

Die selektierten Sequenzen werden mit Hyper Draw für Lautstärke (Controller 07) dargestellt.

Tasturbefehl:
Hyper Draw: Lautstärke
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > Panorama

Die selektierten Sequenzen werden mit Hyper Draw für Panorama (Controller 10) dargestellt.

Tasturbefehl:
Hyper Draw: Panorama
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > Balance

Die selektierten Sequenzen werden mit Hyper Draw für Balance (Controller 08) dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Modulation

Die selektierten Sequenzen werden mit Hyper Draw für Modulation (Controller 01) dargestellt.

Tasturbefehl:
Hyper Draw: Modulation
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > Blaswandler

Die selektierten Sequenzen werden mit Hyper Draw für Blaswandler (Controller 02) dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Fußpedal

Die selektierten Sequenzen werden mit Hyper Draw für Fußpedal (Controller 04) dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Port.-Zeit

Die selektierten Sequenzen werden mit Hyper Draw für die Potamento-Zeit (Controller 05) dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Ausdruck

Die selektierten Sequenzen werden mit Hyper Draw für Ausdruck (Controller 11) dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Andere...

Öffnet ein Dialog zur Manuellen Eingabe einer Controller-Nummer zur Darstellung als Hyper Draw.

Tasturbefehl:
Hyper Draw: Andere...
(Arrangierfenster)



Noten-Editor > Ansicht > Hyper Draw > Druck (Channel Pressure)

Die selektierten Sequenzen werden mit Hyper Draw für Druck (Channel Pressure, auch Aftertouch 
genannt) dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Tonhöhenbeugerad

Die selektierten Sequenzen werden mit Hyper Draw für Tonhöhenbeugerad dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Programmwechselbefehl

Die selektierten Sequenzen werden mit Hyper Draw für Programmwechselbefehle dargestellt.



Noten-Editor > Ansicht > Hyper Draw > Anschlagstärke

Die selektierten Sequenzen werden mit Hyper Draw für Anschlagstärke dargestellt.



Noten-Editor > Optionen > Diatonisches Einfügen

Bei eingeschalteter Option ist nur die Eingabe von Tonhöhen, die zu der aktuellen Tonart gehören, 
möglich.



Noten-Editor > Optionen > Voreinstellungen für Notation...

Öffnet einen Dialog zu den globalen Einstellungen der Notation.

Tasturbefehl:
Notations-Voreinstellungen
(Notenfenster)



Noten-Editor > Optionen > Einstellungen importieren...

Öffnet einen Dialog in welchem Screen Sets, Transform Sets, Hyper Edit Sets, Score Instrument Sets, 
Notationsformate oder Notations-Einstellungen markiert werden können. Die markierten Einstellungen 
werden dann von dem mit "Import" gewählten Song auf den aktuellen Song übertragen.

Tasturbefehl:
Einstellungen importieren...
(Globale Kommandos)



Hyper-Editor > Über den Hyper-Editor

Sämtliche Befehle unter «Hyper-Editor» sind Befehle des lokalen Menüs dieses Fensters und sind daher 
nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Hyper-Editor > Hyper > Hyper Set erzeugen

Erzeugt ein neues Hyper Set.



Hyper-Editor > Hyper > GM Drum Set erzeugen

Erzeugt ein neues Drumset initialisiert nach General MIDI.



Hyper-Editor > Hyper > Hyper Set löschen

Löscht das aktuelle Hyper Set.



Hyper-Editor > Hyper > Event-Definition erzeugen

Erzeugt eine neue Definition eines Events ("Spur") im aktuellen Hyper Set.

Tasturbefehl:
Create Event Definition
(Hyper Edit)



Hyper-Editor > Hyper > Event-Definition löschen

Löscht die selektierte Definition eines Events ("Spur") im aktuellen Hyper Set.

Tasturbefehl:
Delete Event Definition
(Hyper Edit)



Hyper-Editor > Hyper > Mehrere Event-Definitionen erzeugen...

Öffnet einen Dialog zur Erzeugung mehrerer neuer Definitionen von Events ("Spuren") im aktuellen Hyper 
Set.

Tasturbefehl:
Multi Create Event Definition...
(Hyper Edit)



Hyper-Editor > Hyper > Event-Definition konvertieren...

Öffnet einen Dialog zur Änderung mehrerer Definitionen von Events ("Spuren") im aktuellen Hyper Set.

Tasturbefehl:
Convert Event Definition...
(Hyper Edit)



Hyper-Editor > Hyper > Event-Definition kopieren

Kopiert die selektierte Definition eines Events ("Spur") im aktuellen Hyper Set.

Tasturbefehl:
Copy Event Definition
(Hyper Edit)



Hyper-Editor > Hyper > Event-Definition einfügen

Fügt eine kopierte Definition eines Events ("Spur") im aktuellen Hyper Set ein.

Tasturbefehl:
Paste Event Definition
(Hyper Edit)



Hyper-Editor > Hyper > Alle Event-Definitionen auswählen

Selektiert alle Definitionen von Events ("Spuren") im aktuellen Hyper Set.

Tasturbefehl:
Select All Event Definitions
(Hyper Edit)



Hyper-Editor > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Hyper-Editor > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Hyper-Editor > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Hyper-Editor > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Hyper-Editor > Bearbeiten > Einfügen an der Originalposition

Objekte aus der Zwischenablage werden zu deren ursprünglichen Zeitpunkt eingesetzt.

Tasturbefehl:
An originaler Position einfügen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Einfügen mit Ersetzen

Objekte aus der Zwischenablage werden eingefügt und ersetzten dabei die selektierten Objekte.

Tasturbefehl:
Einfügen durch Ersetzen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Hyper-Editor > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Hyper-Editor > Bearbeiten > Alle folgenden Objekte auswählen

Alle folgenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Alle folgenden Objekte auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Innerhalb Locatorpunkten auswählen

Alle Objekte im aktuellen Fenster in der Zeit zwischen den Locatorpunkten werden selektiert.

Tasturbefehl:
Alles auswählen innerhalb Locatorpunkten
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Auswahl zurücknehmen außerhalb der Locatorpunkte

Alle Objekte im aktuellen Fenster ausserhalb der Zeit zwischen den Locatorpunkten werden deselektiert.

Tasturbefehl:
Ausserhalb der Lokatorpunkte die Auswahl zurücknehmen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Auswahl umkehren

Die aktuelle Auswahl des obersten Fensters wird umgekehrt. Alle nicht selektierten Objekte werden 
selektiert und umgekehrt.

Tasturbefehl:
Auswahl umkehren
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Leere Objekte auswählen

Alle leeren Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Leere Objekte auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Überlappte Objekte auswählen

Alle überlappenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Überlappte Objekte auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Stummgeschaltete (Mute) Objekte auswählen

Alle stummgeschalteten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
stummgeschaltete (Mute) Objekte auswählen
(Arrangierfenster)



Hyper-Editor > Bearbeiten > Gleichfarbige Objekte auswählen

Alle zur aktuellen Auswahl identisch eingefärbten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
gleichfarbige Objekte auswählen
(Arrangierfenster)



Hyper-Editor > Bearbeiten > Ähnliche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden selektiert. So können 
z.B. alle Noten 'A' selektiert werden, unabhängig von deren Oktavlage.

Tasturbefehl:
Ähnliche Objekte auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Gleiche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die der aktuellen Auswahl entsprechen, werden selektiert. So können 
z.B. alle Controller 10 vom Wert 80 selektiert werden.

Tasturbefehl:
Gleiche Objekte auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Objekte mit gleichem MIDI-Kanal auswählen

Alle Objekte im aktuellen Fenster,    deren MIDI Kanal der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleichem MIDI-Kanal auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Bearbeiten > Objekte mit gleicher Position im Takt auswählen

Alle Objekte im aktuellen Fenster,    deren Positionen im Takt der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleicher Position im Takt auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Locatorpunkte den Objekten anpassen

Setzt die Position der Locator auf den Anfang und das Ende der gegenwärtig selektierten Objekte.

Tasturbefehl:
Locatorpunkte setzen entsprechend Objekte
(Globale Kommandos)



Hyper-Editor > Funktionen > Erneut quantisieren

Die selektierten Objekt im aktuellen Fenster werden erneut quantisiert. 

Tasturbefehl:
øErneut quantisieren
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Dequantisieren

Hebt die Quantisierung der selektierten Objekte im aktuellen Fenster auf. 

Tasturbefehl:
Quantisierung zurücknehmen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > MIDI-Events löschen > Duplikate

Doppelte Events werden gelöscht.

Tasturbefehl:
Doppelte Events löschen
(Arrangierfenster)



Hyper-Editor > Funktionen > MIDI-Events löschen > Zwischen den Locatorpunkten

Alle MIDI Events zwischen den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Innerhalb der Lokatorpunkte löschen
(Arrangierfenster)



Hyper-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Locatorpunkte

Alle MIDI Events ausserhalb den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Ausserhalb der Lokatorpunkte löschen
(Arrangierfenster)



Hyper-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Objektgrenzen

Alle MIDI Events ausserhalb von Start und Ende der Sequenz werden aus den selektierten Sequenzen 
gelöscht.

Tasturbefehl:
Ausserhalb der jeweiligen Objektgrenzen löschen
(Arrangierfenster)



Hyper-Editor > Funktionen > MIDI-Events löschen > Nichtausgewählte innerhalb der Auswahl

Sämtliche nicht selektierten Objekte, welche sich zwischen selektierten Objekten befinden, werden 
gelöscht.

Tasturbefehl:
Innerhalb der Auswahl nicht ausgewähltes löschen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/alle)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/Auswahl)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Notenüberlappungskorrektur nur für gleiche Noten

Das Überlappen der selektierten Noten mit identischen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:

(Arrange and Various Sequence Editors)



Hyper-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/alle)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/Auswahl)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Oberste Linie auswählen

Selektiert die höchste Stimme im aktuellen Fenster. Jeweils die höchste Note eines Akkordes wird 
selektiert.

Tasturbefehl:
Oberste Stimmführung auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Unterste Linie auswählen

Selektiert die tiefste Stimme im aktuellen Fenster. Jeweils die tiefste Note eines Akkordes wird selektiert.

Tasturbefehl:
Unterste Stimmführung auswählen
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Jeder Linie einen MIDI-Kanal zuordnen

In der aktuellen Auswahl werden den Noten eines Akkordes MIDI-Kanäle zugeordnet. Dabei erhält die 
höchste Note den MIDI Kanal 1, die nächst tiefere den Kanal 1 usw.

Tasturbefehl:
Stimmführung zu MIDI-Kanäle
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Noten > Haltepedal in Notenlänge wandeln

In der aktuellen Auswahl wird die Länge der Noten jeweils der Dauer des Sustains angepaßt. Die Sustain 
Befehle sind danach nicht mehr nötig und werden gelöscht.

Tasturbefehl:
Nachhalte-Pedal zu Notenlänge konvertieren
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > MIDI-Events kopieren...

Ein Dialog zum Kopieren von MIDI Events wird geöffnet.

Tasturbefehl:
MIDI-Events kopieren...
(Globale Kommandos)



Hyper-Editor > Funktionen > SMPTE-Position entriegeln

Die selektierten Objekte werden von der festen Zuordnung einer SMPTE Zeit gelöst.

Tasturbefehl:
SMPTE-Position entriegeln
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > SMPTE-Position verriegeln

Die selektierten Objekte werden fest der SMPTE-Zeit ihrer gegenwärtigen Position zugeordnet. Danach 
sind sie unabhängig vom Taktraster und somit auch vom Tempo.

Tasturbefehl:
SMPTE-Position verriegeln
(Arrangier- und Editierfenster)



Hyper-Editor > Funktionen > Transformieren

Ruft die verschiedenen Presets des Transform-Fensters auf. Im Transform definierte Presets erscheinen 
automatisch in diesem Menu.



Hyper-Editor > Ansicht > Scroll in Play

Während der Wiedergabe bewegt sich der Fensterinhalt. Ist diese Funktion ausgeschaltet, so bewegt 
sich nur die Songposition-Line.



Hyper-Editor > Ansicht > SMPTE-Lineal

Die Angaben bezüglich Zeit im Lineal und in den Positionsangaben werden als SMPTE-Einheiten 
dargestellt.



Hyper-Editor > Ansicht > Laufwerktasten

Blendet die Transport-Funktionen im aktuellen Fenster ein oder aus.



Hyper-Editor > Ansicht > Parameter

Blendet die Paramater im aktuellen Fenster ein oder aus.

Tasturbefehl:
Zeige/verstecke Parameter
(Verschiedene Fenster)



Hyper-Editor > Ansicht > Auswahl darstellen

Der Inhalt im aktuellen Fenster verschoben, damit die aktuelle Auswahl sichtbar wird.

Tasturbefehl:
Auswahl im Fenster darstellen
(Arrangier- und Editierfenster)



Hyper-Editor > Ansicht > Mini-Event-Anzeige...

Öffnet ein kleines Floating Window mit den Daten des selektierten Events.

Tasturbefehl:
Event-Editor immer oben öffnen...
(Globale Kommandos)



Matrix-Editor > Über den Matrix-Editor

Sämtliche Befehle unter «Matrix-Editor» sind Befehle des lokalen Menüs dieses Fensters und sind daher 
nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Matrix-Editor > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Matrix-Editor > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Matrix-Editor > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Matrix-Editor > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Matrix-Editor > Bearbeiten > Einfügen an der Originalposition

Objekte aus der Zwischenablage werden zu deren ursprünglichen Zeitpunkt eingesetzt.

Tasturbefehl:
An originaler Position einfügen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Einfügen mit Ersetzen

Objekte aus der Zwischenablage werden eingefügt und ersetzten dabei die selektierten Objekte.

Tasturbefehl:
Einfügen durch Ersetzen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Matrix-Editor > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Matrix-Editor > Bearbeiten > Alle folgenden Objekte auswählen

Alle folgenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Alle folgenden Objekte auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Innerhalb Locatorpunkten auswählen

Alle Objekte im aktuellen Fenster in der Zeit zwischen den Locatorpunkten werden selektiert.

Tasturbefehl:
Alles auswählen innerhalb Locatorpunkten
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Auswahl zurücknehmen außerhalb der Locatorpunkte

Alle Objekte im aktuellen Fenster ausserhalb der Zeit zwischen den Locatorpunkten werden deselektiert.

Tasturbefehl:
Ausserhalb der Lokatorpunkte die Auswahl zurücknehmen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Auswahl umkehren

Die aktuelle Auswahl des obersten Fensters wird umgekehrt. Alle nicht selektierten Objekte werden 
selektiert und umgekehrt.

Tasturbefehl:
Auswahl umkehren
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Leere Objekte auswählen

Alle leeren Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Leere Objekte auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Überlappte Objekte auswählen

Alle überlappenden Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
Überlappte Objekte auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Stummgeschaltete (Mute) Objekte auswählen

Alle stummgeschalteten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
stummgeschaltete (Mute) Objekte auswählen
(Arrangierfenster)



Matrix-Editor > Bearbeiten > Gleichfarbige Objekte auswählen

Alle zur aktuellen Auswahl identisch eingefärbten Objekte im aktuellen Fenster werden selektiert.

Tasturbefehl:
gleichfarbige Objekte auswählen
(Arrangierfenster)



Matrix-Editor > Bearbeiten > Ähnliche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden selektiert. So können 
z.B. alle Noten 'A' selektiert werden, unabhängig von deren Oktavlage.

Tasturbefehl:
Ähnliche Objekte auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Gleiche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die der aktuellen Auswahl entsprechen, werden selektiert. So können 
z.B. alle Controller 10 vom Wert 80 selektiert werden.

Tasturbefehl:
Gleiche Objekte auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Objekte mit gleichem MIDI-Kanal auswählen

Alle Objekte im aktuellen Fenster,    deren MIDI Kanal der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleichem MIDI-Kanal auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Bearbeiten > Objekte mit gleicher Position im Takt auswählen

Alle Objekte im aktuellen Fenster,    deren Positionen im Takt der aktuellen Auswahl entsprechen, werden 
selektiert.

Tasturbefehl:
Objekte mit gleicher Position im Takt auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Locatorpunkte den Objekten anpassen

Setzt die Position der Locator auf den Anfang und das Ende der gegenwärtig selektierten Objekte.

Tasturbefehl:
Locatorpunkte setzen entsprechend Objekte
(Globale Kommandos)



Matrix-Editor > Funktionen > Erneut quantisieren

Die selektierten Objekt im aktuellen Fenster werden erneut quantisiert. 

Tasturbefehl:
øErneut quantisieren
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Dequantisieren

Hebt die Quantisierung der selektierten Objekte im aktuellen Fenster auf. 

Tasturbefehl:
Quantisierung zurücknehmen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > MIDI-Events löschen > Duplikate

Doppelte Events werden gelöscht.

Tasturbefehl:
Doppelte Events löschen
(Arrangierfenster)



Matrix-Editor > Funktionen > MIDI-Events löschen > Zwischen den Locatorpunkten

Alle MIDI Events zwischen den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Innerhalb der Lokatorpunkte löschen
(Arrangierfenster)



Matrix-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Locatorpunkte

Alle MIDI Events ausserhalb den Locators werden aus den selektierten Sequenzen gelöscht.

Tasturbefehl:
Ausserhalb der Lokatorpunkte löschen
(Arrangierfenster)



Matrix-Editor > Funktionen > MIDI-Events löschen > Ausserhalb der Objektgrenzen

Alle MIDI Events ausserhalb von Start und Ende der Sequenz werden aus den selektierten Sequenzen 
gelöscht.

Tasturbefehl:
Ausserhalb der jeweiligen Objektgrenzen löschen
(Arrangierfenster)



Matrix-Editor > Funktionen > MIDI-Events löschen > Nichtausgewählte innerhalb der Auswahl

Sämtliche nicht selektierten Objekte, welche sich zwischen selektierten Objekten befinden, werden 
gelöscht.

Tasturbefehl:
Innerhalb der Auswahl nicht ausgewähltes löschen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/alle)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Notenüberlappungskorrektur (Auswahl/Auswahl)

Das Überlappen der selektierten Noten mit anderen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:
Korrektur von Notenüberlappungen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Notenüberlappungskorrektur nur für gleiche Noten

Das Überlappen der selektierten Noten mit identischen Noten im aktuellen Fenster wird korrigiert. 

Tasturbefehl:

(Arrange and Various Sequence Editors)



Matrix-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/alle)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Legato erzwingen (Auswahl/Auswahl)

Die Längen der selektierten Noten im aktuellen Fenster werden jeweils bis zum Anfang der nächsten 
Note verlängert und entsprechen dann einer Legato-Spielweise. 

Tasturbefehl:
Legato von Noten erzwingen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Oberste Linie auswählen

Selektiert die höchste Stimme im aktuellen Fenster. Jeweils die höchste Note eines Akkordes wird 
selektiert.

Tasturbefehl:
Oberste Stimmführung auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Unterste Linie auswählen

Selektiert die tiefste Stimme im aktuellen Fenster. Jeweils die tiefste Note eines Akkordes wird selektiert.

Tasturbefehl:
Unterste Stimmführung auswählen
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Jeder Linie einen MIDI-Kanal zuordnen

In der aktuellen Auswahl werden den Noten eines Akkordes MIDI-Kanäle zugeordnet. Dabei erhält die 
höchste Note den MIDI Kanal 1, die nächst tiefere den Kanal 1 usw.

Tasturbefehl:
Stimmführung zu MIDI-Kanäle
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Noten > Haltepedal in Notenlänge wandeln

In der aktuellen Auswahl wird die Länge der Noten jeweils der Dauer des Sustains angepaßt. Die Sustain 
Befehle sind danach nicht mehr nötig und werden gelöscht.

Tasturbefehl:
Nachhalte-Pedal zu Notenlänge konvertieren
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > MIDI-Events kopieren...

Ein Dialog zum Kopieren von MIDI Events wird geöffnet.

Tasturbefehl:
MIDI-Events kopieren...
(Globale Kommandos)



Matrix-Editor > Funktionen > SMPTE-Position entriegeln

Die selektierten Objekte werden von der festen Zuordnung einer SMPTE Zeit gelöst.

Tasturbefehl:
SMPTE-Position entriegeln
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > SMPTE-Position verriegeln

Die selektierten Objekte werden fest der SMPTE-Zeit ihrer gegenwärtigen Position zugeordnet. Danach 
sind sie unabhängig vom Taktraster und somit auch vom Tempo.

Tasturbefehl:
SMPTE-Position verriegeln
(Arrangier- und Editierfenster)



Matrix-Editor > Funktionen > Transformieren

Ruft die verschiedenen Presets des Transform-Fensters auf. Im Transform definierte Presets erscheinen 
automatisch in diesem Menu.



Matrix-Editor > Ansicht > Scrolling bei Wiedergabe

Während der Wiedergabe bewegt sich der Fensterinhalt. Ist diese Funktion ausgeschaltet, so bewegt 
sich nur die Songposition-Line.



Matrix-Editor > Ansicht > SMPTE-Lineal

Die Angaben bezüglich Zeit im Lineal und in den Positionsangaben werden als SMPTE-Einheiten 
dargestellt.



Matrix-Editor > Ansicht > Parameter

Blendet die Paramater im aktuellen Fenster ein oder aus.

Tasturbefehl:
Zeige/verstecke Parameter
(Verschiedene Fenster)



Matrix-Editor > Ansicht > Weißer Hintergrund

Schaltet die Darstellung des Hintergrundes auf weiß ein oder aus.

Tasturbefehl:
Hintergrund ändern
(Arrangierfenster)



Matrix-Editor > Ansicht > Sequenzfarben

Werden im Matrix-Editor mehrere Seqeunzen dargestellt, so können die Noten der einzelnen Sequenzen 
wahlweise in der Farbe der jeweiligen Sequenz dargestellt werden.



Matrix-Editor > Ansicht > Auswahl darstellen

Der Inhalt im aktuellen Fenster verschoben, damit die aktuelle Auswahl sichtbar wird.

Tasturbefehl:
Auswahl im Fenster darstellen
(Arrangier- und Editierfenster)



Matrix-Editor > Ansicht > Mini-Event-Anzeige...

Öffnet ein kleines Floating Window mit den Daten des selektierten Events.

Tasturbefehl:
Event-Editor immer oben öffnen...
(Globale Kommandos)



Matrix-Editor > Ansicht > Hyper Draw > aus

Hyper Draw wird für die selektierten Sequenzen ausgeschaltet.

Tasturbefehl:
Hyper Draw: ausschalten
(Arrangierfenster)



Matrix-Editor > Ansicht > Hyper Draw > automatisch definieren

Hyper Draw wird automatisch auf den ersten Event der Sequenz eingestellt.

Tasturbefehl:
Hyper Draw: automatisch definieren
(Arrangierfenster)



Matrix-Editor > Ansicht > Hyper Draw > Kanal

Hier wird der MIDI Kanal für die Darstellung und Eingabe des Hyper Draw gewählt.



Matrix-Editor > Ansicht > Hyper Draw > Lautstärke

Die selektierten Sequenzen werden mit Hyper Draw für Lautstärke (Controller 07) dargestellt.

Tasturbefehl:
Hyper Draw: Lautstärke
(Arrangierfenster)



Matrix-Editor > Ansicht > Hyper Draw > Panorama

Die selektierten Sequenzen werden mit Hyper Draw für Panorama (Controller 10) dargestellt.

Tasturbefehl:
Hyper Draw: Panorama
(Arrangierfenster)



Matrix-Editor > Ansicht > Hyper Draw > Balance

Die selektierten Sequenzen werden mit Hyper Draw für Balance (Controller 08) dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Modulation

Die selektierten Sequenzen werden mit Hyper Draw für Modulation (Controller 01) dargestellt.

Tasturbefehl:
Hyper Draw: Modulation
(Arrangierfenster)



Matrix-Editor > Ansicht > Hyper Draw > Blaswandler

Die selektierten Sequenzen werden mit Hyper Draw für Blaswandler (Controller 02) dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Fußpedal

Die selektierten Sequenzen werden mit Hyper Draw für Fußpedal (Controller 04) dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Port.-Zeit

Die selektierten Sequenzen werden mit Hyper Draw für die Potamento-Zeit (Controller 05) dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Ausdruck

Die selektierten Sequenzen werden mit Hyper Draw für Ausdruck (Controller 11) dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Andere...

Öffnet ein Dialog zur Manuellen Eingabe einer Controller-Nummer zur Darstellung als Hyper Draw.

Tasturbefehl:
Hyper Draw: Andere...
(Arrangierfenster)



Matrix-Editor > Ansicht > Hyper Draw > Druck (Channel Pressure)

Die selektierten Sequenzen werden mit Hyper Draw für Druck (Channel Pressure, auch Aftertouch 
genannt) dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Tonhöhenbeugerad

Die selektierten Sequenzen werden mit Hyper Draw für Tonhöhenbeugerad dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Programmwechselbefehl

Die selektierten Sequenzen werden mit Hyper Draw für Programmwechselbefehle dargestellt.



Matrix-Editor > Ansicht > Hyper Draw > Anschlagstärke

Die selektierten Sequenzen werden mit Hyper Draw für Anschlagstärke dargestellt.



Environment > Über das Environment

Sämtliche Befehle unter «Environment» sind Befehle des lokalen Menüs dieses Fensters und sind daher 
nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Environment > Neu > Instrument

Erzeugt ein neues Instrument in der aktuellen Layer.

Tasturbefehl:
Instrument erzeugen
(Environment-Fenster)



Environment > Neu > Multi Instrument

Erzeugt ein neues Multi Instrument in der aktuellen Layer.

Tasturbefehl:
Multi Instrument erzeugen
(Environment-Fenster)



Environment > Neu > Mapped Instrument

Erzeugt ein neues Mapped Instrument in der aktuellen Layer.

Tasturbefehl:
Mapped Instrument erzeugen
(Environment-Fenster)



Environment > Neu > Touch Tracks

Erzeugt ein neues Touch Tracksª Objekt in der aktuellen Layer.



Environment > Neu > Regler

Erzeugt einen neuen Fader. Im Menü können verschiedene grafische Varianten gewählt werden. Im 
Menü "Specials" stehen ausserdem vordefinierte Fader zur Verfügung, welche Logic-interne Funktionen 
auslösen. 

Tasturbefehl:
Fader/Knobs/... erzeugen
(Environment-Fenster)



Environment > Neu > Alias

Erzeugt ein neues Alias-Objekt in der aktuellen Layer. Als Ausgangslage dient dabei die aktuelle Auswahl.



Environment > Neu > Ornament

Erzeugt ein neues Ornament-Objekt in der aktuellen Layer.



Environment > Neu > GM Mischer

Erzeugt ein neues GM Mischer-Objekt in der aktuellen Layer.



Environment > Neu > Tastatur

Erzeugt ein neues Keyboard Objekt in der aktuellen Layer.

Tasturbefehl:
Keyboard erzeugen
(Environment-Fenster)



Environment > Neu > Monitor

Erzeugt ein neues Monitor Objekt in der aktuellen Layer.

Tasturbefehl:
Monitor erzeugen
(Environment-Fenster)



Environment > Neu > Makro

Erzeugt ein neues Makro-Objekt aus den momentan selektierten Objekten in der aktuellen Layer.



Environment > Neu > Arpeggiator

Erzeugt ein neues Arpeggiator Objekt in der aktuellen Layer.

Tasturbefehl:
Arpeggiator erzeugen
(Environment-Fenster)



Environment > Neu > Transformer

Erzeugt ein neues Transformer Objekt in der aktuellen Layer.

Tasturbefehl:
Transformer erzeugen
(Environment-Fenster)



Environment > Neu > Delay Line

Erzeugt ein neues Delay Line Objekt in der aktuellen Layer.

Tasturbefehl:
Delay Line erzeugen
(Environment-Fenster)



Environment > Neu > Stimmenbegrenzer

Erzeugt ein neues Stimmenbegrenzer-Objekt in der aktuellen Layer.

Tasturbefehl:
Voice Limiter erzeugen
(Environment-Fenster)



Environment > Neu > Kanaltrenner

Erzeugt ein neues Kanaltrenner-Objekt in der aktuellen Layer.

Tasturbefehl:
Channel Splitter erzeugen
(Environment-Fenster)



Environment > Neu > Akkordspeicher

Erzeugt ein neues Akkordspeicher-Objekt in der aktuellen Layer.

Tasturbefehl:
Chord Memorizer erzeugen
(Environment-Fenster)



Environment > Neu > Physikalischer Eingang

Erzeugt ein neues Objekt für den Physikalischen Eingang in der aktuellen Layer.



Environment > Neu > Sequenzereingang

Erzeugt ein neues Objekt für den Sequenzereingang in der aktuellen Layer.



Environment > Neu > MIDI-Metronom

Erzeugt ein neues Objekt für das MIDI-Metronom in der aktuellen Layer.



Environment > Neu > Intern > AutoLink

Erzeugt ein neues AutoLink-Objekt in der aktuellen Layer.



Environment > Neu > MIDI-Ausgang

Erzeugt ein neues MIDI-Ausgang-Objekt in der aktuellen Layer.

Tasturbefehl:
MIDI Out Port erzeugen
(Environment-Fenster)



Environment > Neu > Audio-Objekt

Erzeugt ein neues Audio-Objekt in der aktuellen Layer.

Tasturbefehl:
Audio Object erzeugen
(Environment-Fenster)



Environment > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Environment > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Environment > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Environment > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Environment > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Environment > Bearbeiten > Nur Kabel löschen

Nur die Kabel der aktuellen Auswahl werden gelöscht.

Tasturbefehl:
Nur ausgewählte Kabel löschen
(Environment-Fenster)



Environment > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Environment > Bearbeiten > Auswahl umkehren

Die aktuelle Auswahl des obersten Fensters wird umgekehrt. Alle nicht selektierten Objekte werden 
selektiert und umgekehrt.

Tasturbefehl:
Auswahl umkehren
(Environment-Fenster)



Environment > Bearbeiten > Benutzte Instrumente auswählen

Selektiert alle Objekte, die einer Spur im Arrangierfenster zugewiesen worden sind.

Tasturbefehl:
Benutzte Instrumente auswählen
(Environment-Fenster)



Environment > Bearbeiten > Nicht benutzte Instrumente auswählen

Selektiert alle Objekte, die keiner Spur im Arrangierfenster zugewiesen worden sind.

Tasturbefehl:
Unbenutzte Instrumente auswählen
(Environment-Fenster)



Environment > Bearbeiten > Kabelziel auswählen

Selektiert alle Objekte, zu denen eine Verbindung vom selektierten Objekt führt.

Tasturbefehl:
Kabelziel auswählen
(Environment-Fenster)



Environment > Bearbeiten > Kabelausgangspunkt auswählen

Selektiert alle Objekte, von denen eine Verbindung zum selektierten Objekt führt.

Tasturbefehl:
Kabelursprung auswählen
(Environment-Fenster)



Environment > Bearbeiten > Ähnliche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden selektiert. So können 
z.B. alle Noten 'A' selektiert werden, unabhängig von deren Oktavlage.



Environment > Bearbeiten > Gleiche Objekte auswählen

Alle Objekte im aktuellen Fenster,    die der aktuellen Auswahl entsprechen, werden selektiert. So können 
z.B. alle Controller 10 vom Wert 80 selektiert werden.



Environment > Ansicht > Kabel und Positionen schützen

Sowohl die Positionen der Objekte, als auch die Kabel werden geschützt.

Tasturbefehl:
Kabel und Positionen schützen
(Environment-Fenster)



Environment > Ansicht > Positionen einrasten

Die selektierten Objekte werden auf den nächstliegenden Raster verschoben.



Environment > Ansicht > Kabel

Wahlweise wird die Darstellung der Kabel aus- oder eingeblendet.

Tasturbefehl:
Kabel zeigen/verstecken
(Environment-Fenster)



Environment > Ansicht > Parameter

Blendet die Paramater im aktuellen Fenster ein oder aus.

Tasturbefehl:
Zeige/verstecke Parameter
(Verschiedene Fenster)



Environment > Ansicht > als Text

Die Darstellung im aktuellen Fenster erfolgt wahlweise in Textform.



Environment > Ansicht > Import-Optionen

Das Menü "Import Options" kann wahlweise aus- oder eingeblendet werden.



Environment > Ansicht > farbige Kabel

Wahlweise kann die Darstellung der Kabel in der Farbe des Objektes erfolgen,vom dem sie ausgehen.



Environment > Ansicht > Objektfarben...

Öffnet die Farbpalette zum Einfärben von Sequenzen, Instrumenten, Markierungen usw.

Tasturbefehl:
Objektfarben öffnen...
(Globale Kommandos)



Environment > Optionen > Mixer Automation > Mischen

Beim Aufzeichnen des Mixers werden die neuen Daten mit bereits vorhandenen Daten 
zusammengemischt.



Environment > Optionen > Mixer Automation > Ersetzen

Beim Aufzeichnen des Mixers ersetzten die neuen Daten bereits vorhandene Daten.



Environment > Optionen > Mixer Automation > Aktualisieren

Beim Aufzeichnen des Mixers ersetzten die neuen Daten bereits vorhandene Daten an der selben 
Position.



Environment > Optionen > Mixer Automation > Fade-Zeit...

Ermöglicht die Einstellung einer Übergangszeit, in der eine Überblendung bereits vorhandener Daten mit 
neuen Daten erfolgt.



Environment > Optionen > zum vorigen Layer gehen

Die Darstellung wechselt zur vorherigen Layer .

Tasturbefehl:
zum davor dargestellten Layer gehen
(Environment-Fenster)



Environment > Optionen > zum Layer des Objektes gehen

Von der 'All Objects' Layer wird auf Darstellung der Layer des aktuell selektierten Objektes umgeschaltet.

Tasturbefehl:
zum Layer des Objektes gehen
(Environment-Fenster)



Environment > Optionen > ausgewählte Regler zurücksetzen

Die selektierten Fader werden zurückgesetzt.



Environment > Optionen > alle Regler senden ohne Sysex

Die momentanen Einstellungen der Fader werden ausgegeben. Betroffen davon sind alle Fader des 
Environments außer solchen, die mit Sysex definiert worden sind.

Tasturbefehl:
Alle Regler-Werte senden außer Sysex
(Globale Kommandos)



Environment > Optionen > alle Regler senden

Die momentanen Einstellungen der Fader werden ausgegeben. Betroffen davon sind sämtliche Fader 
des Environments.

Tasturbefehl:
Send All Fader Values
(Environment-Fenster)



Environment > Optionen > alle ausgewählten Regler senden

Die aktuellen Einstellungen der momentan selektierten Fader werden ausgegeben. 

Tasturbefehl:
Ausgewählte Reglerwerte senden
(Environment-Fenster)



Environment > Optionen > Bankwechsel-Befehle definieren...

Öffnet ein Fenster, in welchem man pro Instrument individuelle Bankwechsel-Befehle eingeben kann, falls 
diese nicht der Norm entsprechen.



Environment > Optionen > Layer > Löschen

Löscht die aktuelle Layer inklusive aller darin enthaltenen Objekte.

Tasturbefehl:
Layer löschen
(Environment-Fenster)



Environment > Optionen > Layer > Einfügen

Erzeugt eine neue Environment Layer.

Tasturbefehl:
Layer einfügen
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Größe

Die Größe der Vorlage wird auf die selektierten Objekte übertragen.

Tasturbefehl:
Muster anwenden auf Größe
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Position

Die Position der Vorlage wird auf die selektierten Objekte übertragen.

Tasturbefehl:
Muster anwenden auf Position
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Position und Größe

Die Position und Größe der Vorlage wird auf die selektierten Objekte übertragen.

Tasturbefehl:
Muster anwenden auf Position und Größe
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Definition

Die Definition der Vorlage wird auf die selektierten Objekte übertragen.

Tasturbefehl:
Muster anwenden auf Definition
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Definition, Kanal inkrementieren

Die Definition der Vorlage wird auf die selektierten Objekte übertragen. Dabei wird der MIDI Kanal 
fortlaufend erhöht.

Tasturbefehl:
Muster anwenden auf Definition mit Kanalincrement
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Definition, Nummer inkrementieren

Die Definition der Vorlage wird auf die selektierten Objekte übertragen. Dabei wird die Nummer der 
Definition fortlaufend erhöht.

Tasturbefehl:
Muster anwenden auf Definition mit Nummerincrement
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Kabel

Die Kabel-Verbindungen der Vorlage werden auf die selektierten Objekte übertragen. 

Tasturbefehl:
Muster anwenden auf Kabelverbindungen
(Environment-Fenster)



Environment > Optionen > Muster anwenden auf > Muster definieren

Das selektierte Objekt wird als Vorlage aufgenommen.



Environment > Optionen > aufräumen > Objekte auf eine Höhe bringen

Die Positionen der selektierten Objekte werden aufgeräumt.

Tasturbefehl:
Objekte ausrichten
(Environment-Fenster)



Environment > Optionen > aufräumen > Positionen anhand eines Rasters

Die Positionen der selektierten Objekte werden auf den Raster positioniert..

Tasturbefehl:
Objekt-Positionen aufräumen
(Environment-Fenster)



Environment > Optionen > aufräumen > Größe zurücksetzen

Die Größe der selektierten Objekte wird auf die normale Größe dieses Objektes gesetzt.

Tasturbefehl:
Objekt-Größen zurücksetzen
(Environment-Fenster)



Environment > Optionen > seriell verkabeln

Die selektierten Objekte werden seriell verkabelt.

Tasturbefehl:
seriell verkabeln
(Environment-Fenster)



Environment > Optionen > Einstellungen importieren...

Öffnet einen Dialog in welchem Screen Sets, Transform Sets, Hyper Edit Sets, Score Instrument Sets, 
Notationsformate oder Notations-Einstellungen markiert werden können. Die markierten Einstellungen 
werden dann von dem mit "Import" gewählten Song auf den aktuellen Song übertragen.

Tasturbefehl:
Einstellungen importieren...
(Globale Kommandos)



Environment > Optionen > Environment importieren > Layer

Eine komplette Layer wird aus einem anderen Song importiert.



Environment > Optionen > Environment importieren > Zuordnen...

Ein Environment wird aus einem anderen Song importiert. Dabei erfolgt eine manuelle Zuordnung der 
bestehenden und zu importierenden Objekte.



Environment > Optionen > Environment importieren > Mischen

Ein komplettes Environment wird aus einem anderen Song importiert und dem aktuellen Song angefügt.



Environment > Optionen > Environment importieren > Aktualisieren

Ein Environment wird aus einem anderen Song importiert. Dabei werden die älteren Objekte durch die 
neuen ersetzt.



Environment > Optionen > Environment importieren > Ersetzen nach Port/MIDI-Kanal

Ein Environment wird aus einem anderen Song importiert. Objekte mit übereinstimmendem Ausgang und 
MIDI Kanal werden ersetzt.



Environment > Optionen > Environment importieren > Ersetzen nach Namen

Ein Environment wird aus einem anderen Song importiert. Objekte mit übereinstimmenden Namen 
werden ersetzt.



Environment > Optionen > Environment importieren > komplett ersetzen

Ein komplettes Environment wird aus einem anderen Song importiert und ersetzt jenes im aktuellen 
Song.



Environment > Importieren > Environment importieren entsprechend aktueller Zuordnung

Ein Environment wird aus einem anderen Song importiert. Dabei wird die aktuelle Zuordnung der 
bestehenden und zu importierenden Objekte verwendet.



Environment > Importieren > Zuordnen als 'bleibt'

Markiert die selektierten Objekte als "zu behaltenden Objekte".



Environment > Importieren > Zuordnen als 'löschen'

Markiert die selektierten Objekte als "zu löschende Objekte".



Environment > Importieren > Zuordnen wenn identisch

Markiert die selektierten Objekte als "zu ersetzten durch identische Objekte". Dabei werden Typ, Icon, 
Name, Port und MIDI Kanal verglichen.



Environment > Importieren > Zuordnen nach interner ID-Nummer

Objekte werden Objekten mit derselben internen Kennummer zugeordnet.



Environment > Importieren > Zuordnen nach Port/MIDI-Kanal

Markiert die selektierten Objekte als "zu ersetzten durch Objekte mit identischem Ausgang und MIDI 
Kanal". 



Environment > Importieren > Zuordnen nach Namen

Ordnet den Objekten Objekte mit dem ähnlichsten Namen zu.



Environment > Importieren > Zuordnen nach Icon und Namen

Ordnet den Objekten Objekte mit dem ähnlichsten Namen und identischem Icon zu.



Environment > Importieren > Layer-Namen kopieren

Überträgt die Namen der Layer auf den aktuellen Song.



Environment > Importieren > Ausgewählte Objekte des 2. Song kopieren

Alle Objekte des zweiten Environments werden kopiert, sofern sie keiner Zuordnung entsprechen.



Transportfenster > Über das Transportfenster

Sämtliche Befehle unter «Transportfenster» sind in lokalen Menüs im Transportfenster zu finden.



Transportfenster > Tempo und Synchronisation > Interner Sync-Modus

Aktiviert die interne Synchronisation. Logic ist dann Master.



Transportfenster > Tempo und Synchronisation > SMPTE-Sync-Modus (MTC)

Aktiviert SMPTE Synchronisation via MTC. Logic ist dann Slave zu MTC.



Transportfenster > Tempo und Synchronisation > MIDI-Clock-Sync-Modus

Aktiviert die Synchronisation zu MIDI Clock. Logic ist dann Slave zu MIDI Clock.



Transportfenster > Tempo und Synchronisation > Manueller Sync-Modus (Tempo Interpreter)

Aktiviert die manuelle Synchronisation. Das Tempo wird dann mit dem Tastaturkommando "Tap Tempo" 
gesteuert.



Transportfenster > Tempo und Synchronisation > Automatisch Sync-Modus umschalten

Bei aktivierter Funktion synchronisiert sich Logic automatisch auf    MIDI Clock oder MTC, sobald er diese 
empfängt



Transportfenster > Tempo und Synchronisation > MIDI Machine Control (MMC)

Schaltet die Ausgabe von MIDI Machine Control ein oder aus.



Transportfenster > Tempo und Synchronisation > Synchronisation...

Öffnet ein Fenster mit sämtlichen Parametern, welche für die Synchronisation von Bedeutung sind.



Transportfenster > Tempo und Synchronisation > Tempo Interpreter öffnen...

Öffnet ein Fenster in dem man die Paramater zur manuellen Kontrolle des Tempos einstellen kann.



Transportfenster > Tempo und Synchronisation > Tempo-Operationen öffnen...

Öffnet ein Fenster zur Berechnung von Änderungen im Tempo.



Transportfenster > Tempo und Synchronisation > Tempo als Graphik öffnen...

Öffnet ein Fenster zur graphischen Bearbeitung des Tempos.



Transportfenster > Tempo und Synchronisation > Tempo-Liste öffnen...

Öffnet eine Liste der eingetragenen Tempo-Änderungen, ähnlich dem Event-Editor.



Transportfenster > Ansicht > kleiner

Verkleinert das Transportfenster.



Transportfenster > Ansicht > größer

Vergrößert das Transportfenster.



Transportfenster > Ansicht > Größe

In diesem Menü kann die Größe des Transportfensters direkt gewählt werden



Transportfenster > Ansicht > Legende

Eine Legende wird auf der linken Seite des Track-Mixers eingeblendet.



Transportfenster > Ansicht > Positionsbalken

Wahlweise kann eine Positionsanzeige eingeblendet werden. Diese zeigt die aktuelle Position im 
Verhältnis zur Länge des Songs.



Transportfenster > Ansicht > Use SMPTE View Offset

In der Anzeige der SMPTE Zeit wird wahlweise der unter "SMPTE View Offset..." eingestellte SMPTE 
Zeit-Versatz berücksichtigt.



Transportfenster > Ansicht > SMPTE View Offset...

Öffnet einen Dialog zur Eingabe eines Versatzes der angezeigten SMPTE Zeit. 



Transportfenster > Ansicht > Giant SMPTE Display

Das aktuelle Transportfenster wird zu einer grossen SMPTE-Anzeige umfunktioniert.



Transportfenster > Ansicht > Giant Bar Display

Das aktuelle Transportfenster wird zu einer grossen Takt-Anzeige umfunktioniert.



Transportfenster > Ansicht > Control Switches Display

Der Bereich der Transport-Kontrolle wird für das aktuelle Transportfenster wahlweise aktiviert.



Transportfenster > Ansicht > Mode Switches Display

Der Bereich der Modi-Schaltflächen wird für das aktuelle Transportfenster wahlweise aktiviert.



Transportfenster > Ansicht > Position Display

Der Bereich der Positions-Anzeige wird für das aktuelle Transportfenster wahlweise aktiviert.



Transportfenster > Ansicht > Locator Display

Der Bereich der Locator-Anzeige wird für das aktuelle Transportfenster wahlweise aktiviert.



Transportfenster > Ansicht > Tempo/Signature Display

Der Bereich der Tempo/Takt-Anzeige wird für das aktuelle Transportfenster wahlweise aktiviert.



Transportfenster > Ansicht > MIDI Indicator Display

Der Bereich der MIDI Indikator-Anzeige wird für das aktuelle Transportfenster wahlweise aktiviert.



Transportfenster > Ansicht > All Elements Horizontal

Sämtliche Elemente werden im aktuellen Transportfenster horizontal nebeneinander dargestellt.



Transportfenster > Ansicht > All Elements Normal

Alle Elemente des aktuellen Transportfenster werden normal dargestellt.



Transportfenster > Aufnahme > Aufnahme

Eine Aufnahme wird gestartet. Aufgenommen wird auf der angewählten Spur an der aktuellen Position 
der Song Position Line. Je nach Einstellung der Song Settings erfolgt dabei ein Einzählen.

Tasturbefehl:
Aufnahme
(Globale Kommandos)



Transportfenster > Aufnahme > Aufnahme wiederholen

Die letzte Aufnahme wird wiederholt. Die letzte Aufnahme wird gelöscht und an der Position der letzten 
Aufnahme wird erneut aufgenommen.

Tasturbefehl:
øAufnahme wiederholen
(Globale Kommandos)



Transportfenster > Aufnahme > Aufnahme ein- bzw. ausschalten

Schaltet den Aufnahmemodus ein oder aus. So kann    z.B. während dem Abspielen in den 
Aufnahmemodus geschaltet werden. Es erfolgt dabei keinerlei Unterbruch.

Tasturbefehl:
*Aufnahme ein/ausschalten
(Globale Kommandos)



Transportfenster > Aufnahme > Aufnahme-Einstellungen...

Öffnet den Abschnitt Recording Options der Song Settings.

Tasturbefehl:
Aufnahmeoptionen...
(Globale Kommandos)



Transportfenster > Aufnahme > Punch on the fly

Ermöglicht jederzeit den sofortigen Einstieg in die Aufnahme.    Bei der Aufnahme von Audio bedarf es 
dazu besondere Vorkehrungen. Daher sollte diese Option, wenn nicht benötigt, ausgeschaltet werden.



Transportfenster > Aufnahme > Auto Input Monitoring

Wahlweise kann das Durchschleifen des Audiosignals bei der Aufnahme deaktiviert werden.

Tasturbefehl:
Auto-Eingangshörkontrolle ein-/ausschalten
(Globale Kommandos)



Transportfenster > Aufnahme > Audio-Aufnahmepfad setzen ...

Öffnet einen Dialog zur Einstellung des Pfades und weiteren Optionen bezüglich der Aufnahme von 
Audio.

Tasturbefehl:
Audio-Aufnahmepfad setzen ... 
(Globale Kommandos)



Transportfenster > Aufnahme > Mixer Automation: Merge

Beim Aufzeichnen des Mixers werden die neuen Daten mit bereits vorhandenen Daten 
zusammengemischt.



Transportfenster > Aufnahme > Mixer Automation: Replace

Beim Aufzeichnen des Mixers ersetzten die neuen Daten bereits vorhandene Daten.



Transportfenster > Aufnahme > Mixer Automation: Update

Beim Aufzeichnen des Mixers ersetzten die neuen Daten bereits vorhandene Daten an der selben 
Position.

Tasturbefehl:

(Global Commands)



Transportfenster > Aufnahme > Automation Soft Fade Time...

Ermöglicht die Einstellung einer Übergangszeit, in der eine Überblendung bereits vorhandener Daten mit 
neuen Daten erfolgt.



Audio > Über das Audio-Fenster

Sämtliche Befehle unter «Audio» sind Befehle des lokalen Menüs dieses Fensters und sind daher nur 
dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Audio > Audio-Datei > Audio-Datei anmelden

Öffnet eine Dateiauswahl. Damit kann eine bestehende Audio-Datei in den aktuellen Song aufgenommen 
werden.

Tasturbefehl:
Audio-Datei anmelden
(Audio-Fenster)



Audio > Audio-Datei > Region erzeugen

Dem selektierten Audio-File wird eine neue Region angefügt.

Tasturbefehl:
Region erzeugen
(Audio-Fenster)



Audio > Audio-Datei > Audio-Aufnahmepfad setzen ...

Öffnet einen Dialog zur Einstellung des Pfades und weiteren Optionen bezüglich der Aufnahme von 
Audio.



Audio > Audio-Datei > Datei(en) löschen

Die selektierten Dateien werden von der Festplatte gelöscht. Diese Funktion ist nicht wiederrufbar, also 
gut überlegen...

Tasturbefehl:
Datei(en) löschen
(Audio-Fenster)



Audio > Audio-Datei > Datei(en) optimieren

Optimiert die selektierten Audio Dateien. Diese werden so zusammengeschnitten, daß alle Teile, die im 
Arrangierfenster nicht verwendet werden, gelöscht werden.

Tasturbefehl:
Datei(en) optimieren
(Audio-Fenster)



Audio > Audio-Datei > Datei-Sicherheitskopie(n) erzeugen

Es werden Sicherheitskopien der selektierten Audio Dateien erstellt.

Tasturbefehl:
Datei-Sicherheitskopie(n) erzeugen
(Audio-Fenster)



Audio > Audio-Datei > Datei(en) kopieren/konvertieren

Die selektierten Dateien werden kopiert. Dabei kann das gewünschte Dateiformat gewählt werden.

Tasturbefehl:
Datei(en) kopieren/konvertieren
(Audio-Fenster)



Audio > Audio-Datei > Datei(en) verschieben

Die selektierten Dateien werden in ein neues Verzeichnis verschoben.

Tasturbefehl:
Datei(en) verschieben
(Audio-Fenster)



Audio > Audio-Datei > Fade-Datei(en) löschen

Die Dateien mit den Daten zur Überblendung werden von der Festplatte gelöscht. 



Audio > Audio-Datei > Region(en) sichern unter...

Die selektierten Regionen werden als neue Datei gespeichert.



Audio > Audio-Datei > Nach Wave-Stereo konvertieren

Aus den selektierten (Stereo-) Dateien werden neue Wave-Stereodateien erzeugt. Diese werden 
teilweise für die weitere Verarbeitung in anderen Programmen benötigt.



Audio > Audio-Datei > Datei-Information abgleichen

Die Informationen über die selektierten Audio-Dateien werden auf den neusten Stand gebracht.



Audio > Audio-Datei > Overview(s) neu berechnen

Fordert Logic auf, die Übersichts-Darstellung der Wellenformen der selektierten Audio Dateien neu zu 
berechnen.



Audio > Audio-Datei > Alle SSHDR-Dateien anmelden

Sämtlich im angeschlossenen SSHDR befindlichen Audio Dateien werden angefordert und in Audio 
Fenster aufgelistet.



Audio > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Audio > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Audio > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Audio > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Audio > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Audio > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Audio > Bearbeiten > Verwendete auswählen

Selektiert alle im Arrangierfenster verwendeten Regions und Dateien.

Tasturbefehl:
Verwendete auswählen
(Audio-Fenster)



Audio > Bearbeiten > Nicht verwendete auswählen

Selektiert alle im Arrangierfenster nicht verwendeten Regions und Dateien.

Tasturbefehl:
Nicht verwendete auswählen
(Audio-Fenster)



Audio > Bearbeiten > Info

Es erscheint ein Dialog mit Angaben bezüglich den verwendeten Audio-Files und Regions.



Audio > Bearbeiten > Null-Durchgänge suchen

Bei aktivierter Funktion werden beim Schneiden immer die nächstliegenden Nulldurchgänge als 
Schnittpunkte berücksichtigt. Diese können zwar von eigentlichen Schnittpunkt etwas abweichen, es 
entstehen dafür an den Schnittpunkten keine Knackser.



Audio > Bearbeiten > Selektierte Split-Stereo-Datei auftrennen

Die linke und rechte Spur der selektierten Stereo-Datei werden entkoppelt und lasssen sich fortan als 
zwei getrennte Mono-Dateien bearbeiten.



Audio > Bearbeiten > Alle aufgetrennten Split-Stereo-Dateien verknüpfen

Alle mittels "Deconnect selected stereo file" getrennten Stereo-Dateien werden wieder zu einer 
gemeinsamen Stereo-Datei zusammengefügt. Dies funktioniert jedoch nur dann, wenn beide Kanläle die 
selbe Anzahl Regions verwenden.



Audio > Ansicht > Dateien sortieren nach > nichts

Die Darstellung der Reihenfolge der Audio Dateien erfolgt nicht sortiert.



Audio > Ansicht > Dateien sortieren nach > Name

Die Darstellung der Reihenfolge der Audio Dateien erfolgt sortiert nach dem Namen der Dateien.



Audio > Ansicht > Dateien sortieren nach > Größe

Die Darstellung der Reihenfolge der Audio Dateien erfolgt sortiert nach der Größe der Dateien.



Audio > Ansicht > Dateien sortieren nach > Laufwerk

Die Darstellung der Reihenfolge der Audio Dateien erfolgt sortiert nach dem Laufwerk auf der sich die 
Dateien befinden.



Audio > Ansicht > Dateien sortieren nach > Bit-Tiefe

Die Darstellung der Reihenfolge der Audio Dateien erfolgt sortiert nach deren Auflösung.



Audio > Ansicht > Datei-Informationen anzeigen

Informationen über die Dateien werden angezeigt.



Audio > Ansicht > Alle Regionen zeigen

Alle Regions werden aufgelistet.

Tasturbefehl:
Alle Regionen zeigen
(Audio-Fenster)



Audio > Ansicht > Alle Regionen verbergen

Alle Regions werden ausgeblendet

Tasturbefehl:
Alle Regionen verbergen
(Audio-Fenster)



Audio > Ansicht > Regionen sortieren nach > Anfang

Die Darstellung der Reihenfolge der Regions erfolgt sortiert nach deren Startpunkt.



Audio > Ansicht > Regionen sortieren nach > Länge

Die Darstellung der Reihenfolge der Regions erfolgt sortiert nach deren Länge.



Audio > Ansicht > Regionen sortieren nach > Name

Die Darstellung der Reihenfolge der Regions erfolgt sortiert nach deren Namen.



Audio > Ansicht > Länge angeben in > gar nicht

Die Darstellung der Reihenfolge der Regions erfolgt nicht sortiert.



Audio > Ansicht > Länge angeben in > Min:Sek:Ms

Die Länge wird in Minuten, Sekunden und Milisekunden dargestellt.



Audio > Ansicht > Länge angeben in > Samples

Die Länge wird in Samples dargestellt.



Audio > Ansicht > Länge angeben in > SMPTE-Zeit

Die Länge SMPTE Zeiteinheiten dargestellt.



Audio > Ansicht > Länge angeben in > Takte/Schläge...

Die Länge wird in Takten und Schlägen dargestellt.



Audio > Ansicht > Objektfarben...

Öffnet die Farbpalette zum Einfärben von Sequenzen, Instrumenten, Markierungen usw.

Tasturbefehl:
Objektfarben öffnen...
(Globale Kommandos)



Audio > Optionen > Audio Mixer

Öffnet ein Environment Fenster mit den Audio Objekten.

Tasturbefehl:
Audio-Aufnahmefenster öffnen...
(Globale Kommandos)



Audio > Optionen > SSHDR Disk(s) defragmentieren

Fordert das SSHDR auf, die Disks zu defragmentieren.



Audio > Optionen > Audio-Konfiguration

Öffnet ein Fenster mit symbolischer Darstellung der Audio-Belegung.

Tasturbefehl:
Audio-Konfiguration
(Globale Kommandos)



Audio > Optionen > Sample Rate 44100

Stellt die Sample Rate auf 44100 Hz.



Audio > Optionen > Sample Rate 48000

Stellt die Sample Rate auf 48000 Hz. Wird nicht von jeder Hardware unterstützt.



Audio > Optionen > Sample Rate 88200

Stellt die Sample Rate auf 88200 Hz. Wird nicht von jeder Hardware unterstützt.



Audio > Optionen > Sample Rate 96000

Stellt die Sample Rate auf 96000 Hz. Wird nicht von jeder Hardware unterstützt.



Audio > Optionen > Strip Silence

Öffnet einen Dialog zur selektierten Audio-Datei. Diese kann darin automatisch in Regions zerlegt 
werden. Dabei werden Stellen mit wenig Pegel als "Stille" interpretiert und herausgeschnitten. Gewisse 
Vorgaben können eingestellt werden.

Tasturbefehl:
Strip Silence
(Audio-Fenster)



Sample-Editor > Über den Sample-Editor

Sämtliche Befehle unter «Sample-Editor» sind Befehle des lokalen Menüs dieses Fensters und sind 
daher nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Sample-Editor > Audio-Datei > Sicherungsdatei erzeugen

Erzeugt eine Sicherheitskopie der Datei, an der momentan gearbeitet wird..

Tasturbefehl:
Sicherungsdatei erzeugen
(Wellenform-Editor-Fenster)



Sample-Editor > Audio-Datei > Zurück zur Sicherung

Es wird auf zur letzten Sicherheitskopie zurückgekehrt. Alle Änderungen, die seither gemacht wurden, 
werden    dadurch verworfen.

Tasturbefehl:
Zurück zur Sicherung
(Wellenform-Editor-Fenster)



Sample-Editor > Audio-Datei > Kopie sichern unter...

Eine Kopie der aktuellen Datei wird unter neuem Namen gesichert.

Tasturbefehl:
Kopie sichern unter...
(Wellenform-Editor-Fenster)



Sample-Editor > Audio-Datei > Auswahl sichern unter...

Eine Kopie der aktuellen Auswahl wird unter neuem Namen gesichert.

Tasturbefehl:
Auswahl sichern unter...
(Wellenform-Editor-Fenster)



Sample-Editor > Audio-Datei > Datei-Information abgleichen

Die Informationen über die selektierten Audio-Dateien werden auf den neusten Stand gebracht.



Sample-Editor > Audio-Datei > Overview(s) neu berechnen

Fordert Logic auf, die Übersichts-Darstellung der Wellenformen der selektierten Audio Dateien neu zu 
berechnen.



Sample-Editor > Bearbeiten > Widerrufen

Macht den letzten datenverändernden Bearbeitungsschritt rückgängig.

Tasturbefehl:
Widerrufen
(Globale Kommandos)



Sample-Editor > Bearbeiten > Ausschneiden

Die aktuelle Auswahl wird ausgeschnitten und in die Zwischenablage gelegt.

Tasturbefehl:
Ausschneiden
(Globale Kommandos)



Sample-Editor > Bearbeiten > Kopieren

Eine Kopie der aktuellen Auswahl wird in die Zwischenablage gelegt.

Tasturbefehl:
Kopieren
(Globale Kommandos)



Sample-Editor > Bearbeiten > Einfügen

Der Inhalt der    Zwischenablage wird eingefügt.

Tasturbefehl:
Einfügen
(Globale Kommandos)



Sample-Editor > Bearbeiten > Löschen

Die aktuelle Auswahl wird gelöscht.

Tasturbefehl:
Löschen
(Globale Kommandos)



Sample-Editor > Bearbeiten > Alles auswählen

Es werden alle Objekte im aktuellen Fenster selektiert.

Tasturbefehl:
Alles auswählen
(Globale Kommandos)



Sample-Editor > Bearbeiten > Region -> Auswahl

Die Grenzen der Auswahl werden an Start- und Endpunkt der aktuellen Region gesetzt.

Tasturbefehl:
Region -> Auswahl
(Wellenform-Editor-Fenster)



Sample-Editor > Bearbeiten > Auswahl -> Region

Start- und Endpunkt der aktuellen Region werden durch Grenzen der Auswahl ersetzt.

Tasturbefehl:
Auswahl -> Region
(Wellenform-Editor-Fenster)



Sample-Editor > Bearbeiten > Neue Region erzeugen

Erzeugt eine neue Region.

Tasturbefehl:
Neue Region erzeugen
(Wellenform-Editor-Fenster)



Sample-Editor > Bearbeiten > Null-Durchgänge suchen

Bei aktivierter Funktion werden beim Schneiden immer die nächstliegenden Nulldurchgänge als 
Schnittpunkte berücksichtigt. Diese können zwar von eigentlichen Schnittpunkt etwas abweichen, es 
entstehen dafür an den Schnittpunkten keine Knackser.



Sample-Editor > Funktionen > Normalisieren

Normalisiert die aktuelle Auswahl. Der höchste Pegel wird auf den höchstmöglichen Pegel 
hochgerechnet. Alle anderen Daten werden proportional ebenfalls hochgerechnet.

Nicht zu verwechseln mit der Funktion im Arrangierfenster, welche den selben Namen trägt. 

Tasturbefehl:
Normalisieren
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Pegel ändern...

Es erscheint ein Dialog, in dem man numerisch einen Wert zur relativen Berechnung des Pegels angeben 
kann. Dieser wird dann auf die aktuelle Auswahl umgerechnet.

Tasturbefehl:
Pegel ändern...
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Einblenden

Über den Bereich der aktuellen Auswahl wird ein lineares Einblenden berechnet. 

Tasturbefehl:
Einblenden
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Ausblenden

Über den Bereich der aktuellen Auswahl wird ein lineares Ausblenden berechnet. 

Tasturbefehl:
Ausblenden
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Stille

Der Bereich der aktuellen Auswahl wird auf Pegel Null gesetzt und somit zur Stille. 

Tasturbefehl:
Stille
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Umkehren

Der Bereich der aktuellen Auswahl wird invertiert, also seine Phase wird gespiegelt. 

Tasturbefehl:
Umkehren
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Rückwärts

Der Bereich der aktuellen Auswahl wird zeitlich gespiegelt, wird danach rückwärts abgespielt. 

Tasturbefehl:
Rückwärts
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Trimmen

Der Bereich der aktuellen Auswahl wird aus der Datei freigestellt. Die Datei wird demnach auf die aktuelle 
Auswahl reduziert.

Tasturbefehl:
Trimmen
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Gleichspannungsversatz entfernen

Entfernt eine allfällige Gleichspannung aus dem selektierten Bereich. 



Sample-Editor > Funktionen > Einstellungen...

Öffnet einen Dialog zur Eingabe von Einstellungen bezüglich der Kurven bei Fades oder dem Pegel bei 
Normalize.



Sample-Editor > Funktionen > Errechne Tempo aus Auswahl & Locators

Das Tempo wird der Dauer der selektierten Objekte angepaßt. Mittels Locator bestimmt man, wieviele 
Takte der Länge der selektierten Objekte entsprechen sollen. Die Funktion berechnet dann das genaue 
Tempo, damit die Dauer der Objekte der vorgegebenen Taktzahl entspricht.



Sample-Editor > Funktionen > Suche maximalen Ausschlag

Sucht die Stelle mit dem lautesten Pegel innerhalb der aktuellen Auswahl.

Tasturbefehl:
Suche maximalen Ausschlag
(Wellenform-Editor-Fenster)



Sample-Editor > Funktionen > Suche Stille

Sucht stille Stellen innerhalb der aktuellen Auswahl.

Tasturbefehl:
Suche Stille
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Time and Pitch Machine...

Öffnet ein Fenster mit der Time and Pitch Machine zur Berechnung von Geschwindigkeit und Tonhöhe 
über den selektierten Bereiches einer Audio-Datei.

Tasturbefehl:
Time and Pitch Machine...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Groove Maschine...

Öffnet ein Fenster mit der Groove Machine zur Berechnung eines Swing-Anteils über den selektierten 
Bereiches einer Audio-Datei.

Tasturbefehl:
Groove Maschine...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Audio Energizer...

Öffnet ein Fenster mit dem Audio Energizer zur Berechnung eines komprimierten Pegels über den 
selektierten Bereiches einer Audio-Datei.

Tasturbefehl:
Audio Energizer...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Sample-Rate-Konvertierung...

Öffnet ein Fenster mit dem Sample Rate Convert zur Berechnung der Sample Rate über den selektierten 
Bereiches einer Audio-Datei.

Tasturbefehl:
Sample-Rate-Konvertierung...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Silencer...

Öffnet ein Fenster mit dem Silencer zur Berechnung und Elimination von Knacksern über den selektierten 
Bereiches einer Audio-Datei.

Tasturbefehl:
Silencer...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Audio to MIDI Groove Template...

Öffnet ein Fenster mit dem Audio to MIDI Groove Template zur Berechnung eines Quantisierungs-Rasters 
aus dem selektierten Bereiches einer Audio-Datei.

Tasturbefehl:
Audio to MIDI Groove Template...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Audio to Score ...

Öffnet ein Fenster mit dem Audio to Score zur Berechnung einer MIDI Sequenz aus dem selektierten 
Bereiches einer Audio-Datei.

Tasturbefehl:
Audio to Score ...
(Wellenform-Editor-Fenster)



Sample-Editor > Factory > Quantisierungsmaschine...

Öffnet ein Fenster mit der Quantize Engine zur Quantisierung des selektierten Bereiches einer Audio-
Datei.

Tasturbefehl:
Quantisierungsmaschine...
(Wellenform-Editor-Fenster)



Sample-Editor > Ansicht > Samples

Die Darstellung der Länge erfolgt in Samples.



Sample-Editor > Ansicht > Min:Sek:Ms

Die Darstellung der Länge erfolgt in Min:Sec:Ms.



Sample-Editor > Ansicht > SMPTE-Zeit

Die Darstellung der Länge erfolgt in SMPTE Zeiteinheiten.



Sample-Editor > Ansicht > Takte/Schläge...

Die Darstellung der Länge erfolgt in Takten und Schlägen.



Sample-Editor > Ansicht > Amplitude Prozentual

Die Darstellung der Amplitude erfolgt in Prozent.



Sample-Editor > Ansicht > Amplitude Sample Wert

Die Darstellung der Amplitude erfolgt in Sample-Werten.



Sample-Editor > Ansicht > Als Sample & Hold anzeigen

Die Darstellung der Amplitude entspricht den digitalen Daten.



Sample-Editor > Ansicht > Farbe...

Öffnet die Farbpalette zum Einfärben von Sequenzen, Instrumenten, Markierungen usw.

Tasturbefehl:
Objektfarben öffnen...
(Globale Kommandos)



Sample-Editor > Ansicht > Scrolling bei Wiedergabe

Während der Wiedergabe bewegt sich der Fensterinhalt. Ist diese Funktion ausgeschaltet, so bewegt 
sich nur die Songposition-Line.



Tastaturbefehle > Über die Tastaturbefehle

Sämtliche Befehle unter «Tastaturbefehle» sind Befehle des lokalen Menüs dieses Fensters und sind 
daher nur dann aktiv, wenn eine Fenster dieses Typs aktiv ist.



Tastaturbefehle > Optionen > Tastaturkommandos importieren...

Mit diesem Befehl lassen sich die Einstellungen der Tastaturkommandos aus einer Logic Preferences-
Datei importieren.



Tastaturbefehle > Optionen > Tastaturkommandos in die Ablage kopieren

Hiermit werden sämtliche momentan angezeigten Tastaturkommandos als Text in die Zwischenablage 
kopiert. Diese lassen sich sodann in eine Textverabeitung einfügen und ausdrucken.



Tastaturbefehle > Optionen > Voreinstellungen sichern

Die globalen Einstellungen werden jeweils beim Beenden von Logic automatisch gesichert. Mit diesem 
Befehl läßt sich die Sicherung der globalen Einstellungen manuell vornehmen.



Tastaturbefehle > Optionen > Auswahl darstellen

Sämtliche Tastaturbefehle werden angezeigt, eine momentane Auswahl wird aufgehoben.



Tastaturbefehle > Optionen > Zurücksetzen > Alle Voreinstellungen außer allen Kommandos

Alle Voreinstellungen außer den Tastaturbefehlen werden initialisiert, also auf die Werkseinstellungen 
zurückgesetzt.



Tastaturbefehle > Optionen > Zurücksetzen > alle Tastaturkommandos

Alle Tastaturkommandos werden initialisiert, also auf die Werkseinstellungen zurückgesetzt.



Tastaturbefehle > Optionen > Zurücksetzen > alle MIDI-Kommandos

Alle MIDI-Kommandos der Tastaturbefehlen werden initialisiert, also auf die Werkseinstellungen 
zurückgesetzt.



Globale Voreinstellungen > Über die globalen Voreinstellungen

Hierbei handelt es sich um globale Einstellungen des Programmes. Diese gelten demnach für alle Songs 
gleichermassen. Die verschiedenen Abschnitte der globalen Voreinstellungen finden Sie im Menü 
"Optionen > Einstellungen >".



Globale Voreinstellungen > Kommunikation > AMT (Active MIDI Transmittion)

Aktiviert die aktive MIDI Übertragung im Zusammenhang mit einem Unitor 8.



Globale Voreinstellungen > Kommunikation > MIDI Machine Control im alten Fostex-Format statt 
MMC

Bei aktivierter Option wird anstelle des normalen MMC-Formates das alte Fostex-Format gesendet.



Globale Voreinstellungen > Kommunikation > Externer Stop beendet die Aufnahme

Ankommende Stop-Befehle beenden eine Aufnahme, falls diese Option aktiviert ist.



Globale Voreinstellungen > Kommunikation > Nach dem Öffnen immer Stoppen

Beim Öffnen eines Songs wird die Wiedergabe nicht automatisch gestartet, auch wenn der Song so 
gesichert worden ist.



Globale Voreinstellungen > Kommunikation > Autolink mit SoundDiver/-Surfer nach Möglichkeit 
verwenden

Für die Kommunikation zwischen SoundDiver oder SoundSurfer und Logic wird AUTOLINK verwendet.



Globale Voreinstellungen > Kommunikation > Song Position Pointer auch bei der Wiedergabe 
zulassen

Erlaubt die Ausgabe von Song Position Pointer während der Wiedergabe. Dies ist normalerweise nicht 
nötig.



Globale Voreinstellungen > Kommunikation > AMT Version

Beim Betrieb eines Unitor 8 oder AMT 8 kann die Version von AMT gewählt werden. Nach Möglichkeit 
sollte hier unbedingt AMT Version 2 verwendet werden. Gegebenenfalls muß dazu die Software des 
Interfaces auf den neusten Stand gebracht werden.



Globale Voreinstellungen > Global > Beim Öffnen Schließen des aktuellen Songs vorschlagen

Beim Öffnen eines Songs fragt Logic nach, ob der bestehende Song geschlossen werden soll.



Globale Voreinstellungen > Global > Den Papierkorb entleeren nach dem Sichern

Der Papierkorb wird beim Sichern eines Song automatisch entleert.



Globale Voreinstellungen > Global > 'Letzte Funktion' an Sequenznamen anhängen

Der Name einer Sequenz erhält beim Bearbeiten automatisch den Zusatz der Funktion.



Globale Voreinstellungen > Global > Keine Rückfrage bei 'Widerrufen'

Hiermit kann die Sicherheitsabfrage beim Aufrufen der 'Widerrufen'-Funktion ausgeschaltet werden.



Globale Voreinstellungen > Global > Bezug Groove-Muster/Basis-Sequenz aufheben

Normalerweise wirkt sich eine Änderung an einer Sequenz, welche als 'Groove Template' definiert 
worden ist, auch auf das daraus erzeugte Quantisierungsraster aus. Diese Verknüpfung kann hiermit 
unterbunden werden.



Globale Voreinstellungen > Global > "Catch" einschalten wenn Sequenzer startet

Die 'Catch'-Funktion wird beim Starten des Sequenzers automatisch aktiviert.



Globale Voreinstellungen > Global > "Catch" einschalten beim Ändern der Songposition

Die 'Catch'-Funktion wird beim Verschieben der Position des Sequenzers automatisch aktiviert.



Globale Voreinstellungen > Global > "Content Catch by Position"    bei aktiviertem "Catch" und 
"Link" zulassen

Falls diese Option eingeschaltet ist, so wird bei einem Fenster, bei welchen sowohl Catch als auch Link 
aktiviert worden sind, die 'Content Catch' Funktion aktiv.



Globale Voreinstellungen > Global > Ziehen im Matrix- und Noten-Editor nur in einer Richtung 
zulassen

Diese Option begrenzt das Verschieben von Noten im Matrix- und Noten-Editor in einer Richtung.



Globale Voreinstellungen > Global > Ziehen im Arrangierfenster nur in einer Richtung zulassen

Diese Option begrenzt das Verschieben von Objekten im Arrangierfenster jeweils in einer Richtung.



Globale Voreinstellungen > Global > Fenster nicht-aktiver Songs ausblenden

Die Fenster der nicht aktiven Songs werden ausgeblendet.



Globale Voreinstellungen > Global > 'MIDI-File exportieren...' sichert Einzelsequenz im Format 0

Beim Exportieren eines MIDI-Files wird das Format 0 verwendet, sofern die zu exportierenden Daten aus 
einer einzigen Sequenz bestehen.



Globale Voreinstellungen > Global > Doppelklick auf Sequenz öffnet ... im Arrangierfenster

Dieser Eintrag bestimmt darüber, welcher Editor geöffnet werden soll, falls eine Sequenz im 
Arrangierfenster über einen Doppelklick geöffnet wird.



Globale Voreinstellungen > Global > Automatische Sicherheitskopie der letzten...    Versionen

Beim Sichern wird die alte Version eines Songs wahlweise nicht überschrieben, sondern in einem 
Verzeichnis numeriert abgelegt. Der Eintrag dieses Menüs bestimmt darüber, wieviele Versionen eines 
Songs maximal erhalten bleiben sollen.



Globale Voreinstellungen > Anzeige > breite Song-Positionslinie

Die Song Position Line kann wahlweise breiter dargestellt werden.



Globale Voreinstellungen > Anzeige > Mittleres C als "C3" auffassen (Yamaha)

Das mittlere C wird als C3 dargestellt.



Globale Voreinstellungen > Anzeige > Layer "Alle Objekte" im Environment zulassen

Diese Option entscheidet darüber, ob im Environment die Layer, in welcher sämtliche Objekte angezeigt 
werden, angewählt werden darf.



Globale Voreinstellungen > Anzeige > Instrument-Menü nach Layer sortieren

Die Einträge des Instrument-Menüs werden gemäß der Environment-Layer, in welcher sie liegen, sortiert 
dargestellt.



Globale Voreinstellungen > Anzeige > Instrument-Menü nach Icons sortieren

Die Einträge des Instrument-Menüs werden gemäß dem Symbol, welches dem Instrument zugeordnet 
worden ist,    sortiert dargestellt.



Globale Voreinstellungen > Anzeige > hochauflösende Hintergrundgraphik

In verschiedenen Fenstern wird der hochauflösenden Grafik-Hintergrung anstelle von Grau verwendet.



Globale Voreinstellungen > Anzeige > In der SMPTE-Anzeige Nullen als Leerstellen anzeigen

Wahlweise können in der SMPTE-Zeitangabe vorangehende Nullwerte als Leerschlag dargestellt werden. 



Globale Voreinstellungen > Anzeige > Zeige SMPTE mit ...

Dieser Eintrag bestimmt das Darstellungsformat der SMPTE-Zeit.



Globale Voreinstellungen > Anzeige > Tempo in ...

Dieser Eintrag bestimmt das Darstellungsformat der Tempo-Angaben.



Globale Voreinstellungen > Anzeige > Taktposition als ...

Dieser Eintrag bestimmt das Darstellungsformat der Takt-Angabe.



Globale Voreinstellungen > Anzeige > Sprache...

Wählen Sie aus diesem Menü die Sprache, in der Logic sämtliche Menüs darstellen soll. Nach dem 
Umschalten muß Logic beendet und neu gestartet werden, damit diese Einstellung wirksam wird.



Globale Voreinstellungen > Anzeige > Version ... Aussehen

Wählen Sie hier zwischen dem aktuellen Erscheinungsbild von Logic oder demjenigen bekannt aus den 
Versionen vor 4.0.



Globale Voreinstellungen > Notation > Punktierte Song-Positionslinie

Die Song Positionsline kann wahlweise punktiert dargestellt werden.



Globale Voreinstellungen > Notation > Sequenzauswahl farbig darstellen

Sequenzen werden farbig dargestellt, wenn sie selektiert sind.



Globale Voreinstellungen > Notation > Beschleunigte (niedrigauflösende) Kurvendarstellung

Zur Darstellung der Bögen kann auf dem Bildschirm eine weniger genaue Auflösung und dafür schnellere 
Darstellung benutzt werden.



Globale Voreinstellungen > Notation > Alle Längenangaben in Zoll

Hiermit erfolgen alle Distanzen im Zoll-Mass.



Globale Voreinstellungen > Notation > Symbolpaletten

Die Paletten der Notensymbole werden wahlweise standardmäßig, horizontal oder vertikal geöffnet.



Globale Voreinstellungen > Notation > Doppelklick auf Note öffnet

Ein Doppelklick auf eine Note öffnet wahlweise die Noten-Attribute, Event-Editor, Matrix-Editor oder 
Hyper-Editor.



Globale Voreinstellungen > Notation > Grafikexport-Auflösung

Dieser Wert bestimmt die Auflösung des Bildes beim Exportieren der Notation.



Globale Voreinstellungen > Notation > Grafikexport in

Der Grafik-Export kann wahlweise in eine Datei oder in die Zwischenablage erfolgen.



Globale Voreinstellungen > Notation > Automatische Kanaltrennung bei

Bei einer Einspielung können die Noten nach einem festen Splittpunkt der linken und rechten Hand 
zugeordnet werden.



Globale Voreinstellungen > Reset-Einstellungen (Zurücksetzen) > Reset-Einstellungen 
(Zurücksetzen)

Beim Stoppen des Sequenzers sollten verschiedene MIDI-Daten zurückgesetzt werden.
Dazu können verschiedene Datentypen pro Port aktiviert werden welche dann zurückgesetzt werden.



Globale Voreinstellungen > Audio > Sample-Editor > Warnung vor dem Schließen des Sample-
Editors

Ist diese Option markiert, so erfolgt beim Schließen des Sample-Editors eine Sicherheitsabfrage.



Globale Voreinstellungen > Audio > Sample-Editor > Warnung vor destruktiven Bearbeitungen 
durch eine Funktion (Taste)

Ist diese Option markiert, so erfolgt , beim Aufrufen einer datenverändernden Funktion des Sample-
Editors über die Tastatur, eine Sicherheitsabfrage.



Globale Voreinstellungen > Audio > Sample-Editor > Warnung vor destruktiven Bearbeitungen 
durch eine Funktion (Menü)

Ist diese Option markiert, so erfolgt , beim Aufrufen einer datenverändernden Funktion des Sample-
Editors über die Tastatur, eine Sicherheitsabfrage.



Globale Voreinstellungen > Audio > Sample-Editor > Frage nach Sicherungsdatei vor dem 
Prozessieren im Editor

Ist diese Option aktiviert, so fragt Logic Audio beim Aufrufen einer datenverändernden Funktion des 
Sample-Editors nach dem Erstellen eines    Backups der betroffenen Daten.



Globale Voreinstellungen > Audio > Sample-Editor > Undo file erzeugen für "Normalisieren"

Ist diese Option aktiviert, so erstellt Logic Audio auch für die Funktion "Normalize" eine Undo-Datei, die es 
ermöglicht, über die 'Undo'-Funktion zum vorherigen Zustand zurückzukehren.



Globale Voreinstellungen > Audio > Sample-Editor > Zwischenzeitlich schnelleres Darstellen der 
Wellenform im Sample-Editor

Falls aktiviert, so wird im Sample-Editor die Wellenform zwischenzeitlich ungenauer und dafür schneller 
dargestellt, so etwa wenn die Darstellungsgröße verändert wird.



Globale Voreinstellungen > Audio > Anzeige > Farbe im Audio-Fenster

Falls aktiviert, so werden Farben im Audio-Fenster dargestellt.



Globale Voreinstellungen > Audio > Anzeige > Audio-Objekte im neuen Stil

Hier läßt sich wahlweise zwischen der neueren und der älteren Art der Darstellung der Audio-Objekte im 
Environment umschalten.



Globale Voreinstellungen > Audio > Anzeige > Farbige Audio-Objekte (Alter Stil)

Bei der Darstellung der Audio-Objekte in der älteren Darstellung, lassen sich diese einfärben, falls diese 
Option gewählt wird.



Globale Voreinstellungen > Audio > Global > Im Stop: Audio-Treiber im Hintergrund freigeben

Ähnlich wie bei den seriellen Ports, kann auch die Audio-Hardware freigegeben werden, falls Logic Audio 
gestoppt und nicht die aktive Anwendung ist.



Globale Voreinstellungen > Audio > Global > Im Stop: Audio-Treiber für die Wiedergabe 
vorbereiten

Das Aktivieren dieser Einstellung veranlasst Logic Audio, bereits beim Stoppen das Abspielen von Audio 
vorzubereiten. Dadurch kann die Reaktionszeit beim Starten der Wiedergabe verkleinert werden.



Globale Voreinstellungen > Audio > Global > Übersicht nach der Aufnahme erstellen

Ist dies Optioen ausgeschaltet, so beginnt Logiac nach einer Aufnahme nicht automatisch damit, die 
Übersicht der Wellenform-Darstellung zu berechnen. Diese kann dann später bei Bedarf manuell 
gestartet werden.



Globale Voreinstellungen > Audio > Global > Aufnahme & Konvertierung in Split-Stereo-Dateien 
erzwingen

Falls aktiviert, legt Logic bei Stereo-Aufnahmen jeweils eine separate Datei für den linken und rechten 
Kanal an. 



Globale Voreinstellungen > Audio-Treiber > PC AV > PC AV

Aktiviert den Treiber für die über den Multimedia-Treiber angesprochene Audio-Hardware.



Globale Voreinstellungen > Audio-Treiber > PC AV > Treiber

Wählen Sie hier denjenigen Mulitmedia-Treiber, den Sie für die Aufnahme und Wiedergabe von Audio 
verwenden wollen.



Globale Voreinstellungen > Audio-Treiber > PC AV > Delay

Dieser Wert bestimmt die Verzögerung bei der Wiedergabe und Aufnahme von Audio..



Globale Voreinstellungen > Audio-Treiber > PC AV > 20/24 Bit Recording

Sobald diese Option aktivert ist, erfolgen die Aufnahmen mit einer Auflösung von 20/24 Bit, sofern dies 
von der Audio-Hardware unterstütz wird.



Globale Voreinstellungen > Audio-Treiber > PC AV > Control Panel

Hier können Sie die externe Anwendung öffnen, in der die spezifischen Einstellungen der Hardware 
vorgenommen werden können.



Globale Voreinstellungen > Audio-Treiber > Audiowerk > Audiowerk

Aktiviert den Treiber für die Verwendung von Audiowerk 8.



Globale Voreinstellungen > Audio-Treiber > Audiowerk > Input

Hier kann entweder die analoge oder digitale Betriebsart des Einganges gewählt werden.



Globale Voreinstellungen > Audio-Treiber > Audiowerk > Monitor Response

Hier kann eingestellt werden, wie schnell die Monitor-Funktion bei der Audiowerk reagieren soll.



Globale Voreinstellungen > Audio-Treiber > Audiowerk > Monitoring

Hier kann das Monitoring beim Einsatz einer Audiowerk8-Karte wahlweise gänzlich deaktiviert werden.



Globale Voreinstellungen > Audio-Treiber > SSHDR > SSHDR

Aktiviert den Treiber für das angschlossene Soundscape HDR.



Globale Voreinstellungen > Audio-Treiber > SSHDR > Input

Hier kann entweder die analoge oder digitale Betriebsart des Einganges gewählt werden.



Globale Voreinstellungen > Audio-Treiber > SSHDR > Mix Inputs during playback

Wahlweise kann das am Eingang des SSHDR anliegende Signal während der Wiedergabe dazugemischt 
werden.



Globale Voreinstellungen > Audio-Treiber > SSHDR > Mix Mode "Trk 1-4 -> Out1/2, Trk 1-8-> 
Out3/4"

Bestimmt den Modus des Mixers. Wenn aktivert, werden Spuren 1 bis 4 am Ausgang 1/2, Spuren 1 bis 8 
am Ausgang 3/4 ausgegeben.



Globale Voreinstellungen > Audio-Treiber > SSHDR > Master Clock (Unit 1)

Hier kann die Quelle gewählt werden, die als Taktgeber des SSHDR verwendet werden soll.



Song-Einstellungen > Über die Song-Einstellungen

Bei den Song-Einstellungen handelt es sich um lokale Einstellungen des Songs. Diese gelten demnach 
nur für den aktuellen Song. Sämtliche Einstellungen unter «Song-Einstellungen» sind in den 
verschiedenen Abschnhitten unter "Optionen > Einstellungen >" zu finden.



Song-Einstellungen > Aufnahme-Einstellungen... > Neue Aufnahme in ausgewählte Sequenz 
einfügen (r)

Neu augezeichnete Daten werden mit den selektierten Sequenzen zusammengemischt.



Song-Einstellungen > Aufnahme-Einstellungen... > Alle Cycle-Aufnahmen in eine Sequenz (n)

Neue erzeugte Sequenzen werden mit bestehenden Sequenzen dieser Spur zusammengemischt, falls 
die Aufnahme im Cycle Mode erfolgt.



Song-Einstellungen > Aufnahme-Einstellungen... > Auto Mute während der Aufnahme im Cycle-
Modus    (m)

Im Cycle-Mode aufgezeichnete Sequenzen werden automatisch stummgeschaltet.



Song-Einstellungen > Aufnahme-Einstellungen... > Spuren während der Aufnahme im Cycle-
Modus erzeugen (c)

Im Cycle-Mode aufgezeichnete Sequenzen werden automatisch auf eine neue Spur gelegt.



Song-Einstellungen > Aufnahme-Einstellungen... > nach Event-Kanal auftrennen bei Multitrack-
Aufnahmen

Wird gleichzeitig auf mehreren MIDI-Spuren aufgezeichnet, so werden die Events automatisch nach dem 
MIDI-Kanal des jeweiligen Instrumentes aufgeteilt.



Song-Einstellungen > Aufnahme-Einstellungen... > Aufnahme von Tempowechseln zulassen

Ermöglicht das Aufzeichnen von Tempoänderungen.



Song-Einstellungen > Aufnahme-Einstellungen... > MIDI-Datenreduktion

Beim Aufzeichnen werden die Daten nach einem komplexen Verfahren auf die notwendigen Daten 
reduziert.



Song-Einstellungen > Aufnahme-Einstellungen... > Klick während der Wiedergabe (p)

Aktiviert die Ausgabe des Metronoms während der Wiedergabe.



Song-Einstellungen > Aufnahme-Einstellungen... > Klick während der Aufnahme (e)

Aktiviert die Ausgabe des Metronoms während einer Aufnahme.



Song-Einstellungen > Aufnahme-Einstellungen... > Polyphone Metronom-Klicks

Erlaubt die gleichzeitige Ausgabe von mehreren Clicks.



Song-Einstellungen > Aufnahme-Einstellungen... > Klick über Lautsprecher

Aktiviert die Ausgabe des Metronoms über den internen Lautsprecher.



Song-Einstellungen > Aufnahme-Einstellungen... > Klick über MIDI

Aktiviert die Ausgabe des Metronoms über MIDI.



Song-Einstellungen > Aufnahme-Einstellungen... > Vorzähler

Dieses Menü bestimmt die Länge des Einzählers bei der Aufnahme.



Song-Einstellungen > Aufnahme-Einstellungen... > Klick nur während des Vorzählers (Aufnahme)

Die Ausgabe des Metronoms erfolgt lediglich während dem Einzählen.



Song-Einstellungen > MIDI-Einstellungen... > Eingangsfilter

Das Deaktivieren eines Event-Symbols hat zur Folge, daß diese Events vor der Aufnahme gefiltert und 
somit nicht aufgezeichnet werden.



Song-Einstellungen > MIDI-Einstellungen... > MIDI Thru auch bei systemexklusiven Daten

Das Durchschleifen von Sysex-Daten kann unterbunden werden.



Song-Einstellungen > MIDI-Einstellungen... > Instrument ohne MIDI-Thru-Funktion (ältere 
Keyboards ohne "Local Off")

Das in diesem Menü gewählte Instrument wird vom Durchschleifen der MIDI-Daten ausgenommen.



Song-Einstellungen > MIDI-Einstellungen... > MIDI-Clock senden

Aktiviert die Ausgabe von MIDI-Clock. Dahinter kann der Port angegeben werden, an den MIDI Clock 
gesendet werden soll.



Song-Einstellungen > MIDI-Einstellungen... > MTC (MIDI Time Code) senden

Aktiviert die Ausgabe von MIDI Time Code. Dahinter kann der Port angegeben werden, an den MTC 
gesendet werden soll.



Song-Einstellungen > MIDI-Einstellungen... > Auto Sync am Eingang

Bei aktivierter Funktion synchronisiert sich Logic automatisch auf    MIDI Clock oder MTC, sobald er diese 
empfängt



Song-Einstellungen > MIDI-Einstellungen... > MMC (MIDI Machine Control ) senden

Schaltet die Ausgabe von MIDI Machine Control ein oder aus. Entspricht der Einstellung im 
Transportfenster.

Tasturbefehl:
MIDI Machine Control (Laufwerkfernsteuerung)
(Globale Kommandos)



Song-Einstellungen > MIDI-Einstellungen... > nach dem Öffnen benutzte MIDI-Einstellungen 
senden

Die Einstellungen der Instrumente werden nach dem Laden des Songs automatisch gesendet.



Song-Einstellungen > MIDI-Einstellungen... > nach dem Öffnen alle Faderwerte senden

Die Stellungen der Fader werden nach dem Laden des Songs automatisch gesendet.



Song-Einstellungen > MIDI-Einstellungen... > MIDI-Fernbedienung

Ermöglicht die Steuerung von Logic über MIDI-Daten gemäß den Einstellungen der Tastaturbefehle.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Events verfolgen...

Für die gewählten Event-Typen sucht MIDI Studio Professional beim Start der Wiedergabe nach 
vorangegangenen relevaten Daten und sendet diese.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Controller 0-15 erfassen

Aktiviert die Chase-Funktion für die Controller Nummer 0 bis 15.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Controller 64-71 
erfassen

Aktiviert die Chase-Funktion für die Controller Nummer 64 bis 71.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Alle anderen Controller 
erfassen

Aktiviert die Chase-Funktion für alle anderen Controller .



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Per Sustain Pedal 
gehaltene Noten erfassen

Aktiviert die Chase-Funktion für mit Sustain gehaltene Noten.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Drum-Noten ebenfalls 
berücksichtigen

Aktiviert die Chase-Funktion für Instrumente, deren Parameter 'No Seq Trp' aktiviert ist.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Kanäle von auf allen 
Kanälen sendenden Intrumenten individuell erfassen

Aktiviert die Chase-Funktion pro Kanal von Instrumenten, welche die Einstellung 'All Cha' aufweisen.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Beim Cycle-Sprung 
Befehle erfassen

Aktiviert die Chase-Funktion beim Cycle-Sprung.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Beim Cycle-Sprung 
Noten erfassen

Aktiviert die Chase-Funktion beim Cycle-Sprung.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Totalen Reset senden

Bewirkt die Ausgabe von MIDI-Reset Messages vor dem Senden der Chase-Daten.



Song-Einstellungen > Chase Events (vorausgehende Befehle erfassen) > Chase Text Meta Events

Aktiviert die Chase-Funktion für (interne) Text Meta Events.



Song-Einstellungen > Notat.: globale Formate > Oberer Rand

Bestimmt die Grösse des oberen Randes der Seite bei der Noten-Darstellung, resp.    Ausdruck.



Song-Einstellungen > Notat.: globale Formate > Unterer Rand

Bestimmt die Grösse des unteren Randes der Seite bei der Noten-Darstellung, resp.    Ausdruck.



Song-Einstellungen > Notat.: globale Formate > Linker Rand

Bestimmt die Grösse des linken Randes der Seite bei der Noten-Darstellung, resp.    Ausdruck.



Song-Einstellungen > Notat.: globale Formate > Rechter Rand

Bestimmt die Grösse des rechten Randes der Seite bei der Noten-Darstellung, resp.    Ausdruck.



Song-Einstellungen > Notat.: globale Formate > Titelzone

Bestimmt die Grösse des Titel-Bereiches bei der Noten-Darstellung, resp.    Ausdruck.



Song-Einstellungen > Notat.: globale Formate > Zeilenabstand

Bestimmt den Abstand der Notensysteme.



Song-Einstellungen > Notat.: globale Formate > Max. Takte/Zeile

Die maximale Anzahl Takte, welche auf einer Zeile dargestellt werden, wird auf diese Zahl begrenzt.



Song-Einstellungen > Notat.: globale Formate > Konstanter Notenabstand

Dieser Parameter vergrößert den Abstand zwischen Noten oder Pausen unabhängig von ihrer Länge.



Song-Einstellungen > Notat.: globale Formate > Proportionaler Notenabstand

Dieser Parameter vergrößert den Abstand zwischen Noten oder Pausen abhängig von ihrer Länge.



Song-Einstellungen > Notat.: globale Formate > Abstand für Querstriche

Bestimmt die Größe des horizontalen Abstandes der "Beat Slashes".



Song-Einstellungen > Notat.: globale Formate > Pedalzeichen-Position

Dieses Mass bestimmt den vertikalen Abstand für aufgezeichnete Sustain-Pedal-Events.



Song-Einstellungen > Notat.: globale Formate > Faktor Balkenneigung

Bestimmt das Verhältnis zwischen dem Intervall der Noten und der Steigung der Balken.



Song-Einstellungen > Notat.: globale Formate > Minimale Balkenneigung

Diese Einstellung bestimmt die minimale Steigung der Balken.



Song-Einstellungen > Notat.: globale Formate > Maximale Balkenneigung

Diese Einstellung bestimmt die maximale Steigung der Balken.



Song-Einstellungen > Notat.: globale Formate > Klammerbreite freihalten

Falls aktiviert wird zusätzlicher Raum für die Klammerbreite freigehalten. 



Song-Einstellungen > Notat.: globale Formate > Einzelsysteme offen

Einzelne Notensysteme werden offen dargestellt.



Song-Einstellungen > Notat.: globale Formate > Letzte Zeile ausrichten

Der letzte Takt der wird in der Breite angepasst und bis zum rechten Rand ausgedehnt.



Song-Einstellungen > Notat.: globale Formate > Stillgeschaltete Sequenzen ausblenden

Stummgeschaltete Sequenzen werden im Notenbild nicht dargestellt. 



Song-Einstellungen > Notat.: globale Formate > Stillgeschaltete Spuren ausblenden

Stummgeschaltete Spuren werden im Notenbild nicht dargestellt. 



Song-Einstellungen > Notat.: globale Formate > Alternative Wiederholungszeichen

Wahlweise kann die Darstellung der Wiederholungszeichen im 'Real Book'-Stil erfolgen.



Song-Einstellungen > Notat.: globale Formate > Deutsche Akkordsymbole

Aktiviert die Verwendung von deutschen Akkord-Symbolen (H anstatt B).



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Seitennummern

Aktiviert die automatische Seitennumerierung.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Hor.    Position

Bestimmt die horizontale Ausrichtung der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Vert. Position

Bestimmt die vertikale Ausrichtung der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Seiten-Versatz

Bestimmt den horizontalen Abstand der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Hor.    Abstand

Bestimmt den horizontalen Abstand der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Vert. Abstand

Bestimmt den vertikalen Abstand der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Font

Bestimmt den Schrift-Typ der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Größe

Bestimmt die Schrift-Grösse der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Effekt

Bestimmt die Schrift-Attribute der Seitenzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Seite 1 nicht numerieren

Die erste Seitenzahl wird unterdrückt.



Song-Einstellungen > Notat.: Ziffern & Namen > Seitennr. > Präfix

Hier kann wahlweise ein Zusatz zur Seitennumerierung angegeben werden.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Taktnummern

Aktiviert die Ausgabe der automatischen Taktnumerierung.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Vert. Position

Bestimmt den vertikalen Abstand der automatischen Taktnumerierung zum Notensystem .



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Schrittweite

Bestimmt die Schrittgröße der automatischen Taktnumerierung.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Takt

Hier kann wahlweise eine Verschiebung der Taktzahl eingegeben werden.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Beginnen mit

Bestimmt die Anfangszahl der automatischen Taktnumerierung.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Font

Bestimmt den Schrift-Typ der Taktzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Größe

Bestimmt die Schrift-Größe der Taktzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Effekt

Bestimmt die Schrift-Attribute der Taktzahl.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Mehrfachpausen zählen

Bei der Berechnung der Taktzahl werden mehrtaktige Pausen berücksichtigt.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > An allen Doppelstrichen

Ist diese Option aktiviert, so erfolgt die Ausgabe der Taktnummern auch bei sämtlichen Doppelstrichen.



Song-Einstellungen > Notat.: Ziffern & Namen > Taktnr. > Nur in erster/letzter Zeile

Die Ausgabe der Taktzahlen erfolgt nur auf dem obersten und unterstem Notensystem.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Instrument-Namen

Aktiviert die Ausgabe der Instrumenten-Namen auf dem Notenblatt.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Position

Die Namen der Instrumente lassen sich wahlweise neben oder über dem Notensystem ausgeben.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Ausrichtung

Bestimmt die Ausrichtung der Instrumenten-Namen.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Erste Zeile

Bestimmt die Form des Namens auf der ersten Seite.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Folgesysteme

Bestimmt die Form des Namens auf allen folgenden Seiten.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Font

Bestimmt den Schrift-Typ der Instrumenten-Namen.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Größe

Bestimmt die Schrift-Grösse der Instrumenten-Namen.



Song-Einstellungen > Notat.: Ziffern & Namen > Instr.-N. > Effekt

Bestimmt die Schrift-Attribute der Instrumenten-Namen.



Song-Einstellungen > Notat.: Gitarrentabulatur > Name

Hier können die Namen der 12 Sets von Tabulator-Zuordnungen eingegeben werden.



Song-Einstellungen > Notat.: Gitarrentabulatur > Saiten

Diese Zahl bestimmt die Anzahl der Saiten der jeweiligen Tabulator-Zuordnung.



Song-Einstellungen > Notat.: Gitarrentabulatur > Zuordnung

Dieser Parameter bestimmt die automatische Zuordnung einer Note zu einer Saite. 



Song-Einstellungen > Notat.: Gitarrentabulatur > Font

Bestimmt den Schrift-Typ der Gitarren-Tabulatur.



Song-Einstellungen > Notat.: Gitarrentabulatur > Größe

Bestimmt die Schrift-Größe der Gitarren-Tabulatur.



Song-Einstellungen > Notat.: Gitarrentabulatur > Effekt

Bestimmt die Schrift-Attribute der Gitarren-Tabulatur.



Song-Einstellungen > Notat.: Gitarrentabulatur > Ausrichtung

Bestimmt die Ausrichtung der Tabulatur-Zeichen.



Song-Einstellungen > Notat.: Gitarrentabulatur > Basssaite

Bestimmt die Linienstärke der Bassaite.



Song-Einstellungen > Notat.: Gitarrentabulatur > 1/1, 1/2 Noten

Wahlweise können halbe und ganze Noten umkreist dargestellt werden.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Notenschl. > Jedes Notensystem

Die Ausgabe des Notenschlüssels erfolgt in jedem Notensystem.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Notenschl. > Erstes System jeder Seite

Die Ausgabe des Notenschlüssels erfolgt nur im jeweils ersten Notensystem einer Seite.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Notenschl. > Erstes System Seite 1

Die Ausgabe des Notenschlüssels erfolgt nur im jeweils ersten Notensystem der ersten Seite.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Notenschl. > Alle ausblenden

Die Ausgabe des Notenschlüssels wird unterdrückt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Notenschl. > Ankündigung am Zeilenende

Falls der Wechsel des Notenschlüssels auf einen Zeilenumbruch fällt, so wird dieser am Ende der 
vorhergehenden Zeile angekündigt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Notenschl. > Bei Schlüsselwechsel kleiner

Bei einem Schlüsselwechsel können die neuen Notenschlüssel kleiner als der Hauptschlüssel dargestellt 
werden.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Jedes Notensystem

Die Ausgabe der Tonart erfolgt in jedem Notensystem.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Erstes System jeder Seite

Die Ausgabe der Tonart erfolgt nur im jeweils ersten Notensystem einer Seite.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Erstes System Seite 1

Die Ausgabe der Tonart erfolgt nur im jeweils ersten Notensystem der ersten Seite.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Alle ausblenden

Die Ausgabe der Tonart wird unterdrückt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Ankündigung am Zeilenende

Falls der Wechsel der Tonart auf einen Zeilenumbruch fällt, so wird dieser am Ende der vorhergehenden 
Zeile angekündigt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Automatische Tonarttransposition

Das Deaktivieren dieser Option führt dazu, daß bei einer Transposition im Notationsformate die globalen 
Vorzeichen unterdrückt werden.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Transponierte Vorzeichenanzahl 
minimieren

Durch das Aktivieren dieser Option wird die notierte Tonart eines Instrumentes immer dann enharmonisch 
verwechselt, wenn es dadurch möglich ist, insgesamt weniger Vorzeichen zu notieren.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Auflösungszeichen zeigen

Bei aktivierter Option werden bei Tonartartwechsel die Auflösungszeichen für abweichende Vorzeichen 
der vorhergehenden Tonart angezeigt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Tonart > Hilfsvorzeichen zeigen

Bei einer Änderung der Tonart werden wahlweise Hilfsvorzeichen angezeigt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Taktart > Jedes Notensystem

Die Ausgabe der Taktart erfolgt in jedem Notensystem.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Taktart > Erstes System jeder Seite

Die Ausgabe der Taktart erfolgt nur im jeweils ersten Notensystem einer Seite.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Taktart > Erstes System Seite 1

Die Ausgabe der Taktart erfolgt nur im jeweils ersten Notensystem der ersten Seite.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Taktart > Alle ausblenden

Die Ausgabe der Taktart wird unterdrückt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Taktart > Ankündigung am Zeilenende

Falls der Wechsel der Taktart auf einen Zeilenumbruch fällt, so wird dieser am Ende der vorhergehenden 
Zeile angekündigt.



Song-Einstellungen > Notat.: Schl.- & Taktw. > Taktart > Takstriche ausblenden

Falls aktiviert werden sämtliche Taktstriche ausgeblendet.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Notenlinienstärke

Dieser Wert bestimmt die Stärke der Notenlinien.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Notenhalsstärke

Dieser Wert bestimmt die Stärke der Notenhälse.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Hilfslinienstärke

Dieser Wert bestimmt die Stärke der Hilfslinien.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Takstrichstärke

Dieser Wert bestimmt die Stärke der Taktstriche.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Endstrichstärke

Dieser Wert bestimmt die Stärke der Endlinien.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > N-Tolen-Klammernstärke

Dieser Wert bestimmt die Stärke der N-Tolen-Klammern.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Textrahmenstärke

Dieser Wert bestimmt die Stärke der Rahmen von Text-Boxen.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Crescendostärke

Dieser Wert bestimmt die Stärke der Crescendolinien und Pfeile.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Abstand Kopf-Punkt

Dieser Wert bestimmt den Abstand zwischen Notenkopf und Punkt einer punktierten Note.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Abstand Punkt-Punkt

Dieser Wert bestimmt den Abstand der Punkte bei mehrfach punktierten Noten.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Abstand Vorzeichen-Kopf

Dieser Wert bestimmt den Abstand zwischen den Vorzeichen und den Noten.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Abstand Vorzeichen-Vorzeichen

Dieser Wert bestimmt den Abstand zwischen den Vorzeichen und Vorzeichen.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Notenhalslänge

Dieser Wert bestimmt die Länge des Notenhalses.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Hor. Haltebogenposition

Dieser Wert bestimmt den horizontalen Abstand zwischen Notenkopf und Haltebogen. 



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Vert. Haltebogenposition

Dieser Wert bestimmt den vertikalen Abstand zwischen Notenkopf und Haltebogen. 



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Haltebogen-Stärke

Dieser Wert bestimmt die Stärke von Haltebögen.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Phrasierungsbogen-Stärke

Dieser Wert bestimmt die Stärke von Bindebögen.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Ausrichtung Akkordsymbole

Bestimmt die Ausrichtung der Akkord-Symbole.



Song-Einstellungen > Notat.: Erweiterte Layout-Parameter > Vorgaben

Sämtliche Werte werden auf Logics Voreinstellungen zurückgesetzt.



Song-Einstellungen > Notat.: MIDI-Bedeutung > Symbol

Bei der Eingabe dieser Symbole kann deren Auswirkung auf Velocity und Länge der betroffenen Noten 
bestimmt werden.



Song-Einstellungen > Notat.: MIDI-Bedeutung > Velocity

Bestimmt den Grad der Dynamik-Änderung bei der Wiedergabe der Noten, denen dieses Symbol 
zugeordnet worden ist.



Song-Einstellungen > Notat.: MIDI-Bedeutung > Länge

Bestimmt den Grad der Längen-Änderung bei der Wiedergabe der Noten, denen dieses Symbol 
zugeordnet worden ist.



Über die Tastaturkommandos

Die Zuordnung der Tastaturkommandos zu den Tastenkombinationen erfolgt in einem speziellen Fenster, 
das sich über "Optionen > Einstellungen > Tastaturkommandos..." öffnen läßt.

Die Befehle sind in mehrer Gruppen aufgeteilt:

- Globale Kommandos
Tastenkombinationen, welche mit Globalen Kommandos belegt sind gelten in allen Fenstern.

- Verschiedene Fenster
Diese Befehle gelten in verschiedenen Fenstern.

- Arrangier- und Editierfenster
Diese Befehle gelten für das Arrangierfenster und die verschiedenen Editoren.

- Arrangierfenster
- Environment-Fenster
- Notenfenster
- Event-Fenster
- Hyper Edit
- Audio-Fenster
- Wellenform-Editor-Fenster

Die Befehle dieser Gruppen gelten jeweils nur für den entsprechenden Fenster-Typ.
Es ist daher durchaus möglich, einer Tastenkombination in verschiedenen Fenstern unterschiedliche 
Befehle aus diesen Gruppen zuzuordnen.



Importieren...      (Tastaturbefehl)

Erlaubt das Importieren von Songs in anderen Formaten, so z.B. MIDI Files.

Tastaturbefehl:
Importieren...
(Globale Kommandos)



*Letzten Take als Aufnahme einfangen      (Tastaturbefehl)

Spielt man während dem Abspielen mit, so kann die letzte Einspielung als Aufnahme zurückgeholt 
werden.

Tastaturbefehl:
*Letzten Take als Aufnahme einfangen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Letzten Take als Aufnahme einfangen & Wiedergabe      (Tastaturbefehl)

Spielt man während dem Abspielen mit, so kann die letzte Einspielung als Aufnahme zurückgeholt 
werden. Danach wird wieder abgespielt.

Tastaturbefehl:
*Letzten Take als Aufnahme einfangen & Wiedergabe
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Wiedergabe      (Tastaturbefehl)

Startet den Abspielmodus an der gegenwärtigen Position der Song Position Line.

Tastaturbefehl:
Wiedergabe
(Globale Kommandos)



Pause      (Tastaturbefehl)

Der Sequenzer wird im gegenwärtigen Modus zum Stillstand gebracht. Entspricht der Pausentaste im 
Transport Fenster.

Tastaturbefehl:
Pause
(Globale Kommandos)



Stop      (Tastaturbefehl)

Stoppt den Sequenzer. 

Tastaturbefehl:
Stop
(Globale Kommandos)



Wiedergabe oder Stop      (Tastaturbefehl)

Im Abspielmodus wird der Sequenzer angehalten.
Steht der Sequenzer, so wird die Wiedergabe gestartet.
So kann für Start und Stop der selbe Befehl verwendet werden.

Tastaturbefehl:
Wiedergabe oder Stop
(Globale Kommandos)



Zurückspulen      (Tastaturbefehl)

Setzt die Song Position Line um einen Takt zurück. 

Tastaturbefehl:
Zurückspulen
(Globale Kommandos)



Vorwärtsspulen      (Tastaturbefehl)

Setzt die Song Position Line um einen Takt vor. 

Tastaturbefehl:
Vorwärtsspulen
(Globale Kommandos)



Schnell zurückspulen      (Tastaturbefehl)

Setzt die Song Position Line um acht Takte zurück. 

Tastaturbefehl:
Schnell zurückspulen
(Globale Kommandos)



Schnell vorwärtsspulen      (Tastaturbefehl)

Setzt die Song Position Line um acht Takte vor. 

Tastaturbefehl:
Schnell vorwärtsspulen
(Globale Kommandos)



Zurückspulen 1 frame      (Tastaturbefehl)

Setzt die Song Position Line um 1 Frame des synchronisierten Filmes zurück.

Tastaturbefehl:
Zurückspulen 1 frame
(Globale Kommandos)



Vorspulen 1 frame      (Tastaturbefehl)

Setzt die Song Position Line um 1 Frame des synchronisierten Filmes vor.

Tastaturbefehl:
Vorspulen 1 frame
(Globale Kommandos)



Zurückspulen um Format-Schrittweite      (Tastaturbefehl)

Setzt die Song Position Line um 1 Format-Wert zurück.

Tastaturbefehl:
Zurückspulen um Format-Schrittweite
(Globale Kommandos)



Vorspulen um Format-Schrittweite      (Tastaturbefehl)

Setzt die Song Position Line um 1 Format-Wert vor.

Tastaturbefehl:
Vorspulen um Format-Schrittweite
(Globale Kommandos)



Zurückspulen mit Hörkontrolle      (Tastaturbefehl)

Setzt die Song Position Line um einen Schlag zurück. Dabei werden die MIDI Daten , und falls es die 
Audio Hardware erlaubt, auch die Audio Daten, ausgegeben.

Tastaturbefehl:
Zurückspulen mit Hörkontrolle
(Globale Kommandos)



Vorwärtsspulen mit Hörkontrolle      (Tastaturbefehl)

Setzt die Song Position Line um einen Schlag vor. Dabei werden die MIDI Daten , und falls es die Audio 
Hardware erlaubt, auch die Audio Daten, ausgegeben.

Tastaturbefehl:
Vorwärtsspulen mit Hörkontrolle
(Globale Kommandos)



Scrub anhand MIDI-Wert (-2-)      (Tastaturbefehl)

Das Scrubbing, also das Spulen mit Ausgabe der Daten, kann per MIDI gesteuert werden. Ordnet man 
diesem Befehl z.B. dem Pitch Wheel zu, so kann man damit vor und zurück scrubben.

Tastaturbefehl:
Scrub anhand MIDI-Wert (-2-)
(Globale Kommandos)



*Wiedergabe ab Anfang      (Tastaturbefehl)

Startet die Wiedergabe ab Anfang des Stückes.

Tastaturbefehl:
*Wiedergabe ab Anfang
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Wiedergabe ab vorherigen Takt      (Tastaturbefehl)

Setzt die Song Position Line auf den Anfang des Taktes und startet dann die Wiedergabe.

Tastaturbefehl:
*Wiedergabe ab vorherigen Takt
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Wiedergabe ab linken Lokatorpunkt      (Tastaturbefehl)

Startet die Wiedergabe von der Position des linken Locators.

Tastaturbefehl:
*Wiedergabe ab linken Lokatorpunkt
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Wiedergabe ab rechten Lokatorpunkt      (Tastaturbefehl)

Startet die Wiedergabe von der Position des rechten Locators.

Tastaturbefehl:
*Wiedergabe ab rechten Lokatorpunkt
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Wiedergabe ab linken Fensterrand      (Tastaturbefehl)

Die Wiedergabe wird ab der Position, welche zur Zeit dem linken Fensterrand entspricht, gestartet. 

Tastaturbefehl:
*Wiedergabe ab linken Fensterrand
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Zum linken Lokatorpunkt      (Tastaturbefehl)

Setzt die Song Position Line auf den Zeitpunkt, welcher im linken Locator eingetragen ist.

Tastaturbefehl:
Zum linken Lokatorpunkt
(Globale Kommandos)



Zum rechten Lokatorpunkt      (Tastaturbefehl)

Setzt die Song Position Line auf den Zeitpunkt, welcher im rechten Locator eingetragen ist.

Tastaturbefehl:
Zum rechten Lokatorpunkt
(Globale Kommandos)



Zur letzten Wiedergabeposition      (Tastaturbefehl)

Setzt die Song Position Line an die Position, an der zuletzt mit dem Abspielen begonnen wurde.

Tastaturbefehl:
Zur letzten Wiedergabeposition
(Globale Kommandos)



Stop & Zur letzten Wiedergabeposition      (Tastaturbefehl)

Hält den Sequenzer an und setzt die Song Position Line an die Position, an der zuletzt mit dem Abspielen 
begonnen wurde.

Tastaturbefehl:
Stop & Zur letzten Wiedergabeposition
(Globale Kommandos)



Stop & Zum linken Lokatorpunkt      (Tastaturbefehl)

Der Sequenzer wird gestoppt und die Song Position Line an die Position des linken Locators gesetzt.

Tastaturbefehl:
Stop & Zum linken Lokatorpunkt
(Globale Kommandos)



*zur Position...      (Tastaturbefehl)

Öffnet einen Dialog in dem man numerisch die Position eingeben kann, an den die Song Position Line 
gesetzt werden soll.

Tastaturbefehl:
*zur Position...
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Linken Lokatorpunkt setzen...      (Tastaturbefehl)

Öffnet einen Dialog in welchem man numerisch den linken Locatorpunkt setzen kann.

Tastaturbefehl:
Linken Lokatorpunkt setzen...
(Globale Kommandos)



Rechten Lokatorpunkt setzen...      (Tastaturbefehl)

Öffnet einen Dialog in welchem man numerisch den rechten Locatorpunkt setzen kann.

Tastaturbefehl:
Rechten Lokatorpunkt setzen...
(Globale Kommandos)



Linken Lokatorpunkt auf Songposition setzen      (Tastaturbefehl)

Setzt den linken Locator auf die gegenwärtige Position der Song Position Line.

Tastaturbefehl:
Linken Lokatorpunkt auf Songposition setzen
(Globale Kommandos)



Linken Lokatorpunkt auf gerundete Songposition setzen      (Tastaturbefehl)

Setzt den linken Locator auf die gerundete gegenwärtige Position der Song Position Line.

Tastaturbefehl:
Linken Lokatorpunkt auf gerundete Songposition setzen
(Globale Kommandos)



Linken Autodrop-Punkt auf Songposition setzen      (Tastaturbefehl)

Setzt den linken Autodrop Punkt auf die gegenwärtige Position der Song Position Line.

Tastaturbefehl:
Linken Autodrop-Punkt auf Songposition setzen
(Globale Kommandos)



Linken Autodrop-Punkt auf gerundete Songposition setzen      (Tastaturbefehl)

Setzt den linken Autodrop Punkt auf die gerundete gegenwärtige Position der Song Position Line.

Tastaturbefehl:
Linken Autodrop-Punkt auf gerundete Songposition setzen
(Globale Kommandos)



Rechten Autodrop-Punkt auf Songposition setzen      (Tastaturbefehl)

Setzt den rechten Locator auf die gegenwärtige Position der Song Position Line.

Tastaturbefehl:
Rechten Autodrop-Punkt auf Songposition setzen
(Globale Kommandos)



Rechten Autodrop-Punkt auf gerundete Songposition setzen      (Tastaturbefehl)

Setzt den rechten Locator auf die gerundete gegenwärtige Position der Song Position Line.

Tastaturbefehl:
Rechten Autodrop-Punkt auf gerundete Songposition setzen
(Globale Kommandos)



Locatorpunkte setzen gerundet entsprechend Objekte      (Tastaturbefehl)

Setzt die Position der Locator auf den Anfang und das Ende der gegenwärtig selektierten Objekte. Dabei 
werden die Position auf den nächsten Takt gerundet.

Tastaturbefehl:
Locatorpunkte setzen gerundet entsprechend Objekte
(Globale Kommandos)



Linken und rechten Lokatorpunkt vertauschen      (Tastaturbefehl)

Vertauscht die Positionen der linken und rechten Lokatorpunkte.

Tastaturbefehl:
Linken und rechten Lokatorpunkt vertauschen
(Globale Kommandos)



Beide Lokatorpunkte um Cycle-Länge vorrücken      (Tastaturbefehl)

Beide Lokatorpunkte werden jeweils um deren Abstand vorgerückt.

Tastaturbefehl:
Beide Lokatorpunkte um Cycle-Länge vorrücken
(Globale Kommandos)



Beide Lokatorpunkte um Cycle-Länge rückwärts      (Tastaturbefehl)

Beide Lokatorpunkte werden jeweils um deren Abstand zurückgesetzt.

Tastaturbefehl:
Beide Lokatorpunkte um Cycle-Länge rückwärts
(Globale Kommandos)



*Locatorpunkte setzen und wiedergeben      (Tastaturbefehl)

Die Locator Punkte werden entsprechend der aktuellen Selektion gesetzt. Danach wird die Song Position 
Line auf den linken Locator gesetzt und die Wiedergabe beginnt.

Tastaturbefehl:
*Locatorpunkte setzen und wiedergeben
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Locatorpunkte gerundet setzen und wiedergeben      (Tastaturbefehl)

Die Locator Punkte werden entsprechend der aktuellen Selektion gesetzt. Dabei werden die Locator 
Punkte auf den Takt gerundet. Danach wird die Song Position Line auf den linken Locator gesetzt und die 
Wiedergabe beginnt.

Tastaturbefehl:
*Locatorpunkte gerundet setzen und wiedergeben
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Locatorpunkte gerundet setzen und wiedergeben im Cycle-Modus      (Tastaturbefehl)

Die Locator Punkte werden entsprechend der aktuellen Selektion gesetzt. Dabei werden die Locator 
Punkte auf den Takt gerundet. Der Cycle Modus wird eingeschaltet. Danach wird die Song Position Line 
auf den linken Locator gesetzt und die Wiedergabe beginnt.

Tastaturbefehl:
*Locatorpunkte gerundet setzen und wiedergeben im Cycle-Modus
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Locatorpunkte gerundet setzen und aufnehmen      (Tastaturbefehl)

Die Locator Punkte werden entsprechend der aktuellen Selektion gesetzt. Dabei werden die Locator 
Punkte auf den Takt gerundet. Danach wird die Song Position Line auf den linken Locator gesetzt und 
Logic geht in den Aufnahme-Modus.

Tastaturbefehl:
*Locatorpunkte gerundet setzen und aufnehmen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Locatorpunkte gerundet setzen und aufnehmen im Cycle-Modus      (Tastaturbefehl)

Die Locator Punkte werden entsprechend der aktuellen Selektion gesetzt. Dabei werden die Locator 
Punkte auf den Takt gerundet. Der Cycle Modus wird eingeschaltet. Danach wird die Song Position Line 
auf den linken Locator gesetzt und    Logic geht in den Aufnahme-Modus.

Tastaturbefehl:
*Locatorpunkte gerundet setzen und aufnehmen im Cycle-Modus
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Wiedergabe ab der Auswahl      (Tastaturbefehl)

Es wird ab der Position des ersten selektierten Objektes abgespielt.

Tastaturbefehl:
*Wiedergabe ab der Auswahl
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Zur Auswahl      (Tastaturbefehl)

Setzt die Song Position Line auf den Anfang der aktuellen Auswahl.

Tastaturbefehl:
*Zur Auswahl
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Lokatorpunkte auf Marker setzen & Cycle einschalten      (Tastaturbefehl)

Die Lokatorpunkten werden auf den aktuellen Marker gesetzt und Cycle wird aktiviert.

Tastaturbefehl:
Lokatorpunkte auf Marker setzen & Cycle einschalten
(Globale Kommandos)



Lokatorpunkte auf vorherigen Marker setzen & Cycle einschalten      (Tastaturbefehl)

Die Lokatorpunkten werden auf den vorherigen Marker gesetzt und Cycle wird aktiviert.

Tastaturbefehl:
Lokatorpunkte auf vorherigen Marker setzen & Cycle einschalten
(Globale Kommandos)



Lokatorpunkte auf nächsten Marker setzen & Cycle einschalten      (Tastaturbefehl)

Die Lokatorpunkten werden auf den nächsten Marker gesetzt und Cycle wird aktiviert.

Tastaturbefehl:
Lokatorpunkte auf nächsten Marker setzen & Cycle einschalten
(Globale Kommandos)



Zu Markernummer 1      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 1 gesetzt.

Tastaturbefehl:
Zu Markernummer 1
(Globale Kommandos)



Zu Markernummer 2      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 2 gesetzt.

Tastaturbefehl:
Zu Markernummer 2
(Globale Kommandos)



Zu Markernummer 3      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 3 gesetzt.

Tastaturbefehl:
Zu Markernummer 3
(Globale Kommandos)



Zu Markernummer 4      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 4 gesetzt.

Tastaturbefehl:
Zu Markernummer 4
(Globale Kommandos)



Zu Markernummer 5      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 5 gesetzt.

Tastaturbefehl:
Zu Markernummer 5
(Globale Kommandos)



Zu Markernummer 6      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 6 gesetzt.

Tastaturbefehl:
Zu Markernummer 6
(Globale Kommandos)



Zu Markernummer 7      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 7 gesetzt.

Tastaturbefehl:
Zu Markernummer 7
(Globale Kommandos)



Zu Markernummer 8      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 8 gesetzt.

Tastaturbefehl:
Zu Markernummer 8
(Globale Kommandos)



Zu Markernummer 9      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 9 gesetzt.

Tastaturbefehl:
Zu Markernummer 9
(Globale Kommandos)



Zu Markernummer 10      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 10 gesetzt.

Tastaturbefehl:
Zu Markernummer 10
(Globale Kommandos)



Zu Markernummer 11      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 11 gesetzt.

Tastaturbefehl:
Zu Markernummer 11
(Globale Kommandos)



Zu Markernummer 12      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 12 gesetzt.

Tastaturbefehl:
Zu Markernummer 12
(Globale Kommandos)



Zu Markernummer 13      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 13 gesetzt.

Tastaturbefehl:
Zu Markernummer 13
(Globale Kommandos)



Zu Markernummer 14      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 14 gesetzt.

Tastaturbefehl:
Zu Markernummer 14
(Globale Kommandos)



Zu Markernummer 15      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 15 gesetzt.

Tastaturbefehl:
Zu Markernummer 15
(Globale Kommandos)



Zu Markernummer 16      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 16 gesetzt.

Tastaturbefehl:
Zu Markernummer 16
(Globale Kommandos)



Zu Markernummer 17      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 17 gesetzt.

Tastaturbefehl:
Zu Markernummer 17
(Globale Kommandos)



Zu Markernummer 18      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 18 gesetzt.

Tastaturbefehl:
Zu Markernummer 18
(Globale Kommandos)



Zu Markernummer 19      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 19 gesetzt.

Tastaturbefehl:
Zu Markernummer 19
(Globale Kommandos)



Zu Markernummer 20      (Tastaturbefehl)

Die Song Position Line wird auf die Position der Markierung 20 gesetzt.

Tastaturbefehl:
Zu Markernummer 20
(Globale Kommandos)



Cycle-Modus      (Tastaturbefehl)

Schaltet den Cycle Mode ein oder aus. Entspricht der Schaltfläche im Transport Fenster.

Tastaturbefehl:
Cycle-Modus
(Globale Kommandos)



Drop-Modus      (Tastaturbefehl)

Schaltet den Auto Drop Mode ein oder aus. Entspricht der Schaltfläche im Transport Fenster.

Tastaturbefehl:
Drop-Modus
(Globale Kommandos)



Ersetzungsmodus      (Tastaturbefehl)

Schaltet den Replace Mode ein oder aus. Entspricht der Schaltfläche im Transport Fenster.

Tastaturbefehl:
Ersetzungsmodus
(Globale Kommandos)



Solo-Modus      (Tastaturbefehl)

Schaltet den Solo Mode ein oder aus. Entspricht der Schaltfläche im Transport Fenster.

Tastaturbefehl:
Solo-Modus
(Globale Kommandos)



*Solo-Verriegelung einschalten      (Tastaturbefehl)

Hiermit wird die aktuelle Auswahl als Solo fixiert. Danach hat die Selektion keinen Einfluss mehr auf die 
Wiedergabe. Entspricht einem Doppelklick auf die Solo-Schaltfläche im Transport-Fenster. Mit dem 
selben Befehl wird diese Fumktion wieder aufgehoben.

Tastaturbefehl:
*Solo-Verriegelung einschalten
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Solo-verriegelte Objekte auswählen      (Tastaturbefehl)

Alle Objekte, die selektiert waren als Solo verriegelt worden ist, werden selektiert.

Tastaturbefehl:
*Solo-verriegelte Objekte auswählen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Sync intern/extern      (Tastaturbefehl)

Schaltet zwischen interner und externer Synchronisation um. Entspricht der Schaltfläche im Transport 
Fenster.

Tastaturbefehl:
Sync intern/extern
(Globale Kommandos)



*Tap Tempo      (Tastaturbefehl)

Mittels diesem Befehl kann das Tempo des Sequenzers "diktiert" werden, sofern der Tempo Interpreter so 
eingestellt ist.

Tastaturbefehl:
*Tap Tempo
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Tempo-Alternative wählen...      (Tastaturbefehl)

Öffnet einen Dialog in welchem die Nummer der gewünschten Tempo Liste angegeben werden kann. Es 
stehen 9 Tempo Alternativen zur Verfügung.

Tastaturbefehl:
Tempo-Alternative wählen...
(Globale Kommandos)



MIDI-Fernsteuerung ein/aus (immer MIDI-fernsteuerbar)      (Tastaturbefehl)

Schaltet die die Fernbedienung von Logic über MIDI ein oder aus. 

Tastaturbefehl:
MIDI-Fernsteuerung ein/aus (immer MIDI-fernsteuerbar)
(Globale Kommandos)



MIDI-Fernsteuerung aus      (Tastaturbefehl)

Schaltet die die Fernbedienung von Logic über MIDI aus. 

Tastaturbefehl:
MIDI-Fernsteuerung aus
(Globale Kommandos)



*Nächsthöheres Format wählen      (Tastaturbefehl)

Setzt das Darstellungs-Format des Sequenzers auf den nächst höheren Wert.

Tastaturbefehl:
*Nächsthöheres Format wählen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächstniedrigeres Format wählen      (Tastaturbefehl)

Setzt das Darstellungs-Format des Sequenzers auf den nächst niedrigeren Wert.

Tastaturbefehl:
*Nächstniedrigeres Format wählen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



MIDI/Lautsprecher-Metronomklick      (Tastaturbefehl)

Schaltet das Metronom ein oder aus. Entspricht der Schaltfläche im Transport Fenster.

Tastaturbefehl:
MIDI/Lautsprecher-Metronomklick
(Globale Kommandos)



Alle Noten einzeln ausschalten (Panic)      (Tastaturbefehl)

Im Fall von Notenhängern können so alle Noten werden einzeln ausgeschaltet werden. 

Tastaturbefehl:
Alle Noten einzeln ausschalten (Panic)
(Globale Kommandos)



Alle Regler-Werte senden      (Tastaturbefehl)

Die momentanen Einstellungen der Fader werden ausgegeben. Betroffen davon sind sämtliche Fader 
des Environments.

Tastaturbefehl:
Alle Regler-Werte senden
(Globale Kommandos)



*Aktuellen Screenset wiederherstellen      (Tastaturbefehl)

Das gegenwärtige Screenset wird erneut aufgerufen.

Tastaturbefehl:
*Aktuellen Screenset wiederherstellen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächster Screenset      (Tastaturbefehl)

Das folgende Screenset wird aufgerufen.

Tastaturbefehl:
*Nächster Screenset
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorheriger Screenset      (Tastaturbefehl)

Das zuletzt aktive Screenset wird aufgerufen.

Tastaturbefehl:
*Vorheriger Screenset
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Globale Voreinstellungen...      (Tastaturbefehl)

Öffnet die globalen Voreinstellungen.

Tastaturbefehl:
Globale Voreinstellungen...
(Globale Kommandos)



Externen Wellenform-Editor öffnen      (Tastaturbefehl)

Öffnet die selektierte Audio-Datei in einer externen Anwendung.

Tastaturbefehl:
Externen Wellenform-Editor öffnen
(Globale Kommandos)



Movie erneut öffnen      (Tastaturbefehl)

Öffnet die Filmdatei erneut.

Tastaturbefehl:
Movie erneut öffnen
(Globale Kommandos)



Benutzte Klangprogramme sichern mit SoundSurfer/Diver      (Tastaturbefehl)

Gibt an SoundSurfer/Diver den Befehl, eine Library mit den zur Zeit im Song benötigten Klängen zu 
erstellen.

Tastaturbefehl:
Benutzte Klangprogramme sichern mit SoundSurfer/Diver
(Globale Kommandos)



*Audio-Eingänge stummschalten (Mute)      (Tastaturbefehl)

Das am Eingang anliegende Audiosignal kann abgehört werden, resp. wird stummgeschaltet. 
Dieser Befehl ist nicht bei jeder Hardware verfügbar!

Tastaturbefehl:
*Audio-Eingänge stummschalten (Mute)
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Audio-Spuren stummschalten (Mute)      (Tastaturbefehl)

Die Audiospuren können abgehört werden, resp. werden stummgeschaltet. 

Tastaturbefehl:
*Audio-Spuren stummschalten (Mute)
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Audio-Ausgänge stummschalten (Mute)      (Tastaturbefehl)

Das an den Audio Ausgängen anliegende Audiosignal kann abgehört werden, resp. wird 
stummgeschaltet. 

Tastaturbefehl:
*Audio-Ausgänge stummschalten (Mute)
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Audio-Configuration wiederherstellen      (Tastaturbefehl)

Veranlasst Logic, die eingestellte Audio-Konfiguration neu aufzubauen. Dabei werden dabei sämtliche 
Plug-Ins aus dem Speicher entfernt und dann neu angelegt. 

Tastaturbefehl:
*Audio-Configuration wiederherstellen
(Globale Kommandos)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Song schließen ohne Sichern      (Tastaturbefehl)

Schließt den aktuellen Song. Achtung: Dabei erfolgt keinelei Sicherheitsabfrage.
Falls Sie den Song oder die letzten Änderungen nicht bereits gespeichert haben sollten    , so sind diese 
danach unwiederruflich verloren. Diese Funktion dient vor allem dazu bei Vorführungen einen Song ohne 
zusätzliche Abfrage zu schließen.

Tastaturbefehl:
Song schließen ohne Sichern
(Globale Kommandos)



Aktuellen Fenster nochmal ausgeben      (Tastaturbefehl)

Veranlasst Logic das aktuelle Fenster neu aufzubauen.

Tastaturbefehl:
Aktuellen Fenster nochmal ausgeben
(Globale Kommandos)



*Werkzeuge darstellen      (Tastaturbefehl)

Öffnet die Werkzeug-Palette an der aktuellen Position der Maus.

Tastaturbefehl:
*Werkzeuge darstellen
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächstes Werkzeug wählen      (Tastaturbefehl)

Selektiert das nächste Werkzeug der Werkzeug-Palette.

Tastaturbefehl:
*Nächstes Werkzeug wählen
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorheriges Werkzeug wählen      (Tastaturbefehl)

Selektiert das vorangehende Werkzeug der Werkzeug-Palette.

Tastaturbefehl:
*Vorheriges Werkzeug wählen
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Horizontal herauszoomen      (Tastaturbefehl)

In Fenstern mit Teleskopen wird die Darstellung in horizontaler Richtung verkleinert.

Tastaturbefehl:
Horizontal herauszoomen
(Verschiedene Fenster)



Horizontal hineinzoomen      (Tastaturbefehl)

In Fenstern mit Teleskopen wird die Darstellung in horizontaler Richtung vergrössert.

Tastaturbefehl:
Horizontal hineinzoomen
(Verschiedene Fenster)



Vertikal herauszoomen      (Tastaturbefehl)

In Fenstern mit Teleskopen wird die Darstellung in vertikaler Richtung verkleinert.

Tastaturbefehl:
Vertikal herauszoomen
(Verschiedene Fenster)



Vertikal hineinzoomen      (Tastaturbefehl)

In Fenstern mit Teleskopen wird die Darstellung in vertikaler Richtung vergrößert.

Tastaturbefehl:
Vertikal hineinzoomen
(Verschiedene Fenster)



*Abruf Zoom 1      (Tastaturbefehl)

Die erste gespeicherte Darstellungsgröße (Zoom 1) wird für das aktuelle Fenster abgerufen.

Tastaturbefehl:
*Abruf Zoom 1
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Abruf Zoom 2      (Tastaturbefehl)

Die zweite gespeicherte Darstellungsgröße (Zoom 2) wird für das aktuelle Fenster abgerufen.

Tastaturbefehl:
*Abruf Zoom 2
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Abruf Zoom 3      (Tastaturbefehl)

Die dritte gespeicherte Darstellungsgröße (Zoom 3) wird für das aktuelle Fenster abgerufen.

Tastaturbefehl:
*Abruf Zoom 3
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Speichern Zoom 1      (Tastaturbefehl)

Die Darstellungsgröße des aktuellen Fensters wird als Zoom 1 gespeichert.
Es stehen drei Speicher pro Fenstertyp zur Verfügung.

Tastaturbefehl:
*Speichern Zoom 1
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Speichern Zoom 2      (Tastaturbefehl)

Die Darstellungsgröße des aktuellen Fensters wird als Zoom 2 gespeichert.
Es stehen drei Speicher pro Fenstertyp zur Verfügung.

Tastaturbefehl:
*Speichern Zoom 2
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Speichern Zoom 3      (Tastaturbefehl)

Die Darstellungsgröße des aktuellen Fensters wird als Zoom 3 gespeichert.
Es stehen drei Speicher pro Fenstertyp zur Verfügung.

Tastaturbefehl:
*Speichern Zoom 3
(Verschiedene Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Seite oben      (Tastaturbefehl)

Schiebt den Inhalt des Fenster um eine Seite nach oben.

Tastaturbefehl:
Seite oben
(Verschiedene Fenster)



Seite unten      (Tastaturbefehl)

Schiebt den Inhalt des Fenster um eine Seite nach unten.

Tastaturbefehl:
Seite unten
(Verschiedene Fenster)



Seite links      (Tastaturbefehl)

Schiebt den Inhalt des Fenster um eine Seite nach links.

Tastaturbefehl:
Seite links
(Verschiedene Fenster)



Seite rechts      (Tastaturbefehl)

Schiebt den Inhalt des Fenster um eine Seite nach rechts.

Tastaturbefehl:
Seite rechts
(Verschiedene Fenster)



Oberste Seite      (Tastaturbefehl)

Schiebt den Inhalt des Fenster an den oberen Rand.

Tastaturbefehl:
Oberste Seite
(Verschiedene Fenster)



Unterste Seite      (Tastaturbefehl)

Schiebt den Inhalt des Fenster an den unteren Rand.

Tastaturbefehl:
Unterste Seite
(Verschiedene Fenster)



ganz linke Seite      (Tastaturbefehl)

Schiebt den Inhalt des Fenster an den linken Rand.

Tastaturbefehl:
ganz linke Seite
(Verschiedene Fenster)



ganz rechte Seite      (Tastaturbefehl)

Schiebt den Inhalt des Fenster an den rechten Rand.

Tastaturbefehl:
ganz rechte Seite
(Verschiedene Fenster)



Catch (aktuell abgespielte Zeitposition darstellen)      (Tastaturbefehl)

Veranlaßt Logic den Inhalt des Fensters so zu verschieben, daß die Song Position Line    sichtbar ist und 
folgt dieser.

Tastaturbefehl:
Catch (aktuell abgespielte Zeitposition darstellen)
(Verschiedene Fenster)



Fensterverbindung (Gleiche Ebene) ein/aus      (Tastaturbefehl)

Die Darstellung im aktuellen Fenster wird dem obersten Fenster angepaßt. Es wird der selbe Inhalt 
angezeigt.

Tastaturbefehl:
Fensterverbindung (Gleiche Ebene) ein/aus
(Verschiedene Fenster)



MIDI-Hörkontrolle ein/aus      (Tastaturbefehl)

In verschiedenen Editoren kann die Ausgabe der selektierten MIDI Events zugelassen, resp. unterbunden 
werden.

Tastaturbefehl:
MIDI-Hörkontrolle ein/aus
(Verschiedene Fenster)



MIDI-Eingang ein/aus      (Tastaturbefehl)

In verschiedenen Editoren kann die Eingabe von MIDI Events zugelassen, resp. unterbunden werden.

Tastaturbefehl:
MIDI-Eingang ein/aus
(Verschiedene Fenster)



Sequenzen oder Ordner stummschalten      (Tastaturbefehl)

Die selektierten Ordner oder Sequenzen werden stummgeschaltet, resp. deren Stummschaltung wird 
aufgehoben.

Tastaturbefehl:
Sequenzen oder Ordner stummschalten
(Verschiedene Fenster)



*In den Ordner oder Sequenz hineingehen      (Tastaturbefehl)

Das aktuelle Fenster wird veranlaßt den Inhalt des selektierten Ordners oder Sequenz darzustellen.

Tastaturbefehl:
*In den Ordner oder Sequenz hineingehen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Aus dem Ordner oder Sequenz herausgehen      (Tastaturbefehl)

Das aktuelle Fenster wird veranlaßt den aktuellen Ordner oder Sequenz zu verlassen und die nächst 
höhere Ebene darzustellen.

Tastaturbefehl:
*Aus dem Ordner oder Sequenz herausgehen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Auswahl zurücknehmen      (Tastaturbefehl)

Sämtliche Objekte im aktuellen Fenster werden deselektiert. 

Tastaturbefehl:
Auswahl zurücknehmen
(Arrangier- und Editierfenster)



*Erstes Objekt auswählen      (Tastaturbefehl)

Das erste Objekt im aktuellen Fenster wird selektiert. 

Tastaturbefehl:
*Erstes Objekt auswählen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Letztes Objekt auswählen      (Tastaturbefehl)

Das letzte Objekt im aktuellen Fenster wird selektiert. 

Tastaturbefehl:
*Letztes Objekt auswählen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorheriges Event auswählen      (Tastaturbefehl)

Das vorangehende Objekt im aktuellen Fenster wird selektiert. 

Tastaturbefehl:
*Vorheriges Event auswählen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächstes Event auswählen      (Tastaturbefehl)

Das nächste Objekt im aktuellen Fenster wird selektiert. 

Tastaturbefehl:
*Nächstes Event auswählen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Auswahl des vorherigen Events umdrehen      (Tastaturbefehl)

Das vorangehende Objekt im aktuellen Fenster wird zusätzlich selektiert. 

Tastaturbefehl:
*Auswahl des vorherigen Events umdrehen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Auswahl des nächsten Events umdrehen      (Tastaturbefehl)

Das folgende Objekt im aktuellen Fenster wird zusätzlich selektiert. 

Tastaturbefehl:
*Auswahl des nächsten Events umdrehen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*mit nächstgrößeren Wert quantisieren      (Tastaturbefehl)

Quantisiert die selektierten Objekte im aktuellen Fenster auf den folgenden Quantisierungsraster. 

Tastaturbefehl:
*mit nächstgrößeren Wert quantisieren
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*mit nächstkleineren Wert quantisieren      (Tastaturbefehl)

Quantisiert die selektierten Objekte im aktuellen Fenster auf den vorangehenden Quantisierungsraster. 

Tastaturbefehl:
*mit nächstkleineren Wert quantisieren
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Ähnliche Objekte löschen      (Tastaturbefehl)

Alle Objekte im aktuellen Fenster,    die ähnlich der aktuellen Auswahl sind, werden gelöscht. So können 
z.B. alle Noten 'A' gelöscht werden, unabhängig von deren Oktavlage.

Tastaturbefehl:
*Ähnliche Objekte löschen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Alle nicht-ähnlichen Objekte löschen      (Tastaturbefehl)

Alle Objekte im aktuellen Fenster,    die nicht ähnlich der aktuellen Auswahl sind, werden gelöscht. So 
können z.B. alle Events außer den Noten 'A' gelöscht werden, unabhängig von deren Oktavlage.

Tastaturbefehl:
*Alle nicht-ähnlichen Objekte löschen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Löschen und das nächste Objekt auswählen      (Tastaturbefehl)

Die aktuelle Auswahl wird gelöscht und das nächste Objekt wird selektiert.

Tastaturbefehl:
*Löschen und das nächste Objekt auswählen
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Pickup Clock (Eventposition auf Songposition)      (Tastaturbefehl)

Setzt die Position des selektierten Objekts an die gegenwärtige Position der Song Position Line.

Tastaturbefehl:
*Pickup Clock (Eventposition auf Songposition)
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Pickup Clock & Nächstes Event auswählen        (Tastaturbefehl)

Setzt die Position des selektierten Objekts an die gegenwärtige Position der Song Position Line. Danach 
wird das nächste Objekt selektiert.

Tastaturbefehl:
*Pickup Clock & Nächstes Event auswählen 
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE frame +1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 1 SMPTE Frame.

Tastaturbefehl:
*Nudge Event Position by SMPTE frame +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE frame -1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 1 SMPTE Frame.

Tastaturbefehl:
*Nudge Event Position by SMPTE frame -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE Bits +1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 1 SMPTE Bit.

Tastaturbefehl:
*Nudge Event Position by SMPTE Bits +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE Bits -1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 1 SMPTE Bit.

Tastaturbefehl:
*Nudge Event Position by SMPTE Bits -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE frame + 0.5      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 0.5 SMPTE Frame.

Tastaturbefehl:
*Nudge Event Position by SMPTE frame + 0.5
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE frame - 0.5      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 0.5 SMPTE Frame.

Tastaturbefehl:
*Nudge Event Position by SMPTE frame - 0.5
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE frame + 5      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 5 SMPTE Frames.

Tastaturbefehl:
*Nudge Event Position by SMPTE frame + 5
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by SMPTE frame - 5      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 5 SMPTE Frames.

Tastaturbefehl:
*Nudge Event Position by SMPTE frame - 5
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Tick +1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 1 Tick (1/3840 Note).

Tastaturbefehl:
*Nudge Event Position by Tick +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Tick -1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 1 Tick (1/3840 Note).

Tastaturbefehl:
*Nudge Event Position by Tick -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Format +1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 1 Format-Einheit.
Das Format ist abhängig von der Einstellung im Transport Fenster.

Tastaturbefehl:
*Nudge Event Position by Format +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Format -1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 1 Format-Einheit.
Das Format ist abhängig von der Einstellung im Transport Fenster.

Tastaturbefehl:
*Nudge Event Position by Format -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Beat +1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 1 Schlag.

Tastaturbefehl:
*Nudge Event Position by Beat +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Beat -1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 1 Schlag.

Tastaturbefehl:
*Nudge Event Position by Beat -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Bar    +1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um + 1 Takt.

Tastaturbefehl:
*Nudge Event Position by Bar    +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Position by Bar    -1      (Tastaturbefehl)

Verschiebt die Position der selektierten Objekte um - 1 Takt.

Tastaturbefehl:
*Nudge Event Position by Bar    -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Length by Tick +1      (Tastaturbefehl)

Verändert die Länge der selektierten Objekte um + 1 Tick (1/3840 Note).

Tastaturbefehl:
*Nudge Event Length by Tick +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Length by Tick -1      (Tastaturbefehl)

Verändert die Länge der selektierten Objekte um - 1 Tick (1/3840 Note).

Tastaturbefehl:
*Nudge Event Length by Tick -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Length by Format +1      (Tastaturbefehl)

Verändert die Länge der selektierten Objekte um + 1 Format-Einheit.
Das Format ist abhängig von der Einstellung im Transport Fenster.

Tastaturbefehl:
*Nudge Event Length by Format +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Length by Format -1      (Tastaturbefehl)

Verändert die Länge der selektierten Objekte um - 1 Format-Einheit.
Das Format ist abhängig von der Einstellung im Transport Fenster.

Tastaturbefehl:
*Nudge Event Length by Format -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Length by SMPTE frame +1      (Tastaturbefehl)

Verändert die Länge der selektierten Objekte um + 1 SMPTE Frame.

Tastaturbefehl:
*Nudge Event Length by SMPTE frame +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nudge Event Length by SMPTE frame -1      (Tastaturbefehl)

Verändert die Länge der selektierten Objekte um - 1 SMPTE Frame.

Tastaturbefehl:
*Nudge Event Length by SMPTE frame -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Event transponieren +1      (Tastaturbefehl)

Transponiert die aktuelle Auswahl um + 1 Halbton.

Tastaturbefehl:
*Event transponieren +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Event transponieren -1      (Tastaturbefehl)

Transponiert die aktuelle Auswahl um - 1 Halbton.

Tastaturbefehl:
*Event transponieren -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Event-Kanal +1      (Tastaturbefehl)

Erhöht den MIDI Kanal der aktuellen Auswahl um 1.

Tastaturbefehl:
*Event-Kanal +1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Event-Kanal -1      (Tastaturbefehl)

Vermindert den MIDI Kanal der aktuellen Auswahl um 1.

Tastaturbefehl:
*Event-Kanal -1
(Arrangier- und Editierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorherige Spur auswählen      (Tastaturbefehl)

Die Spur oberhalb der momentan aktiven Spur wird angewählt.

Tastaturbefehl:
*Vorherige Spur auswählen
(Arrangierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächste Spur auswählen      (Tastaturbefehl)

Die Spur unterhalb der momentan aktiven Spur wird angewählt.

Tastaturbefehl:
*Nächste Spur auswählen
(Arrangierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Davorliegendes Objekt wählen      (Tastaturbefehl)

Das vorangehende Objekt wird selektiert.

Tastaturbefehl:
*Davorliegendes Objekt wählen
(Arrangierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nachfolgendes Objekt wählen      (Tastaturbefehl)

Das folgende Objekt wird selektiert.

Tastaturbefehl:
*Nachfolgendes Objekt wählen
(Arrangierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Auswahl auf Aufnahmespur beschränken      (Tastaturbefehl)

Alle Objekte außer denen der Aufnahme-Spur werden deselektiert.

Tastaturbefehl:
*Auswahl auf Aufnahmespur beschränken
(Arrangierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Spur & MIDI-Thru-Parameter anhand Seq./Ordner setzen      (Tastaturbefehl)

Die Spur und MIDI-Thru Parameter der aktuellen Spur werden denen des selektierten Ordners, resp. 
Sequenz angepaßt.

Tastaturbefehl:
*Spur & MIDI-Thru-Parameter anhand Seq./Ordner setzen
(Arrangierfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Neue Spur am Ende der Spurliste hinzufügen      (Tastaturbefehl)

Eine neue Spur wird am Ende der Spurliste angefügt. Die Einstellungen entsprechen denen der aktuelle 
Spur.

Tastaturbefehl:
Neue Spur am Ende der Spurliste hinzufügen
(Arrangierfenster)



Neue Spur am Ende der Spurliste hinzufügen mit nächstem Instrument      (Tastaturbefehl)

Eine neue Spur wird am Ende der Spurliste angefügt. Die Einstellungen entsprechen denen des nächsten 
Instrumentes.

Tastaturbefehl:
Neue Spur am Ende der Spurliste hinzufügen mit nächstem Instrument
(Arrangierfenster)



Spur stummschalten (Mute)      (Tastaturbefehl)

Die aktuelle Spur wird stummgeschaltet.

Tastaturbefehl:
Spur stummschalten (Mute)
(Arrangierfenster)



Alle Spuren im Ordner stummschalten (Mute)      (Tastaturbefehl)

Alle Spuren im aktuelle Ordner werden stummgeschaltet.

Tastaturbefehl:
Alle Spuren im Ordner stummschalten (Mute)
(Arrangierfenster)



Alle Spuren des gleichen Instruments im ganzen Song stummschalten (Mute)      (Tastaturbefehl)

Sämtliche Spuren im Song, welche mit dem Instrument der aktuellen Spur belegt sind, werden 
stummgeschaltet.

Tastaturbefehl:
Alle Spuren des gleichen Instruments im ganzen Song stummschalten (Mute)
(Arrangierfenster)



Aktuelle Spur hereinzoomen      (Tastaturbefehl)

Vergrößert die Darstellung der aktuellen Spur.

Tastaturbefehl:
Aktuelle Spur hereinzoomen
(Arrangierfenster)



Aktuelle Spur herauszoomen      (Tastaturbefehl)

Verkleinert die Darstellung der aktuellen Spur.

Tastaturbefehl:
Aktuelle Spur herauszoomen
(Arrangierfenster)



Aktuelle Spur Zoom zurücksetzen      (Tastaturbefehl)

Setzt die Darstellungs-Größe der aktuellen Spur zurück.

Tastaturbefehl:
Aktuelle Spur Zoom zurücksetzen
(Arrangierfenster)



Für alle Spuren Zoom zurücksetzen      (Tastaturbefehl)

Setzt die Darstellungs-Größe aller Spuren zurück.

Tastaturbefehl:
Für alle Spuren Zoom zurücksetzen
(Arrangierfenster)



Objekte anhand der gerundeten Songposition trennen      (Tastaturbefehl)

Die selektierten Objekte werden an der gerundeten aktuellen Song Position zerschnitten.

Tastaturbefehl:
Objekte anhand der gerundeten Songposition trennen
(Arrangierfenster)



Schleife ein/aus      (Tastaturbefehl)

Der Loop-Status der selektierten Sequenzen, Regions oder Ordner wird umgeschaltet. 

Tastaturbefehl:
Schleife ein/aus
(Arrangierfenster)



Optimale Objektgröße setzen in Takten gerundet      (Tastaturbefehl)

Paßt den Anfang und das Ende einer Sequenz auf den Takt genau an deren Inhalt an. 

Tastaturbefehl:
Optimale Objektgröße setzen in Takten gerundet
(Arrangierfenster)



Optimale Objektgröße setzen in Taktnennereinheit gerundet      (Tastaturbefehl)

Paßt den Anfang und das Ende einer Sequenz auf den Nenner    genau an deren Inhalt an. Der Nenner 
bezieht sich auf die Taktart, als 1/4 bei einem 4/4 Takt.

Tastaturbefehl:
Optimale Objektgröße setzen in Taktnennereinheit gerundet
(Arrangierfenster)



Objekt nach links      (Tastaturbefehl)

Verschiebt die selektierten Objekte nach links.

Tastaturbefehl:
Objekt nach links
(Environment-Fenster)



Objekt nach rechts      (Tastaturbefehl)

Verschiebt die selektierten Objekte nach rechts.

Tastaturbefehl:
Objekt nach rechts
(Environment-Fenster)



Objekt nach oben      (Tastaturbefehl)

Verschiebt die selektierten Objekte nach oben.

Tastaturbefehl:
Objekt nach oben
(Environment-Fenster)



Objekt nach unten      (Tastaturbefehl)

Verschiebt die selektierten Objekte nach unten.

Tastaturbefehl:
Objekt nach unten
(Environment-Fenster)



Objektbreite -1 Pixel      (Tastaturbefehl)

Verkleinert die Breite der selektierten Objekte um einen Pixel.

Tastaturbefehl:
Objektbreite -1 Pixel
(Environment-Fenster)



Objektbreite +1 Pixel      (Tastaturbefehl)

Vergrößert die Breite der selektierten Objekte um einen Pixel.

Tastaturbefehl:
Objektbreite +1 Pixel
(Environment-Fenster)



Objekthöhe -1 Pixel      (Tastaturbefehl)

Verkleinert die Höhe der selektierten Objekte um einen Pixel.

Tastaturbefehl:
Objekthöhe -1 Pixel
(Environment-Fenster)



Objekthöhe +1 Pixel      (Tastaturbefehl)

Vergrößert die Höhe der selektierten Objekte um einen Pixel.

Tastaturbefehl:
Objekthöhe +1 Pixel
(Environment-Fenster)



*Grundeinstellung der Kanalanzeige für neue Multi-Instrumente umschalten      (Tastaturbefehl)

Beeinflußt die Grundeinstellung für die Erzeugung von neuen Multi-Instrumenten.
Mittels diesem Befehl kann man wählen, ob beim Erzeugen eines Multiinstrumentes dessen Subchannels 
im Intrumenten Menü sichtbar sein sollen.

Tastaturbefehl:
*Grundeinstellung der Kanalanzeige für neue Multi-Instrumente umschalten
(Environment-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Instrumentennamen ein/aus      (Tastaturbefehl)

Die Namen der Instrumente werden gemäß den Einstellungen in "Ziffern & Namen" im aktuellen 
Notenfenster dargestellt.

Tastaturbefehl:
Instrumentennamen ein/aus
(Notenfenster)



*Zur Seite springen...      (Tastaturbefehl)

Erlaubt den direkten Sprung auf eine Seite der Notation in der Seitendarstellung durch die Eingabe der 
Seitennummer.

Tastaturbefehl:
*Zur Seite springen...
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Mehrfach einfügen an Originalposition      (Tastaturbefehl)

Der Inhalt der    Zwischenablage wird an der ursprünglichen Position mehrfach eingefügt.

Tastaturbefehl:
Mehrfach einfügen an Originalposition
(Notenfenster)



*Nächstes Event      (Tastaturbefehl)

Das folgende Objekt im aktuellen Fenster wird selektiert. 

Tastaturbefehl:
*Nächstes Event
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorheriges Event      (Tastaturbefehl)

Das vorherige Objekt im aktuellen Fenster wird selektiert. 

Tastaturbefehl:
*Vorheriges Event
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächste Zeile      (Tastaturbefehl)

Das folgende Notensystem wird selektiert.

Tastaturbefehl:
*Nächste Zeile
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorherige Zeile      (Tastaturbefehl)

Das folgende Notensystem wird selektiert.

Tastaturbefehl:
*Vorherige Zeile
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Objekte vertikal ausrichten      (Tastaturbefehl)

Die selektierten Objekte werden vertikal ausgerichtet.

Tastaturbefehl:
*Objekte vertikal ausrichten
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Objekte horizontal ausrichten      (Tastaturbefehl)

Die selektierten Objekte werden horizontal ausgerichtet.

Tastaturbefehl:
*Objekte horizontal ausrichten
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Objekte vertikal und horizontal ausrichten      (Tastaturbefehl)

Die selektierten Objekte werden in einer Linie ausgerichtet.

Tastaturbefehl:
*Objekte vertikal und horizontal ausrichten
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Noten auf Kanäle verteilen      (Tastaturbefehl)

Akkorde werden nach Stimmen auf verschieden MIDI-Kanäle gelegt. Somit kann aus einer Sequenz, die 
Akkorde enthält,    bei Verwendung des entsprechenden Notationsformates, einfach zu einer polyphonen 
Notation umgeschrieben werden.

Tastaturbefehl:
Noten auf Kanäle verteilen
(Notenfenster)



*Partbox: 1/1 Note      (Tastaturbefehl)

In der Partbox wird die ganze Note selektiert. Diese kann danach mit dem Stift eingefügt werden.

Tastaturbefehl:
*Partbox: 1/1 Note
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Partbox: 1/2 Note      (Tastaturbefehl)

In der Partbox wird die halbe Note selektiert. Diese kann danach mit dem Stift eingefügt werden.

Tastaturbefehl:
*Partbox: 1/2 Note
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Partbox: 1/4 Note      (Tastaturbefehl)

In der Partbox wird die 1/4-Note selektiert. Diese kann danach mit dem Stift eingefügt werden.

Tastaturbefehl:
*Partbox: 1/4 Note
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Partbox: 1/8 Note      (Tastaturbefehl)

In der Partbox wird die 1/8-Note selektiert. Diese kann danach mit dem Stift eingefügt werden.

Tastaturbefehl:
*Partbox: 1/8 Note
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Partbox: 1/16 Note      (Tastaturbefehl)

In der Partbox wird die 1/16-Note selektiert. Diese kann danach mit dem Stift eingefügt werden.

Tastaturbefehl:
*Partbox: 1/16 Note
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Partbox: 1/32 Note      (Tastaturbefehl)

In der Partbox wird die 1/32-Note selektiert. Diese kann danach mit dem Stift eingefügt werden.

Tastaturbefehl:
*Partbox: 1/32 Note
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächstes Partbox-Symbol      (Tastaturbefehl)

Wählt in der Partbox das nächste Symbol der Gruppe aus.

Tastaturbefehl:
*Nächstes Partbox-Symbol
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorheriges Partbox-Symbol      (Tastaturbefehl)

Wählt in der Partbox das vorangehende Symbol der Gruppe aus.

Tastaturbefehl:
*Vorheriges Partbox-Symbol
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Nächste Partbox-Gruppe      (Tastaturbefehl)

Wählt in der Partbox die nächste Gruppe aus.

Tastaturbefehl:
*Nächste Partbox-Gruppe
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Vorherige Partbox-Gruppe      (Tastaturbefehl)

Wählt in der Partbox die vorangehende Gruppe aus.

Tastaturbefehl:
*Vorherige Partbox-Gruppe
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Fermate oben      (Tastaturbefehl)

Versieht die selektierten Noten mit einer Fermate nach oben.

Tastaturbefehl:
*Symbol einfügen: Fermate oben
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Fermate unten      (Tastaturbefehl)

Versieht die selektierten Noten mit einer Fermate nach unten.

Tastaturbefehl:
*Symbol einfügen: Fermate unten
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Staccato      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Staccato-Symbol.

Tastaturbefehl:
*Symbol einfügen: Staccato
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Staccatissimo      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Staccatissimo-Symbol.

Tastaturbefehl:
*Symbol einfügen: Staccatissimo
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Akzent      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Akzent-Symbol.

Tastaturbefehl:
*Symbol einfügen: Akzent
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Starker Akzent      (Tastaturbefehl)

Versieht die selektierten Noten mit einem 'Strong Accent'-Symbol.

Tastaturbefehl:
*Symbol einfügen: Starker Akzent
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Langer Akzent      (Tastaturbefehl)

Versieht die selektierten Noten mit einem 'Long Accent'-Symbol.

Tastaturbefehl:
*Symbol einfügen: Langer Akzent
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Tenuto      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Tenuto"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Tenuto
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Bogen auf      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Up-Bow"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Bogen auf
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Bogen ab      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Down-Bow"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Bogen ab
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Flageolet      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Flageolet"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Flageolet
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Pizzicato      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Pizzicato"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Pizzicato
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Linke Hand      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Left Hand"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Linke Hand
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Rechte Hand      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Right Hand"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Rechte Hand
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Weicher Schlag      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Soft"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Weicher Schlag
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Harter Schlag      (Tastaturbefehl)

Versieht die selektierten Noten mit einem "Heavy"-Symbol.

Tastaturbefehl:
*Symbol einfügen: Harter Schlag
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Jazz 1      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Jazz-Symbol 1.

Tastaturbefehl:
*Symbol einfügen: Jazz 1
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Jazz 2      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Jazz-Symbol 2.

Tastaturbefehl:
*Symbol einfügen: Jazz 2
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Jazz 3      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Jazz-Symbol 3.

Tastaturbefehl:
*Symbol einfügen: Jazz 3
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Jazz 4      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Jazz-Symbol 4.

Tastaturbefehl:
*Symbol einfügen: Jazz 4
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Jazz 5      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Jazz-Symbol 5.

Tastaturbefehl:
*Symbol einfügen: Jazz 5
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Symbol einfügen: Jazz 6      (Tastaturbefehl)

Versieht die selektierten Noten mit einem Jazz-Symbol 6.

Tastaturbefehl:
*Symbol einfügen: Jazz 6
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Einfügen: Bindebogen nach oben      (Tastaturbefehl)

Ein nach oben gerichteter Bindebogen wird eingefügt.

Tastaturbefehl:
*Einfügen: Bindebogen nach oben
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Einfügen: Bindebogen nach unten      (Tastaturbefehl)

Ein nach unten gerichteter Bindebogen wird eingefügt.

Tastaturbefehl:
*Einfügen: Bindebogen nach unten
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Einfügen: Crescendo      (Tastaturbefehl)

Fügt über die Dauer der selektierten Noten ein Crescendo Symbol ein.

Tastaturbefehl:
*Einfügen: Crescendo
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Einfügen: Decrescendo      (Tastaturbefehl)

Fügt über die Dauer der selektierten Noten ein Decrescendo Symbol ein.

Tastaturbefehl:
*Einfügen: Decrescendo
(Notenfenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



vorheriges Event darstellen      (Tastaturbefehl)

Selektiert den vorangehenden Event und verschiebt den Fensterinhalt, damit dieser Event in der Mitte 
des aktuellen Fensters dargestellt wird.

Tastaturbefehl:
vorheriges Event darstellen
(Event-Fenster)



nächstes Event darstellen      (Tastaturbefehl)

Selektiert den folgenden Event und verschiebt den Fensterinhalt, damit dieser Event in der Mitte des 
aktuellen Fensters dargestellt wird.

Tastaturbefehl:
nächstes Event darstellen
(Event-Fenster)



*Event-Position numerisch eingeben      (Tastaturbefehl)

Ermöglicht die numerische Eingabe der Position des aktuellen Events

Tastaturbefehl:
*Event-Position numerisch eingeben
(Event-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Event duplizieren und numerisch eingeben      (Tastaturbefehl)

Dupliziert den aktuellen Event und verlangt die numerische Eingabe der Position des neuen Events.

Tastaturbefehl:
*Event duplizieren und numerisch eingeben
(Event-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Wert auf alle nachfolgenden Events übertragen      (Tastaturbefehl)

Überträgt den Wert (VAL) des aktuellen Event auf alle folgenden Events des selben Typs.

Tastaturbefehl:
*Wert auf alle nachfolgenden Events übertragen
(Event-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



Protect Values toggle      (Tastaturbefehl)

Ermöglicht das Ein- und Ausschalten des "Fester Wert" Markierungsfeld per Tastatur.

Tastaturbefehl:
Protect Values toggle
(Hyper Edit)



Erkennen ein/aus      (Tastaturbefehl)

Ermöglicht das Ein- und Ausschalten des "Erkennen" Markierungsfeld per Tastatur.

Tastaturbefehl:
Erkennen ein/aus
(Hyper Edit)



Selektiere vorherige Audio-Datei      (Tastaturbefehl)

Selektiert die vorangehende Audio-Datei.

Tastaturbefehl:
Selektiere vorherige Audio-Datei
(Audio-Fenster)



Selektiere nächste Audio-Datei      (Tastaturbefehl)

Selektiert die folgende Audio-Datei.

Tastaturbefehl:
Selektiere nächste Audio-Datei
(Audio-Fenster)



Start/Stop Region      (Tastaturbefehl)

Startet oder Stoppt die Wiedergabe der aktuellen Region.

Tastaturbefehl:
Start/Stop Region
(Audio-Fenster)



Start/Stop Auswahl      (Tastaturbefehl)

Startet oder Stoppt die Wiedergabe der aktuellen Auswahl.

Tastaturbefehl:
Start/Stop Auswahl
(Wellenform-Editor-Fenster)



*Start/Stop alles      (Tastaturbefehl)

Startet oder Stoppt die Wiedergabe der aktuellen Audio-Datei.

Tastaturbefehl:
*Start/Stop alles
(Wellenform-Editor-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Gehe zum Anfang der Selektion      (Tastaturbefehl)

Die Darstellung im aktuellen Fenster springt an den Anfang der gegenwärtigen Auswahl. 

Tastaturbefehl:
*Gehe zum Anfang der Selektion
(Wellenform-Editor-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Gehe zum Ende der Selektion      (Tastaturbefehl)

Die Darstellung im aktuellen Fenster springt an das Ende der gegenwärtigen Auswahl. 

Tastaturbefehl:
*Gehe zum Ende der Selektion
(Wellenform-Editor-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Gehe zum Anfang der Region      (Tastaturbefehl)

Die Darstellung im aktuellen Fenster springt an den Anfang der gegenwärtigen Region. 

Tastaturbefehl:
*Gehe zum Anfang der Region
(Wellenform-Editor-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Gehe zum Ende der Region      (Tastaturbefehl)

Die Darstellung im aktuellen Fenster springt an das Ende der gegenwärtigen Region. 

Tastaturbefehl:
*Gehe zum Ende der Region
(Wellenform-Editor-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.



*Gehe zum Quantisierungspunkt der Region      (Tastaturbefehl)

Die Darstellung im aktuellen Fenster springt zum Anker der gegenwärtigen Region. 

Tastaturbefehl:
*Gehe zum Quantisierungspunkt der Region
(Wellenform-Editor-Fenster)
Diese Funktion ist nur als Tastaturbefehl verfügbar.




